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Consignes générales de sécurité

Consignes générales de sécurité
Veuillez lire avec attention les précautions et consignes de sécurité suivantes, afin d'éviter toute blessure et
l'endommagement éventuel de cet appareil et des produits qui lui sont associés.

Pour écarter tout danger, utilisez uniquement cet appareil dans les conditions spécifiées.

Seul un personnel qualifié doit être autorisé à effectuer les opérations d'entretien.

En utilisant ce produit, il se peut que vous ayez besoin d’accéder à d’autres parties d'un système global. Lisez les
consignes de sécurité relatives aux autres composants du système pour connaître les avertissements et les précautions
concernant le fonctionnement du système.

Pour éviter les incendies et les dommages corporels
Utilisez le cordon d’alimentation spécifié. Utilisez uniquement le cordon d'alimentation prévu pour cet appareil et
conforme aux normes du pays d'utilisation.

Procédez aux branchements et débranchements de manière appropriée. Ne connectez ou ne déconnectez pas
les sondes ou les conducteurs de test lorsqu'ils sont connectés à une source de tension.

Mettez le produit à la terre. Ce produit est raccordé à la terre au moyen du fil de masse du cordon d'alimentation. Pour
éviter tout choc électrique, le fil de masse doit être connecté à une prise de terre. Avant de procéder aux branchements des
bornes d'entrée et de sortie du produit, veillez à ce que celui-ci soit correctement mis à la terre.

Respectez toutes les valeurs nominales des terminaux. Pour éviter tout risque d'incendie ou de choc électrique,
respectez les valeurs nominales et les indications figurant sur le produit. Consultez le manuel livré avec le produit où figurent
toutes les informations complémentaires avant de procéder au branchement du produit.

Branchez le fil de référence de la sonde sur la terre uniquement.

Interrupteur d'alimentation. Le cordon d'alimentation permet de déconnecter le produit de la source d'alimentation. Ne
bloquez pas le cordon d'alimentation ; il doit rester accessible à tout moment.

Ne mettez pas l'appareil en service sans ses capots de protection. Ne mettez pas l'appareil en service si les
capots ou panneaux de protection ont été retirés.

N'utilisez pas l'appareil en cas de défaillance suspecte. En cas de doute sur le bon état de cet appareil, faites-le
inspecter par un technicien qualifié.

Evitez tout circuit exposé. Ne touchez à aucun branchement ou composant exposé lorsque l’appareil est sous tension.

N'utilisez pas l'appareil dans un environnement humide.

N'utilisez pas l'appareil dans un environnement explosif.

Maintenez les surfaces du produit propres et sèches.
Assurez une ventilation adéquate. Reportez-vous aux instructions d'installation du manuel pour plus de détails sur
la mise en place d'une ventilation adéquate du produit.
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Consignes générales de sécurité

Termes apparaissant dans ce manuel.
Les mentions suivantes peuvent figurer dans ce manuel :

AVERTISSEMENT. Les avertissements identifient des situations ou des opérations pouvant entraîner des blessures
graves ou mortelles.

ATTENTION. Les mises en garde identifient des situations ou des opérations susceptibles d'endommager le matériel
ou d'autres équipements.

Symboles et termes relatifs au produit
Les mentions suivantes peuvent figurer sur le produit :

La mention « DANGER » indique un risque de blessure immédiate à la lecture de l'étiquette.

La mention « AVERTISSEMENT » indique un risque de blessure non immédiate à la lecture de l'étiquette.

La mention « PRECAUTION » indique un risque de dommage matériel, y compris du produit.

Les symboles suivants peuvent figurer sur le produit :
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Informations relatives à la conformité

Informations relatives à la conformité
Cette section répertorie les normes CEM (conformité électromagnétique), de sécurité et d'environnement auxquelles cet
instrument est conforme.

Conformité CEM :
Déclaration de conformité électromagnétique CE
Conforme aux objectifs de la Directive 2004/108/CE pour la compatibilité électromagnétique. La conformité aux spécifications
suivantes, telles qu'établies au Journal officiel des Communautés européennes, a été démontrée :

EN 61326-1:2006, EN 61326-2-1:2006. Règles CEM relatives aux équipements électriques utilisés pour les mesures,
le contrôle et l'utilisation en laboratoire. 1 2 3

CISPR 11:2003. Perturbations rayonnées et conduites, Groupe 1, Classe A

CEI 61000-4-2:2001. Immunité aux décharges électrostatiques

CEI 61000-4-3:2002. Immunité aux champs électromagnétiques rayonnés aux fréquences radioélectriques 4

CEI 61000-4-4:2004. Immunité aux transitoires électriques rapides en salves

CEI 61000-4-5:2001. Immunité aux ondes de choc

CEI 61000-4-6:2003. Immunité aux perturbations conduites, induites par les champs radioélectriques 4

CEI 61000-4-11:2004. Immunité aux creux de tension, coupures brèves et variations de tension 5

EN 61000-3-2:2006. Emissions de courant harmonique

EN 61000-3-3:1995. Variations et fluctuations de tension, oscillation

Contact européen.
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
Royaume-Uni

1 Ce produit est destiné à une utilisation en zone non résidentielle uniquement. Une utilisation en zone résidentielle risque de
causer des interférences électromagnétiques.

2 Des émissions qui dépassent les niveaux requis par cette norme peuvent se produire lorsque cet instrument est connecté à un
objet de test.

3 En cas d'utilisation de câbles d'interconnexion, ils doivent être blindés contre les faibles interférences électromagnétiques (EMI),
comme les pièces Tektronix suivantes ou leurs équivalents : câble GPIB 012-0991-01, 012-0991-02 ou 012-0991-03 ; câble RS-232
012-1213-00 (ou référence CA 0294-9) ; câble Centronics 012-1214-00 ; câble LCOM référence CTL3VGAMM-5 VGA. Utilisez un
câble 012-0482-00 pour le connecteur Ref Out.

4 Critères de performances lorsque l'oscilloscope est soumis à un phénomène électromagnétique présent en continu :
MSO70000/C, DSA70000/C, DPO70000/C et DPO7000 : 10 mV/division à 1 V/division : déplacement du signal ≤ 0,4 division ou
augmentation de ≤ 0,8 division avec bruit crête-à-crête.
MSO5000 et DPO5000 : déplacement du signal ≤ 4 division ou augmentation de ≤ 8 division avec bruit crête-à-crête.

5 Critère de performances C appliqué aux tests de niveau des creux de tension de 70 %/25 cycles et des interruptions de tension
de 0 %/250 cycles (CEI 61000-4-11). Si l'instrument s'éteint lors d'un creux ou d'une interruption de tension, il lui faudra plus
de dix secondes pour redémarrer.
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Déclaration de conformité électromagnétique Australie / Nouvelle-Zélande
Conforme aux dispositions du Radiocommunications Act en matière de compatibilité électromagnétique, par le biais des
normes suivantes, selon l'ACMA :

CISPR 11:2003. Perturbations rayonnées et conduites, Groupe 1, Classe A, conformément aux normes
EN 61326-1:2006 et EN 61326-2-1:2006.

Contact en Australie/Nouvelle-Zélande.

Baker & McKenzie
Level 27, AMP Centre
50 Bridge Street
Sydney NSW 2000, Australie

Conformité en matière de sécurité
Déclaration de conformité CE – Basse tension
La conformité à la spécification suivante, telle qu'énoncée au Journal officiel des Communautés européennes, a été
démontrée :

Directive Basse tension 2006/95/CE.

EN 61010-1 : 2001. Règles de sécurité pour appareils électriques de mesurage, de régulation et de laboratoire.

Liste des laboratoires de test agréés aux Etats-Unis
UL 61010-1:2004, 2e édition. Norme pour les équipements de test et de mesure électrique.

Homologation Canada
CAN/CSA-C22.2 n° 61010-1:2004. Règles de sécurité relatives aux équipements électriques utilisés pour les mesures,
le contrôle et l'utilisation en laboratoire. Partie 1.

Autres normes
CEI 61010-1 : 2001. Règles de sécurité pour appareils électriques de mesurage, de régulation et de laboratoire.

Type d'équipement
Equipement de mesure et de test.

Classe de sécurité
Classe 1 – produits mis à la terre.
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Description du degré de pollution
Mesure des contaminants pouvant se trouver dans l'environnement autour et à l'intérieur du produit. L'environnement interne
d'un produit est généralement considéré comme identique à l'environnement externe. Les produits doivent être utilisés
uniquement dans l'environnement pour lequel ils ont été conçus.

Degré de pollution 1. Pas de pollution ou uniquement une pollution sèche, non conductrice. Les produits de cette
catégorie sont généralement placés dans une enveloppe hermétique ou dans des salles blanches.

Degré de pollution 2. Pollution sèche non-conductrice uniquement. Une conductivité temporaire peut avoir lieu, due à la
condensation. Ces produits sont généralement destinés aux environnements domestiques/de bureau. Une condensation
temporaire peut se former lorsque le produit est hors service.

Degré de pollution 3. Pollution conductrice ou pollution sèche non-conductrice devenant conductrice en cas de
condensation. Ces produits sont destinés à des environnements abrités, où la température et l'humidité ne sont pas
contrôlées. La zone est protégée des rayons directs du soleil, de la pluie ou du vent.

Degré de pollution 4. Pollution générant une conductivité continue due à la conductivité de la poussière, de la pluie ou
de la neige. Ces produits sont généralement utilisés en extérieur.

Degré de pollution
Degré de pollution 2 (tel que défini par la norme CEI 61010-1). Remarque : Conçu pour une utilisation en intérieur
uniquement.

Descriptions des catégories d'installation (surtension)
Les bornes de ce produit peuvent appartenir à plusieurs catégories d'installation (surtension). Les différentes catégories
d'installation sont les suivantes :

Catégorie de mesure IV. Pour les mesures effectuées à la source de l'installation basse tension.

Catégorie de mesure III. Pour les mesures effectuées dans le bâtiment de l'installation.

Catégorie de mesure II. Pour les mesures effectuées sur les circuits directement connectés à l'installation basse tension.

Catégorie de mesure I. Pour les mesures effectuées sur les circuits non connectés directement au secteur.

Catégorie de surtension
Alimentation secteur : Catégorie de surtension II

Entrées des mesures :

Les instruments InMSO5000, DPO5000 et DPO7000 en mode 50 ohms et les instruments MSO70000/C, DSA70000B/C et
DPO70000B/C sont classés CAT 1 sans impulsion autorisée.

Les instruments DPO7000 sont classés CAT 1 en mode 1 mégohm.

Les instruments MSO5000 et DPO5000 sont classés CAT II en mode 1 mégohm.

(telle que définie par la norme CEI 61010-1)
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Environnement
Cette section contient des informations concernant l'impact du produit sur l'environnement.

Recyclage du produit
Observez la procédure suivante pour le recyclage d'un instrument ou d'un composant :

Recyclage de l'appareil. La fabrication de cet appareil a exigé l'extraction et l'utilisation de ressources naturelles. Cet
appareil peut contenir des substances potentiellement dangereuses pour l'environnement ou la santé, si elles ne sont pas
correctement traitées lors de la mise au rebut de l'appareil. Pour éviter la diffusion de telles substances dans l'environnement
et réduire l'utilisation des ressources naturelles, nous vous encourageons à recycler ce produit de manière appropriée, afin
de garantir que la majorité des matériaux soient correctement réutilisés ou recyclés.

Ce symbole indique que ce produit respecte les exigences applicables de l'Union européenne, conformément
aux directives 2002/96/CE et 2006/66/CE relatives aux déchets d’équipements électriques et électroniques
(DEEE), et aux batteries. Pour plus d'informations sur les solutions de recyclage, reportez-vous à la section
Assistance/Maintenance du site Web de Tektronix (www.tektronix.com).

Remarque relative au mercure 1 . Ce produit est équipé d'une lampe de rétroéclairage LCD contenant du mercure. Sa
mise au rebut est soumise à la réglementation en vigueur concernant l'environnement. Pour connaître les conditions de
mise au rebut ou de recyclage, contactez les autorités locales ou, pour les Etats-Unis, connectez-vous sur la page Web
E-cycling Central (www.eiae.org).
1 Cette remarque ne concerne pas les instruments MSO5000 et DPO5000. Ceux-ci utilisent un rétroéclairage à LED qui ne contient

pas de mercure.

Matériaux au perchlorate. Ce produit contient une ou plusieurs piles au lithium CR. En Californie, les piles au
lithium CR sont considérées comme des matériaux au perchlorate et nécessitent un traitement particulier. Visitez le site
www.dtsc.ca.gov/hazardouswaste/perchlorate pour plus d'informations.
2 Cette remarque ne concerne pas les instruments MSO5000 et DPO5000.

Restrictions concernant les substances dangereuses
Cet appareil est considéré comme un appareil de contrôle et de surveillance, non pris en charge par la directive 2002/95/CE
relative à la limitation de l’utilisation de certaines substances dangereuses dans les équipements électriques et électroniques.
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Préface
Le présent manuel décrit les procédures d'installation et d'utilisation des instruments des gammes MSO70000C,
DSA70000C, DPO70000C, DPO7000C, MSO5000 et DPO5000. Il contient les concepts et instructions d'utilisation de
base des instruments. Pour obtenir des informations plus détaillées, consultez l'aide en ligne relative à votre instrument.
Les instruments suivants sont présentés dans ce manuel :

DPO72004C, DSA72004C et MSO72004C

DPO71604C, DSA71604C et MSO71604C

DPO71254C, DSA71254C et MSO71254C

DPO70804C, DSA70804C et MSO70804C

DPO70604C, DSA70604C et MSO70604C

DPO70404C, DSA70404C et MSO70404C

DPO7354C

DPO7254C

DPO7104C

DPO7054C

MSO5204 et DPO5204

MSO5104 et DPO5104

MSO5054 et DPO5054

MSO5034 et DPO5034

Caractéristiques principales
Les instruments des gammes MSO70000C, DSA70000C, DPO70000C, DPO7000C, MSO5000 et DPO5000 peuvent vous
aider à vérifier, dépanner et caractériser des systèmes électroniques. Principales caractéristiques :

Bande passante de 20 GHz et fréquence d'échantillonnage en temps réel de 100 G éch./s sur les voies analogiques,
MSO72004C, DSA72004C et DPO72004C

Bande passante de 16 GHz et fréquence d'échantillonnage en temps réel de 100 G éch./s sur les voies analogiques,
MSO71604C, DSA71604C et DPO71604C

Bande passante de 12,5 GHz et fréquence d'échantillonnage en temps réel de 100 G éch./s sur les voies analogiques,
MSO71254C, DSA71254C et DPO71254C

Bande passante de 8 GHz et fréquence d'échantillonnage en temps réel de 25 G éch./s sur les voies analogiques,
DPO70804C, DSA70804C et MSO70804C

Bande passante de 6 GHz et fréquence d'échantillonnage en temps réel de 25 G éch./s sur les voies analogiques,
DPO70604C, DSA70604C et MSO70604C

Bande passante de 4 GHz et fréquence d'échantillonnage en temps réel de 25 G éch./s sur les voies analogiques,
DPO70404C, DSA70404C et MSO70404C
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Bande passante de 3,5 GHz et fréquence d'échantillonnage en temps réel de 10 G éch./s sur toutes les voies,
40 G éch./s sur une voie, DPO7354C

Bande passante de 2,5 GHz et fréquence d'échantillonnage en temps réel de 10 G éch./s sur toutes les voies, 40 G
éch./s sur une voie, DPO7254C

Bande passante de 1 GHz et fréquence d'échantillonnage en temps réel de 5 G éch./s (10 G éch./s en option) sur toutes
les voies, 20 G éch./s (40 G éch./s en option) sur une voie, DPO7104C

Bande passante de 500 MHz et fréquence d'échantillonnage en temps réel de 5 G éch./s sur toutes les voies,
20 G éch./s sur une voie, DPO7054C

Bande passante de 2 GHz et fréquence d'échantillonnage en temps réel de 10 G éch./s sur les voies analogiques,
MSO5204 et DPO5204

Bande passante de 1 GHz et fréquence d'échantillonnage en temps réel de 10 G éch./s sur les voies analogiques,
MSO5104 et DPO5104

Bande passante de 500 MHz et fréquence d'échantillonnage en temps réel de 5 G éch./s sur les voies analogiques,
MSO5054 et DPO5054

Bande passante de 350 MHz et fréquence d'échantillonnage en temps réel de 5 G éch./s sur les voies analogiques,
MSO5034 et DPO5034

Fonction de bande passante améliorée qui, lorsqu'elle est activée, applique des filtres DSP (Digital Signal
Processing/traitement numérique de signaux) qui étendent et abaissent la bande passante. La fonction de bande
passante améliorée permet une réponse synchronisée sur les voies activées, lorsqu'elles sont à leur fréquence
d'échantillonnage maximum. Vous pouvez limiter la bande passante jusqu'à 500 MHz, pour optimiser le rapport signal
à bruit. La bande passante améliorée s'étend jusqu'à l'extrémité de la sonde pour certaines sondes et certains
embouts hautes performances.

Longueurs d'enregistrement jusqu'à 500 000 000 échantillons, en fonction du modèle et de l'option

Précision du gain vertical jusqu'à 1 % CC en fonction du modèle

Quatre voies d'entrée analogiques (avec résolution 8 bits en mode autre que Hi-Res [Haute résolution]), entrée et
sortie de déclenchement auxiliaires

Seize voies numériques disponibles sur les instruments des gammes MSO70000C et MSO5000, ainsi qu'une voie
d'horloge sur la MSO70000C

iCapture permet d'analyser les caractéristiques analogiques des voies numériques sur les instruments de la gamme
MSO70000C

Modes d'acquisition Echantillon, Enveloppe, Détection de crête, Haute résolution, Base de données de signal, Moyenne
et FastAcq

Instrument entièrement programmable, avec ensemble de commandes GPIB complet et interface de messages

Déclenchement PinPoint avec événements de déclenchement A et B flexibles et déclenchements qualifiés logiques
disponibles sur les gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Ensemble complet de déclenchements disponible sur les instruments des gammes MSO5000 et DPO5000

La correction de la position de déclenchement sélectionnable permet une mise en place plus précise du déclenchement
et une réduction de la gigue.

Les fonctions de déclenchement en série sur normes industrielles, de déclenchement sur séquence série et de
déclenchement sur verrouillage de séquence sont disponibles sur certains modèles ou avec certaines options.

Fonction de déclenchement en digitale disponible sur les instruments des gammes MSO70000C et MSO5000.

xii Manuel de l'utilisateur des gammes MSO70000C, DPO/DSA70000C, DPO7000C et MSO/DPO5000



Préface

Puissante fonctionnalité de mesure intégrée, incluant les histogrammes, les mesures automatiques, les mesures de
diagramme de l'œil et les statistiques de mesure.

Combinaison mathématique des signaux pour créer des signaux prenant en charge vos tâches d'analyse des données.
Utilisation de filtres arbitraires dans les équations mathématiques. Utilisation d'une analyse spectrale pour analyser
les signaux dans le domaine de fréquence.

Grand écran couleur XGA haute résolution de 12,1 pouces (307,3 mm) [10,4 pouces (264 mm) MSO5000 et DPO5000],
prenant en charge la gradation des couleurs pour les données du signal, afin d'afficher la densité de l'échantillon.
Affichage de 10 divisions à la fois horizontalement et verticalement.

Commandes Wave Inspector pour la gestion des grandes longueurs d'enregistrement, avec fonctions zoom et
panoramique, lecture et pause, recherche et marquage disponibles sur les MSO5000 et DPO5000

Résolution MagniVu de 60,6 ps, fréquence d'échantillonnage numérique ultrarapide sur la MSO5000

Fonction MultiView Zoom permettant d'afficher et de comparer jusqu'à quatre zones de zoom en même temps.
Verrouillage et défilement, manuel ou automatique, des zones de zoom. Vous pouvez contrôler la visibilité des signaux
dans la fenêtre de zoom.

Recherche et marquage automatiques des événements intéressants sur votre signal

Analyse DDR automatique avec l'option d'analyse technologique de la mémoire DDR

Fenêtres de commande MyScope personnalisables

Possibilité de contrôler la fréquence d’échantillonnage et la longueur d’enregistrement séparément de l'échelle
horizontale

Interface utilisateur graphique (IU) intuitive, avec aide en ligne intégrée et disponible à l'écran

Stockage sur disque amovible interne

Large gamme de solutions de sonde

Documentation
Consultez le tableau suivant pour connaître l'emplacement de chaque documentation afférente au produit.

Pour en savoir plus sur Lire les documents
Installation et utilisation (présentation) Manuel de l'utilisateur. Contient des informations générales sur le

fonctionnement de l'appareil.
Aide de l'interface utilisateur et utilisation
approfondie

Aide en ligne. Contient des instructions détaillées sur les fonctions de
l'instrument. Accédez à l'aide en ligne, en sélectionnant le bouton ou le
menu Aide, pour plus d'informations sur les commandes et les éléments
affichés à l'écran. (Voir page 25, Accès à l'aide en ligne.)

Commandes programmeur Guide programmeur (sur le CD-ROM de documentation ou disponible
en ligne sur www.tektronix.com/manuals). Contient la syntaxe des
commandes GPIB.

Instructions de maintenance Manuel d'entretien (sur le CD-ROM de documentation ou disponible en
ligne sur www.tektronix.com/manuals).
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Conventions utilisées dans ce manuel
Les icônes suivantes sont utilisées tout au long du présent manuel.

Etape Alimentation
panneau
avant

Branchement
électrique

Réseau PS2 SVGA USB
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Installation de l'instrument

Installation de l'instrument
Déballez l'instrument et vérifiez que vous avez bien reçu tous les éléments indiqués dans la liste des accessoires standard.
Les accessoires, sondes, options d'instrument et mises à jour recommandés sont répertoriés dans l'aide en ligne. Consultez
le site Web de Tektronix (www.tektronix.com) pour obtenir les dernières mises à jour.

Accessoires standard
Accessoire Référence Tektronix
Manuel de l'utilisateur des oscilloscopes à phosphore numérique des
gammes MSO70000C, DSA70000C, DPO70000C, DPO7000C, MSO5000
et DPO5000

071-2790-xx

DVD logiciel des gammes MSO70000C, DSA70000C, DPO70000C et
DPO7000C

020-3079-xx

DVD de restauration du système d'exploitation des gammes MSO70000C,
DSA70000C, DPO70000C et DPO7000C

020-3080-xx

Aide en ligne (incluse avec le logiciel de l'instrument) —
Vérification des performances (sur le CD-ROM de documentation) 077-0063-xx
Guide programmeur en ligne (sur le CD-ROM de documentation) 077-0010-xx
Certificat d'étalonnage NIST, Z540-1 et ISO9000 —
Un adaptateur TekConnect, modèles ≥ 4 GHz uniquement TCA-BNC
Quatre adaptateurs TekConnect, modèles ≥4 GHz uniquement TCA-292 mm
Une sonde numérique 16 voies avec kit d'accessoires, modèles MSO5000
uniquement

P6616

Une sonde passive par voie, modèles MSO5204, MSO5104, DPO5204
et DPO5104

TPP1000

Une sonde passive par voie, modèles MSO5054, MSO5034, DPO5054
et DPO5034

TPP0500

Stylet pour écran tactile, modèles MSO5000 et DPO5000 119-6107-xx
Logiciel NI SignalExpress, modèles MSO5000 et DPO5000 063-4253-xx
Clavier, modèles ≥4 GHz uniquement 119-7083-xx
Souris optique 119-7054-xx
Cache avant, modèles MSO5000 et DPO5000

Tous les autres modèles
200-5052-xx
200-4963-xx

Bracelet antistatique, modèles ≥ 4 GHz uniquement 006-3415-05
Sacoche pour accessoires
Modèles ≥ 4 GHz
Modèles DPO7000C
Modèles MSO5000 et DPO5000

016-1441-xx
016-1966-xx
016-2029-xx

CD-ROM logiciel Nero version OEM, modèles ≥4 GHz et DPO7000C 063-3781-xx
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Accessoire Référence Tektronix
Un des éléments suivants : Modèles

MSO5000 et
DPO5000

Modèles
DPO7000C

Modèles
≥ 4 GHz

Amérique du Nord (Option A0) 161-0348-00 161-0104-00 161-0213-00
Alimentation universelle Euro (Option A1) 161-0343-00 161-0104-06 161-0209-00
Royaume-Uni (Option A2) 161-0344-00 161-0104-07 161-0210-00
Australie (Option A3) 161-0346-00 161-0104-14 161-0211-01
Amérique du Nord : 240 V (option A4) — 161-0104-08 —
Suisse (Option A5) 161-0347-00 161-0167-00 161-0212–00
Japon (Option A6) 161-0342-00 161-A005-00 161-0213-00
Chine (Option A10) 161-0341-00 161-0306-00 161-0352-00
Inde (Option A11) 161-0349-00 161-0324-00 161-0325-00
Brésil (option A12) 161-0356-00 161-0356-00 161-0358-00

Cordon d'ali-
mentation

Aucun cordon d'alimentation, ni adaptateur
secteur (Option A99)

— — —

Conditions de fonctionnement requises
MSO70000C, DSA70000C, DPO70000C et DPO7000C

1. Placez l'instrument sur un chariot ou une
table. L'instrument doit être posé sur son
châssis inférieur ou ses pieds arrière. Un
kit de montage en baie est disponible en
option. Respectez les dimensions et les
espacements indiqués ci-après :

Modèles <4 GHz Modèles ≥4 GHz
Haut : 0 mm (0 pouce) 0 mm (0 pouce)
Gauche et droite : 0 mm (0 pouce) côté droit

76 mm (3 pouces) côté gauche
76 mm (3 pouces)

Bas : 0 mm (0 pouce) sur pieds, support
mobile vers la bas

0 mm (0 pouce) sur pieds, support
mobile vers la bas

Arrière : 0 mm (0 pouce) sur pieds arrière 0 mm (0 pouce) sur pieds arrière
2. Largeur : 456 mm (17,96 pouces) 451 mm (17,75 pouces)
3. Hauteur : 277 mm (10,9 pouces) 292 mm (11,48 pouces)
4. Avant d'utiliser l'instrument, vérifiez la

température ambiante :
5 °C à +45 °C (+41 °F à +113 °F). 5 °C à +45 °C (+41 °F à +113 °F).
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5. Vérifiez l'humidité en fonctionnement : 8 % à 80 % d'humidité relative avec
une température maximum sur
thermomètre humide de +29 °C
(+84 °F) jusqu'à +45 °C (+113 °F),
sans condensation
Limite supérieure ramenée à
30 % d'humidité relative à +45 °C
(+113 °F)

8 % à 80 % d'humidité relative
jusqu'à +32 °C (+90 °F)
5 % à 45 % d'humidité relative
au-dessus de +32 °C (+90 °F)
et jusqu'à +45 °C (+113 °F),
sans condensation, limité à
une température maximum sur
thermomètre humide de +29,4 °C
(+85 °F) (ramené à une humidité
relative de 32 % à +45 °C
[+113 °F])

6. Vérifiez l'altitude en fonctionnement : Modèles <4 GHz : 3 000 m (9 843
pieds)

Modèles ≥4 GHz : 3 000 m
(9 843 pieds), réduire la
température en fonctionnement
maximum de 1 °C par 300 mètres
(984,25 pieds) au-dessus de
1 500 m (4 921,25 pieds) d'altitude.

7. Tension d'entrée maximum, modèles
<4 GHz :
50 Ω
1 MΩ

5 Veff, avec crêtes ≤ ±24 V.
150 V, réduire à 20 dB/décade à 9 Veff au-dessus de 200 kHz. La tension
d'entrée maximum au BNC, entre le conducteur central et la terre, est de
400 V crête. La tension efficace est limitée à <150 V pour les signaux
arbitraires, notamment CC. La largeur d'impulsion maximum pour les
impulsions avec des crêtes supérieures à 150 V est de 50 μs. Exemple :
de 0 V à 400 V crête, signal rectangulaire, le rapport cyclique est de 14 %.
La tension de tenue maximum aux transitoires est de ± 800 V crête.

Tension d'entrée maximum, modèles
≥ 4 GHz :

50 Ω <1 Veff pour des paramètres <1 V/FS et <5,5 Veff pour des paramètres
≥ 1 V/FS.

Tension d'entrée non destructive maximum
pour les sondes logiques, gammes
MSO70000 :

± 15 V

ATTENTION. Pour assurer un refroidissement adéquat, n'encombrez pas les côtés et le bas de l'appareil.
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MSO5000 et DPO5000
1. Placez l'instrument sur un chariot ou une

table. L'instrument doit être posé sur son
châssis inférieur ou ses pieds arrière. Un
kit de montage en baie est disponible en
option. Respectez les dimensions et les
espacements indiqués ci-après :

Arrière : 50,8 mm (2 pouces)
Gauche : 50,8 mm (2 pouces)

2. Largeur : 439 mm (17,3 pouces)
3. Hauteur : 233 mm (9,2 pouces), pieds inclus

272 mm (10,7 pouces), poignée verticale et pieds inclus
4. Avant de faire fonctionner l'instrument,

vérifiez la température ambiante :
5 °C à +50 °C (+41 °F à +131 °F)

5. Vérifiez l'humidité de fonctionnement : Limite haute : 40 °C à 50 °C (104 °F à 122 °F), 10 à 60 % d'humidité
relative
Limite basse : 0 °C à 40 °C (32 °F à 104 °F), 10 à 90 % d'humidité relative

6. Vérifiez l'altitude de fonctionnement : 3000 m (9843 pieds)
7. Tension d'entrée maximale :

Impédance d'entrée de 50 Ω
Impédance d'entrée de 1 MΩ

5 Veff, avec crêtes ≤ ±20 V (rapport cyclique ≤ 6,25 %).
300 Veff avec crêtes ≤ ±425 V au BNC.
Pour <100 mV/div réduire à 20 dB/décade au-dessus de 100 kHz à 30 Veff
à 1 MHz, 10 dB/décade au-dessus de 1 MHz.
Pour ≥ 100 mV/div réduire à 20 dB/décade au-dessus de 3 MHz à 30 Veff à
30 MHz, 10 dB/décade au-dessus de 30 MHz.

Tension d'entrée non destructive maximum
pour les sondes logiques :

± 42 V

ATTENTION. Pour assurer un refroidissement adéquat, n'encombrez pas l'arrière et le côté gauche de l'appareil.

Prévention des décharges électrostatiques

ATTENTION. Une décharge électrostatique directe peut endommager l'entrée de l'instrument. Pour savoir comment éviter
cette situation, prenez connaissance des informations suivantes.
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Les décharges électrostatiques (ESD) constituent une préoccupation en matière de gestion d'équipements électroniques.
Bien que cet instrument soit doté d'une protection efficace contre les décharges électrostatiques, il est toujours possible que
d'importantes décharges d'électricité statique directement dans l'entrée du signal, endommagent l'instrument. Pour éviter une
telle situation, utilisez les techniques ci-dessous pour empêcher les décharges électrostatiques au niveau de l'instrument.

1. Déchargez la tension statique de
votre corps en portant un bracelet
antistatique avec mise à la terre lorsque
vous branchez et débranchez des
câbles et des adaptateurs TekConnect.
L'instrument dispose d'une connexion à
cet effet sur la face avant.

2. Un câble non connecté sur un banc
d'essai peut développer une charge
statique importante. Déchargez
la tension statique de tous les
câbles avant de les brancher sur
l'instrument ou l'appareil testé en mettant
temporairement à la terre le conducteur
central du câble ou en branchant une
terminaison de 50 Ω à une extrémité du
câble avant de relier l'autre extrémité à
l'instrument.

Mise sous tension de l'instrument
Alimentation requise
Fréquence et tension source Consommation électrique
Gammes MSO70000C, DSA70000C et DPO70000C :
100–240 Veff ± 10 %, 50–60 Hz
ou 115 Veff ± 10 %, 400 Hz. CAT II

≤ 1 100 VA

Gamme DPO7000C :
100–240 Veff ± 10 %, 47–63 Hz
ou 115 Veff ± 10 %, 400 Hz

550 W maximum

Gammes MSO5000 et DPO5000 :
100–240 Veff ± 10 % 50–60 Hz
115 V 440 Hz

275 W maximum
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Gamme DPO7000C

Gammes MSO70000C, DSA70000C et DPO70000C

Gammes MSO5000 et DPO5000
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Mise hors tension de l’instrument

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000
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Déconnexion de l'alimentation

Gamme DPO7000C

Gammes MSO70000C, DSA70000C et DPO70000C

Gammes MSO5000 et DPO5000
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Sécurisation de l'oscilloscope
1. Utilisez un verrou de sécurité standard

d'ordinateur portable pour sécuriser votre
oscilloscope.

Gammes MSO5000 et DPO5000

Connexion à un réseau
Vous pouvez connecter votre instrument
à un réseau à des fins d'impression, de
partage de fichiers, d'accès Internet et pour
utiliser d'autres fonctions. Contactez votre
administrateur réseau et servez-vous des
utilitaires Windows standard pour configurer
l'instrument pour la mise en réseau.
Utilisez la fonction Connexion Bureau à
distance de Windows pour contrôler et
afficher l'instrument à distance.
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Ajout d'un second moniteur
Vous pouvez faire fonctionner l'instrument tout en utilisant Windows et les applications installées sur un moniteur externe.
Observez la procédure ci-dessous pour paramétrer une configuration à double moniteur.

Gammes MSO70000C, DSA70000C et DPO70000C

1. Mettez l'instrument hors tension.

2. Branchez le second moniteur. Si vous
utilisez un moniteur VGA, utilisez un
adaptateur DVI vers VGA.

3. Branchez le clavier.

4. Branchez la souris.

5. Mettez l'instrument sous tension.

6. Allumez le moniteur.

Gammes MSO70000C, DSA70000C et DPO70000C
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Modèles DPO7000C

1. Mettez l'instrument hors tension.

2. Branchez le second moniteur.

3. Branchez le clavier.

4. Branchez la souris.

5. Mettez l’instrument sous tension.

6. Allumez le moniteur.

Gamme DPO7000C
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Modèles MSO5000 et DPO5000
1. Mettez l'instrument hors tension.

2. Branchez le second moniteur.

3. Branchez le clavier.

4. Branchez la souris.

5. Mettez l’instrument sous tension.

6. Allumez le moniteur.

Modèles MSO5000 et DPO5000
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Restauration du système d'exploitation
Si votre instrument a été livré avec un DVD de restauration du système d'exploitation et que vous devez restaurer le système
d'exploitation, vous pouvez suivre la procédure fournie avec le DVD.

Un fichier de restauration du système d'exploitation se trouve sur une partition distincte du disque dur de l'instrument.

Le moyen le plus simple de restaurer le système d'exploitation de l'instrument est d'utiliser le fichier de restauration
du disque dur.

ATTENTION. Le processus de restauration reformate le disque dur et réinstalle le système d'exploitation. Toutes les
données sauvegardées sont perdues. Si possible, sauvegardez les fichiers importants sur des supports externes avant
de restaurer le système.

1. Redémarrez l'instrument. Pendant le processus d'amorçage, le message suivant s'affiche en haut de l'écran :
Démarrage d'Acronis Loader... appuyez sur F5 pour lancer Acronis Startup Recovery Manager

2. Appuyez plusieurs fois sur la touche F5 jusqu'à ce que l'utilitaire Acronis True Image s'ouvre. Entre le moment où le
message s'affiche et celui où l'instrument démarre normalement, 15 secondes s'écoulent. Si l'instrument ne lance pas
l'application Acronis, mettez-le hors tension, puis sous tension et essayez de nouveau.

3. Cliquez sur Restore (Restaurer).

4. Dans la boîte de dialogue Confirmation, cliquez sur Yes (Oui) pour restaurer le système d'exploitation de l'instrument
ou sur No (Non) pour annuler la procédure. La procédure de restauration dure 30 minutes environ. La durée réelle
dépend de la configuration de l'instrument.

Installation du disque dur sur les modèles MSO5000 et DPO5000
ATTENTION. Installer le disque dur à
l'envers peut endommager l'instrument.

1. Vérifiez si l'instrument est éteint.

2. Insérez le disque dur dans l'instrument,
le châssis tourné vers le haut.

3. Fixez le disque à l'aide de la vis ailée.

4. Remettez le couvercle en place.
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Présentation de l'instrument

Panneau avant
MSO70000C, DSA70000C, DPO70000C et DPO7000C

1. Lecteur DVD/CD-RW

2. Commandes du panneau avant

3. Port USB

4. Borne de mise à la terre

5. Sortie de données récupérées
(indisponible sur les modèles DPO7104
et DPO7054)

6. Sortie d'horloge récupérée (indisponible
sur les modèles DPO7104 et DPO7054)

7. Sortie de compensation de sonde

8. Sortie d'étalonnage de la sonde

9. Entrée voies 1 à 4

10. Entrée de déclenchement auxiliaire

11. Sortie du front rapide

12. Sortie d'étalonnage de la sonde C.C.

13. Entrée de la sonde logique

Gamme DPO7000C

Gammes DSA70000C et DPO70000C

Gamme MSO70000C
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Gammes MSO5000 et DPO5000
1. Commandes du panneau avant

2. Borne de mise à la terre

3. Sortie de compensation de sonde

4. Entrée de déclenchement auxiliaire

5. Entrées voies 1 à 4

6. Entrée de la sonde logique

7. Ports USB

Gammes MSO5000 et DPO5000
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Panneaux latéraux et arrière
MSO70000C, DSA70000C et DPO70000C

1. Disque dur amovible

2. Connecteur PS-2 pour souris

3. Ports USB hôte

4. Port eSATA passif

5. Connecteur LAN RJ-45 pour la
connexion réseau

6. Connecteur TekLink

7. Port GPIB pour la connexion à un
contrôleur

8. Connecteur de sortie pour haut-parleur

REMARQUE. Certains instruments
peuvent disposer de connecteurs audio
supplémentaires.

9. Connecteur pour microphone (Mic)

10. Port vidéo DVI-I

11. Ports série COM 1 et COM 2

12. Connecteur PS-2 pour clavier

13. Sortie auxiliaire

14. Sortie de référence

15. Entrée de référence externe

Gammes MSO70000C, DSA70000C et DPO70000C
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DPO7000C

1. Ports USB hôte

2. Port vidéo pour la connexion à un
moniteur

REMARQUE. Certains instruments
peuvent disposer de connecteurs audio
supplémentaires.

3. Connecteur pour microphone (Mic)

4. Connecteur de sortie pour haut-parleur

5. Port de sortie vidéo XGA Scope pour la
connexion à un moniteur

6. Connexion imprimante

7. Connecteur d'entrée de ligne

8. Connecteur LAN RJ-45 pour la
connexion à un réseau

9. Port parallèle Centronics

10. Port série COM 1

11. Connecteur PS-2 pour souris

12. Connecteur PS-2 pour clavier

13. Sortie haut-parleur arrière

14. Sortie haut-parleur latéral

15. Haut-parleur basse central

16. Disque dur amovible

17. Port GPIB pour la connexion à un
contrôleur

18. Sortie auxiliaire

19. Sortie Voie 3

20. Entrée de référence externe

Gamme DPO7000C
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MSO5000 et DPO5000
1. Connecteur d'entrée de ligne

2. Connecteur de sortie pour haut-parleur

3. Connecteur pour microphone (Mic)

4. Port vidéo pour la connexion à un
moniteur

5. Connecteur PS-2 pour clavier

6. Connecteur PS-2 pour souris

7. Ports USB hôte

8. Connecteur LAN RJ-45 pour la
connexion réseau

9. Port périphérique USB

10. Entrée d'alimentation de la sonde,
utilisez une alimentation 119-7465-xx

11. Entrée de référence externe

12. Sortie auxiliaire

13. Entrée du verrou de sécurité

14. Entrée d'alimentation secteur

15. Couvercle du disque dur amovible

16. Conducteur de terre

Gammes MSO5000 et DPO5000

Les périphériques PS-2 doivent être banchés avant la mise sous tension de l'instrument. Ils ne peuvent pas être remplacés à
chaud.
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Interface et écran
Le mode Barre de menus permet d'accéder aux commandes qui contrôlent toutes les fonctions de l'instrument. Le mode Barre
d'outils permet d'accéder aux fonctions les plus courantes.

1. Barre de menus : accès aux fonctions
de l'instrument, E/S données, impression
et aide en ligne.

2. Boutons/Menu : cliquez ici pour
basculer entre les modes Barre de
menus et Barre d'outils et personnaliser
votre barre d'outils.

3. Affichages du bouton d'usage
général : ajustez et affichez les
paramètres contrôlés par les boutons
d'usage général.

4. Affichage : les signaux actifs, de
référence, calculés, numériques et de
bus s'affichent ici, avec les curseurs.

5. Positionneur de signal : cliquez sur ce
point et faites-le glisser pour changer la
position verticale d'un signal ou d'un bus.
Cliquez sur le positionneur et modifiez la
position et l'échelle à l'aide des boutons
d'usage général.

6. Statut des commandes : référence
rapide aux sélections, à l'échelle, au
décalage et aux paramètres verticaux.

7. Affichages : les mesures et les curseurs
s'affichent dans cette zone. Vous
pouvez sélectionner les mesures dans
la barre de menus ou la barre d'outils.
Si une fenêtre de commande s'affiche,
certaines combinaisons d'affichages sont
déplacées dans la zone du réticule.

AVERTISSEMENT. En cas d'écrêtage vertical, la tension à l'extrémité de la sonde peut être dangereuse, même si l'affichage
indique une tension basse. Un symbole apparaît dans l'affichage de mesure si une condition d'écrêtage vertical existe.
Les mesures automatiques relatives à l'amplitude peuvent générer des résultats inexacts lorsque le signal est écrêté
verticalement. L'écrêtage entraîne également des valeurs d'amplitude inexactes sur les signaux stockés ou exportés vers
d'autres programmes. Si un signal calculé est écrêté, cela n'affecte pas les mesures d'amplitude de ce signal.

8. Etat : affiche le statut d'acquisition, le mode et le nombre d'acquisitions, le statut de déclenchement, la date, l'heure, et
une référence rapide à la longueur d'enregistrement et aux paramètres horizontaux
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1. Boutons/Menu : cliquez ici pour
basculer entre les modes Barre de
menus et Barre d'outils et personnaliser
la barre d'outils.

2. Faites glisser les curseurs pour mesurer
les signaux à l'écran.

3. Faites glisser les icônes de position pour
repositionner un signal.

4. Cliquez sur cette icône pour affecter les
boutons d'usage général à l'échelle et à
la position verticales du signal.

5. Faites glisser sur la zone de signal
pour créer une fenêtre de zoom,
activer/désactiver les histogrammes et
les mesures de fenêtrage.

6. Faites glisser l'icône pour modifier le
niveau de déclenchement.
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Panneau de contrôle
MSO70000C, DSA70000C, DPO70000C et DPO7000C

1. Appuyez sur ce bouton pour configurer
automatiquement les commandes
verticales, horizontales et de
déclenchement en fonction des
voies sélectionnées.

2. Appuyez sur ce bouton pour restaurer la
valeur par défaut des paramètres.

3. Appuyez sur ce bouton pour créer une
copie d'écran ou enregistrer une capture
d'écran.

4. Appuyez sur ce bouton pour activer le
zoom MultiView et ajouter un réticule
agrandi à l'écran.

5. Configuration de l'échelle, de la
position, du retard et de la longueur
d'enregistrement (résolution) horizontaux
pour tous les signaux.

6. Utilisez ce bouton pour démarrer et
arrêter l'acquisition, lancer une séquence
d'acquisition unique, effacer les données
ou démarrer une acquisition rapide.

7. Utilisez ce bouton pour configurer les
paramètres de déclenchement. Appuyez
sur Advanced pour afficher les fonctions
de déclenchement supplémentaires. Les
voyants Arm, Ready et Trig'D indiquent
le statut de l'acquisition.

8. Tournez ce bouton pour ajuster l'intensité
du signal.

9. Tournez ce bouton pour ajuster les
paramètres sélectionnés dans l'interface.
Appuyez sur ce bouton pour basculer
entre un réglage normal et un réglage fin.

10. Appuyez sur ce bouton pour activer et
désactiver les curseurs.
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11. Utilisez ces fonctions pour rechercher et
marquer des signaux.

12. Appuyez sur ce bouton pour activer ou
désactiver l'écran tactile.

13. Tournez ce bouton pour activer ou
désactiver l'affichage des voies.
Configurez l'échelle, la position ou le
décalage vertical(e) du signal. Basculez
entre la position et le décalage.
Pour les instruments de la gamme
MSO70000, activez les voies numériques
à l'aide du menu Digital (Numérique) >
Digital Setup (Configuration numérique).
(Voir page 48, Configuration de l'entrée
du signal numérique.)
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MSO5000 et DPO5000

1. Tournez ce bouton pour ajuster les
paramètres sélectionnés dans l'interface.
Appuyez sur Fine (Réglage fin) pour
sélectionner un réglage fin ; appuyez
sur Coarse (Réglage approximatif) pour
sélectionner un réglage approximatif.

2. Appuyez sur ce bouton pour activer et
désactiver les curseurs.

3. Appuyez sur ce bouton pour régler
l'intensité du signal au moyen d'un
bouton d'usage général.

4. Appuyez sur ce bouton pour activer le
zoom MultiView et ajouter un réticule
agrandi à l'écran.

5. Appuyez sur ce bouton pour effectuer
des mesures automatiques, rechercher
des critères/événements définis par
l'utilisation dans une acquisition ou
démarrer ou arrêter des acquisitions
rapides.

6. Configurez l'échelle et la position
horizontales, et réglez les paramètres
horizontaux et d'acquisition de tous les
signaux.

7. Tournez le bouton Zoom intérieur pour
régler le facteur de zoom. Tournez le
bouton Panoramique extérieur pour
faire défiler la fenêtre de zoom dans le
signal acquis. Appuyez sur le bouton
Lecture/Pause pour lancer ou arrêter
l'affichage panoramique automatique
d'un signal. Vous pouvez en contrôler
la vitesse et le sens à l'aide du bouton
Panoramique.

8. Utilisez ces boutons pour démarrer et
arrêter l'acquisition ou pour lancer une
séquence d'acquisitions unique.

9. Utilisez ces boutons pour chercher
et marquer des signaux, établir ou
supprimer un marqueur de signal ou
passer au marqueur de signal précédent
ou suivant.

10. Appuyez sur ce bouton pour configurer
automatiquement les commandes
verticales, horizontales et de
déclenchement en fonction des
voies sélectionnées.
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11. Utilisez ce bouton pour configurer les
paramètres de déclenchement. Appuyez
sur Menu pour afficher les fonctions de
déclenchement supplémentaires.

12. Tournez ce bouton pour activer ou
désactiver l'affichage des voies.
Configurez l'échelle ou la position
verticale du signal.
Sur les instruments de la gamme
MSO5000, activez les voies numériques
en appuyant sur les boutons D15–D0 ou
au moyen du menu Digital > Digital Setup
(Numérique > Configuration numérique).
(Voir page 48, Configuration de l'entrée
du signal numérique.)

13. Appuyez sur ce bouton pour activer ou
désactiver l'écran tactile.

14. Appuyez sur ces boutons pour afficher
les menus de configuration de calcul, de
référence, de bus ou verticale.

15. Appuyez sur ce bouton pour fermer un
menu affiché.

16. Appuyez sur ce bouton pour accéder
au menu de configuration numérique
(Gamme MSO5000 uniquement).

17. Appuyez sur ce bouton pour effacer les
données.

18. Appuyez sur ce bouton pour restaurer la
valeur par défaut des paramètres.

19. Appuyez sur ce bouton pour enregistrer
et rappeler des paramètres, des signaux
et des images d'écran.

20. Appuyez sur ce bouton pour créer une
copie d'écran ou enregistrer une capture
d'écran.
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Accès à l'aide en ligne
L'aide en ligne contient des informations approfondies sur toutes les fonctions de l'instrument.

Pour accéder à l'aide contextuelle dans la
fenêtre active, sélectionnez Help > Help on
Window... ou appuyez sur F1.

1. Pour accéder à une rubrique spécifique
de l'aide, sélectionnez Help > Contents
and Index....

2. Utilisez les onglets Contents, Index,
Search et Favorites pour sélectionner la
rubrique de votre choix, puis cliquez sur
Display.

Pour naviguer dans le système d'aide, vous
pouvez :

Cliquer sur un bouton dans la fenêtre
d'aide pour passer du sommaire aux
rubriques spécifiques.

Cliquer sur le bouton Minimize dans une
fenêtre d'aide pour réduire la fenêtre
d'aide et utiliser l'instrument.

Cliquez sur Alt et Tab pour revenir à la
dernière rubrique affichée.
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Accès aux menus et aux fenêtres de commande
Vous pouvez accéder aux menus et aux fenêtres de commande à l'aide des méthodes suivantes :

Cliquez sur un menu, puis sélectionnez
une commande.

Pour un menu de raccourci, cliquez
avec le bouton droit de la souris dans
le réticule ou sur un objet. Le menu
de raccourci est un menu contextuel,
qui varie suivant la zone ou l'objet
sur laquelle/lequel vous cliquez. Vous
trouverez des exemples dans la figure
ci-contre.

En mode Barre d'outils, cliquez sur un
bouton pour accéder rapidement à une
fenêtre de commande de configuration.
(Voir page 19.)
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Inspection de l'instrument
Observez les procédures suivantes pour vérifier le bon fonctionnement de votre instrument.

Vérification des diagnostics internes
1. Mettez l'instrument sous tension.

2. Sélectionnez Instrument
Diagnostics...

3. Cliquez sur Run. Les résultats du test
s'affichent dans la fenêtre de commande
des diagnostics.

4. Vérifiez que tous les tests ont été
passés avec succès. Si le diagnostic
échoue, contactez votre technicien de
maintenance local de Tektronix.
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Acquisition
Cette section présente les concepts et les procédures d'utilisation du système d'acquisition.

Compensation du chemin du signal
Observez la procédure suivante si la température a changé de plus de 5 °C (9 °F) depuis la dernière compensation du chemin
du signal (SPC). Effectuez régulièrement une compensation afin de vous assurer du haut degré de précision de vos mesures.
Tektronix conseille de lancer SPC lors de l'utilisation de l'oscilloscope pour mesurer les signaux avec des paramètres de
sensibilité plus élevés (10 mV/div et inférieur) indépendamment des changements de température ou du délai écoulé depuis
la dernière utilisation. Dans le cas contraire, cela risquerait d'affecter les performances garanties de l'instrument.

1. Conditions préalables requises : l'instrument doit être
sous tension depuis 20 minutes et tous les signaux
d'entrée doivent être effacés.
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2. Sélectionnez Instrument Calibration.

3. Lorsque le champ Temperature Status
(Etat de la température) indique Ready
(Prêt), cliquez sur Run SPC (Lancer
SPC) pour démarrer la calibration. Cette
opération peut prendre 10 à 15 minutes.

4. Si l'instrument échoue à ce test,
étalonnez-le de nouveau ou faites-le
réviser par un technicien de maintenance
qualifié.

REMARQUE. Pour afficher en permanence
l'icône d'état SPC ou pour afficher un
avertissement lorsque SPC n'a pas été
exécuté depuis plus d'un mois, cliquez sur la
case d'option correspondante.

5. Si l'icône requérant SPC est rouge,
effectuez une compensation du chemin
du signal.

Manuel de l'utilisateur des gammes MSO70000C, DPO/DSA70000C, DPO7000C et MSO/DPO5000 29



Acquisition

Configuration de l'entrée du signal analogique
Servez-vous des boutons du panneau avant pour configurer votre instrument pour une acquisition de signal.

1. Branchez la sonde à la source du signal d'entrée.

ATTENTION. Pour éviter d'endommager l'instrument, portez toujours un bracelet antistatique lors de vos raccordements à
l'instrument et respectez les tensions nominales d'entrée maximales pour les connecteurs d'entrée.

Gammes MSO70000C, DSA70000C et DPO70000C Gamme DPO7000C

Gammes MSO5000 et DPO5000

2. Sélectionnez la voie d'entrée en vous servant des boutons du panneau avant pour activer ou désactiver chaque voie.

Gammes MSO5000 et DPO5000

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C
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3. Appuyez sur Autoset.

4. Réglez la position, l'échelle et le décalage verticaux à l'aide des boutons du panneau avant

Gammes MSO5000 et DPO5000 Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

5. Réglez la position et l'échelle horizontales à l'aide des boutons du panneau avant
La position horizontale détermine le nombre d'échantillons effectués en pré- et en post-déclenchement.

Gammes MSO5000 et DPO5000 Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C
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Utilisation de la configuration par défaut
1. Pour restaurer rapidement les paramètres d'usine par

défaut, appuyez sur DEFAULT SETUP.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000
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Utilisation de la fonction de réglage automatique (Autoset)
Servez-vous de la fonction Autoset pour configurer rapidement et automatiquement l'instrument (paramètres d'acquisition,
horizontaux, de déclenchement et verticaux) en fonction des caractéristiques du signal d'entrée. La fonction Autoset
ajuste le signal de manière à ce que l'écran affiche deux ou trois cycles du signal, avec le niveau de déclenchement
en position centrale.

1. Branchez la sonde, puis sélectionnez
la voie d'entrée. (Voir page 30,
Configuration de l'entrée du signal
analogique.)

2. Appuyez sur le bouton AUTOSET pour
effectuer un réglage automatique.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

3. Cliquez sur Undo (Annuler) pour annuler
le dernier réglage automatique. Les
paramètres qui ne sont pas affectés
par la fonction Autoset conservent leur
valeur actuelle.

Astuces
La fonction Autoset (Réglage automatique) configure automatiquement les voies analogiques.

Sur les instruments dotés d'iCapture, la fonction de réglage automatique configure automatiquement les voies iCapture.

Pour positionner correctement le signal, il est possible que la fonction Autoset modifie la position verticale. La fonction
Autoset peut également régler le décalage vertical.
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Si vous utilisez la fonction Autoset alors qu'une ou plusieurs voies sont affichées, l'instrument sélectionne la voie
possédant le plus petit numéro pour effectuer la mise à l'échelle horizontale et le déclenchement. Vous pouvez contrôler
individuellement l'échelle verticale pour chaque voie.

Si vous utilisez la fonction Autoset lorsque aucune voie n'est affichée, l'instrument active la voie une (Ch 1) et la
met à l'échelle.

Pour fermer la fenêtre Undo Autoset, cliquez sur X. Une fois cette fenêtre fermée, vous pouvez tout de même annuler le
dernier réglage automatique en sélectionnant la commande Undo Last Autoset dans le menu Edit.

Vous pouvez empêcher la fenêtre de commande Autoset Undo de s'ouvrir automatiquement en modifiant les Préférences
utilisateur dans le menu Utilities.

Compensation, étalonnage et réalignement de la sonde
Pour optimiser la précision des mesures, consultez l'aide en ligne de l'instrument et effectuez les opérations suivantes :

Compensation des sondes passives

Etalonnage des sondes actives

Réalignement des voies d'entrée

Concepts d'acquisition
Matériel d'acquisition
Avant qu'un signal s'affiche, il doit passer par la voie d'entrée, où il est mis à l'échelle et numérisé. Chaque voie possède
un amplificateur et un numériseur individuels en entrée. Chaque voie produit un flux de données numériques dans lequel
l'instrument extrait les enregistrements de signal.

Processus d'échantillonnage

L'acquisition est le processus
d'échantillonnage d'un signal analogique,
qui le convertit en données numériques et
l'assemble en un enregistrement de signal,
qui est ensuite stocké dans la mémoire
d'acquisition.

Echantillonnage en temps réel

Dans l'échantillonnage en temps réel,
l'instrument numérise tous les points dont
il fait l'acquisition à l'aide d'un événement
de déclenchement unique. Servez-vous de
l'échantillonnage en temps réel pour capturer
des événements monocoup ou transitoires.
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Echantillonnage en temps réel interpolé

Dans l'échantillonnage en temps réel
interpolé, l'instrument numérise tous les
points dont il fait l'acquisition à l'aide d'un
événement de déclenchement unique.
Si l'instrument ne peut faire l'acquisition
d'un nombre suffisant d'échantillons pour
obtenir un signal complet, à la fréquence
d'échantillonnage maximum, il l'interpole.
Servez-vous de l'échantillonnage en temps
réel interpolé pour capturer des événements
monocoup ou transitoires.

Echantillonnage en temps équivalent

L'instrument utilise la fonction
d'échantillonnage en temps équivalent pour
augmenter sa fréquence d'échantillonnage
au-delà de la fréquence en temps réel.
Cette méthode est utilisée uniquement si
l'option Temps équivalent est sélectionnée
et si la base de temps est définie avec une
fréquence d'échantillonnage trop élevée pour
créer un enregistrement de signal à l'aide de
l'échantillonnage en temps réel.
L'instrument effectue plusieurs acquisitions
sur un signal répétitif, afin d'obtenir la densité
d'échantillon requise pour un enregistrement
de signal complet. Cette méthode doit donc
être utilisée uniquement sur les signaux
répétitifs.
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Enregistrement du signal

L'instrument crée l'enregistrement de signal
à l'aide des paramètres suivants :

Intervalle d’échantillonnage : temps
entre les points d'échantillonnage.

Longueur d’enregistrement : nombre
d'échantillons requis pour créer un
enregistrement de signal.

Point de déclenchement : référence
temporelle zéro dans l'enregistrement de
signal.

Position horizontale : lorsque le retard
horizontal est désactivé, la position
horizontale correspond au pourcentage
de l'enregistrement de signal, situé
entre 0 et 99,9 pour cent. Le point
de déclenchement et la référence
horizontale se situent au même endroit
dans l'enregistrement de signal. Par
exemple, si la position horizontale est de
50 pour cent, le point de déclenchement
se situe au milieu de l'enregistrement
de signal. Lorsque le délai horizontal
est activé, le temps entre le point
de déclenchement et la référence
horizontale correspond à ce retard
horizontal.

Interpolation
Votre instrument peut interpoler entre les échantillons capturés, lorsqu'il ne possède pas suffisamment d'échantillons réels
pour remplir l'enregistrement de signal. L'interpolation linéaire calcule les points d'enregistrement entre les échantillons réels
capturés, à l'aide d'un ajustement linéaire.

L'interpolation Sin(x)/x calcule les points d'enregistrement à l'aide d'une courbe entre les valeurs réelles capturées. Il
s'agit du mode d'interpolation par défaut, car il requiert moins de points d'échantillonnage réels que l'interpolation linéaire
pour représenter de manière précise un signal.
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Fonctionnement des modes d'acquisition
Le mode Echantillon (Sample) conserve
le premier point échantillonné de chaque
intervalle d'acquisition. Le mode Echantillon
est le mode par défaut.

Le mode Détection de crête (Peak
Detect) utilise le plus élevé et le plus bas
de tous les échantillons contenus dans
deux intervalles d'acquisition consécutifs.
Ce mode fonctionne uniquement avec
l'échantillonnage non interpolé en temps
réel ; il est utile pour la capture des parasites
haute fréquence.
Le mode Haute résolution (Hi Res) calcule
la moyenne de tous les échantillons pour
chaque intervalle d'acquisition. Il permet
l'acquisition d'un signal de plus haute
résolution, avec moins de bande passante.
Le mode Enveloppe (Envelope) recherche
les points d'enregistrement les plus élevés
et les plus bas sur un grand nombre
d'acquisitions. Le mode Enveloppe utilise
le mode Détection de crête pour chaque
acquisition individuelle.
Le mode Moyenne (Average) calcule
la valeur moyenne pour chaque point
d'enregistrement sur un grand nombre
d'acquisitions. Le mode Moyenne utilise le
mode Echantillon pour chaque acquisition
individuelle. Servez-vous de ce mode pour
réduire le bruit aléatoire.
Le mode Base de données de signal
(Waveform Database) consiste en une
accumulation en trois dimensions des
données du signal source, sur plusieurs
acquisitions. Outre les données d'amplitude
et temporelles, la base de données contient
le nombre de fois où un point de signal
spécifique (heure et amplitude) a été capturé.
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Modification du mode d'acquisition
Observez la procédure suivante pour changer le mode d'acquisition.

1. Sélectionnez Horiz/Acq > Acquisition
Mode.

2. Pour sélectionner un mode d'acquisition,
observez l'une des procédures
suivantes :

Sélectionnez le mode d'acquisition
directement dans le menu.

Cliquez sur Mode..., puis
sélectionnez le mode souhaité.

3. Pour les modes d'acquisition Moyenne
et Enveloppe, cliquez sur la commande
# of Wfms, puis définissez le nombre
de signaux à l'aide du bouton d'usage
général. Pour le mode WfmDB (Base
de données de signal), cliquez sur la
commande Samples, puis définissez le
nombre de signaux à l'aide du bouton
d'usage général.

Astuce
Cliquez sur l'icône du pavé numérique pour définir le nombre de signaux ou d'échantillons.
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Démarrage et arrêt d'une acquisition
Une fois que vous avez sélectionné les voies souhaitées pour l'acquisition, observez la procédure suivante.

1. Appuyez sur le bouton RUN/STOP
du panneau avant pour démarrer
l'acquisition.

2. Appuyez à nouveau sur ce bouton pour
arrêter l'acquisition

3. Pour effectuer une acquisition unique,
appuyez sur le bouton Single.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

Sélection du mode horizontal
L’instrument dispose de trois modes horizontaux. Le mode Automatic (Automatique) est le mode par défaut. Sélectionnez le
mode horizontal le mieux adapté à votre configuration de test.

Pour définir le mode horizontal, sélectionnez
Horiz/Acq > Horizontal/Acquisition
Setup afin d’afficher la fenêtre de réglage
horizontal. Choisissez l'un des modes décrits
ci-après.

En mode Automatic, vous pouvez définir
l’échelle et la fréquence d’échantillonnage.
La longueur d’enregistrement est une
variable dépendante. Si, suite à la
modification de l’échelle, la longueur
d’enregistrement dépasse la limite de
longueur d’enregistrement, la fréquence
d’échantillonnage est réduite au paramètre
disponible suivant.
Si le mode d’échantillonnage est en temps
réel et que la fréquence d’échantillonnage
est à la limite du temps réel, essayer
d’augmenter la fréquence d’échantillonnage
sera sans effet.
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Pour définir la limite de longueur
d’enregistrement, cliquez sur Record
Length Limit et définissez la limite à l’aide
des boutons ou du pavé numérique. La limite
maximum par défaut dépend du modèle
d’instrument et de l’option de longueur
d’enregistrement.

En mode Constant Sample Rate, vous
pouvez définir la fréquence d’échantillonnage
et l’échelle. La fréquence d’échantillonnage
par défaut garantit le fonctionnement du
filtre de bande passante. La longueur
d’enregistrement est une variable
dépendante. La longueur d’enregistrement
maximum dépend du modèle d’instrument et
de l’option de longueur d’enregistrement.
La molette de résolution du panneau avant
modifie la fréquence d’échantillonnage du
mode Automatic et celle du mode Constant
sample rate.
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En mode Manual , vous pouvez définir la
fréquence d’échantillonnage et la longueur
d’enregistrement. L’échelle horizontale est
une variable dépendante calculée à partir
de la fréquence d’échantillonnage et de la
longueur d’enregistrement.
La molette Echelle horizontale modifie la
longueur d’enregistrement en mode manuel.

Les trois modes interagissent avec la
fréquence d’échantillonnage, l’échelle
et la longueur d’enregistrement, comme
illustré. La ligne horizontale correspond à
la fréquence d’échantillonnage maximum
en temps réel. Chaque signal en escalier
indique que lorsque vous augmentez
l’échelle, la fréquence d’échantillonnage
doit baisser si la longueur d’enregistrement
maximum ou la limite de longueur
d’enregistrement que vous avez définie est
atteinte. Le mode manuel utilise la longueur
d’enregistrement maximum.
Les modes Automatic et Constant Sample
Rate sont identiques. Toutefois, le mode
Constant Sample Rate maintient la
fréquence d’échantillonnage à un niveau
constant garantissant l’utilisation des filtres
d’amélioration de la bande passante.

Astuces
La fréquence d'échantillonnage numérique et la résolution sont des variables dépendantes, contrôlées par la sélection
de la fréquence d'échantillonnage analogique.
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Utilisation de la fonction FastAcq
Le mode d'acquisition rapide réduit les temps morts entre les acquisitions de signal, permettant la capture et l'affichage
d'événements transitoires tels que les parasites ou les petites impulsions. Le mode d'acquisition rapide permet également
d'afficher des phénomènes de signal à une intensité qui reflète leur fréquence d'occurrence.

Observez la procédure suivante :

1. Appuyez sur FastAcq.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

2. Recherchez les parasites, événements
transitoires ou autres événements
aléatoires.
Lorsque vous avez identifié une
anomalie, configurez le système de
déclenchement pour qu'il la recherche.
(Voir page 163, Capture d'anomalies
intermittentes.)
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Astuces
Les voies numériques et les bus ne sont pas disponibles en mode FastAcq (Acquisition rapide).

Pour optimiser la capture des détails ou des événements rares, sélectionnez Horiz/Acq > Horizontal/Acquisition
Setup > Acquisition> Fast Acq, puis sélectionnez Optimize pour Capturing Details ou Capturing rare events.

Pour les instruments des gammes MSO5000 et DPO5000, le mode Fast Acq (Acq. rapide) n'est pas disponible en
mode Affichage XY ou XYZ.

Utilisation de la fonction de bande passante améliorée DSP
Si votre instrument possède la fonction de bande passante améliorée, servez-vous de cette méthode DSP (traitement
numérique du signal) pour obtenir des mesures de temps de montée plus précises, pour augmenter la bande passante et
pour l'abaisser à la fréquence d'échantillonnage maximum. La fonction de bande passante améliorée offre une réponse
synchronisée sur l'ensemble des voies activées, afin que vous puissiez effectuer une comparaison entre les voies et
des mesures différentielles.
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1. Appuyez sur AUTOSET pour définir
les commandes de déclenchement,
verticales et horizontales ou définir les
commandes manuellement.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

2. Sélectionnez Vertical > Bandwidth
Enhanced...
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3. Cliquez sur Digital Filters (DSP)
Enabled (Filtres numériques (DSP)
activés) pour activer la fonction de
bande passante améliorée. Vous
devez définir correctement la fréquence
d'échantillonnage pour activer la fonction
DSP.

4. Pour forcer une fréquence
d’échantillonnage constante à activer
les filtres DSP, cochez Force Constant
Sample Rate.

REMARQUE. Si cela n’a pas encore
été fait, le fait de sélectionner Constant
Sample Rate (Fréquence d’échantillonnage
constante) définit le mode horizontal à une
fréquence d’échantillonnage constante,
définit la fréquence d’échantillonnage afin
d’activer la fonction DSP et sélectionne une
bande passante DSP.

5. Sélectionnez la bande passante
souhaitée dans la liste Bandwidth.
Les sélections de bande passante
disponibles dépendent de l’instrument,
de la sonde et de l'embout de celle-ci.
Analog Only (Analogique uniquement)
sélectionne une bande passante
matérielle.

6. Pour appliquer vos sélections à toutes les
voies, cochez Apply To All Channels.
Si différentes connexions empêchent
l’instrument de définir toutes les voies de
la même manière, l’instrument configure
chaque voie sur la valeur de bande
passante la plus proche possible.

L'indicateur de bande passante apparaît
dans l'affichage vertical lorsque la
fonction de bande passante améliorée
est activée.

Astuces
Cliquez avec le bouton droit de la souris sur le positionneur de signal pour afficher un menu permettant de sélectionner
la bande passante de la voie et d'autres paramètres de bande passante améliorée.

La fonction de bande passante améliorée avec DSP se produit à la fréquence d'échantillonnage maximum.

Utilisez la fonction de bande passante améliorée DSP lorsque vos signaux ont un temps de montée inférieur à 50 ps.
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Sélectionnez Analog Only pour les débits de signal élevés, les signaux en surcharge et lorsque vous préférez utiliser
votre propre post-traitement DSP.

Vous pouvez limiter la bande passante de l’instrument en sélectionnant Vertical > Bandwidth Limit , puis la bande
passante.
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Utilisation du mode Défilement
Le mode Défilement offre un affichage similaire à un enregistreur sur bande déroulante pour les signaux basse fréquence.
Il vous permet d'afficher les points de données d'acquisition sans avoir à attendre l'acquisition d'un enregistrement
de signal complet.

1. Sélectionnez Horiz/Acq >
Horizontal/Acquisition Setup.

2. S'il n'est pas sélectionné, cliquez sur
l'onglet Acquisition. Cliquez sur Auto
pour activer le mode Défilement.

REMARQUE. Le mode Défilement
fonctionne uniquement en mode d'acquisition
Echantillon, Détection de crête et Haute
résolution.

3. Pour arrêter les acquisitions en mode
Défilement :

Si vous n'êtes pas en Séquence
unique, appuyez sur RUN/STOP
pour arrêter le mode Défilement.

Si vous êtes en Séquence unique,
les acquisitions en mode Défilement
s'arrêtent automatiquement lorsqu'un
enregistrement complet a été capturé

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

Astuces
Le mode Défilement est automatiquement désactivé lorsque vous passez en mode d'acquisition Enveloppe, Moyenne
ou Base de données de signal.

Il est également désactivé lorsque vous définissez l'échelle horizontale sur 50 ms par division, ou plus.
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Configuration de l'entrée du signal numérique
Utilisez les menus Digital setup (Configuration numérique) pour configurer l'acquisition de signaux par les voies numériques.
Les voies numériques sont disponibles sur les instruments des gammes MSO70000 et MSO5000 uniquement.

1. Branchez la sonde logique sur
l'instrument.

2. Branchez la sonde sur les sources du
signal d'entrée.

ATTENTION. Pour éviter d'endommager
l'instrument, portez toujours un bracelet
antistatique lors de vos raccordements
à l'instrument et respectez les tensions
nominales d'entrée maximales pour les
connecteurs d'entrée.

Gammes MSO70000C, DSA70000C et DPO70000C

Gammes MSO5000 et DPO5000

3. Configurez les voies numériques et
les bus à l'aide des menus Digital
(Numérique).

(Voir page 49, Configuration des voies
numériques.) et (Voir page 50, Configuration
d'un bus.)
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Configuration des voies numériques
Pour les instruments des gammes MSO70000 et MSO5000, vous pouvez définir un seuil, une taille, une position et un
libellé pour une voie numérique.

1. Sélectionnez Digital > Digital Setup
(Numérique > Configuration numérique).

2. Sélectionnez l'onglet D7 - D0 ou D15 -
D8 en fonction des voies numériques
que vous souhaitez configurer.

3. Cliquez sur le bouton d'une voie
numérique pour activer ou désactiver
celle-ci.

4. Cliquez sur Threshold (Seuil) ou
Position et effectuez le réglage à l'aide
du clavier ou des boutons d'usage
général. Vous pouvez également définir
le seuil des 16 voies en saisissant une
valeur dans le champ Global Threshold
(Seuil global) avant de cliquer sur Apply
(Appliquer).
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5. Pour modifier la taille verticale affichée
de toutes les voies numériques, cliquez
sur Size (Taille) et sélectionnez la taille à
afficher dans la liste.

6. Pour modifier le libellé d'une voie
numérique, cliquez dessus et saisissez
un nouveau libellé à l'aide du clavier.

Configuration d'un bus
Vous pouvez configurer des bus série (en option) et parallèles.

1. Sélectionnez Vertical > Bus Setup
(Vertical > Configuration de bus) ou,
sur certains instruments, Digital > Bus
Setup (Numérique > Configuration de
bus).

2. Sélectionnez l'onglet Config.
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3. Faites défiler jusqu'à atteindre le bus à
configurer, puis sélectionnez-le.

4. Pour activer ou désactiver l'affichage du
bus, cliquez sur le bouton Bus.

5. Pour modifier le libellé par défaut du bus,
cliquez sur Label (Libellé) et saisissez
un nouveau libellé à l'aide du clavier.

6. Pour modifier la position affichée du
bus, cliquez sur Bus Position (Position
du bus) et utilisez le clavier ou le bouton
d'usage général pour saisir une nouvelle
position de bus.

7. Pour sélectionner le type de bus,
choisissez l'option Serial (Série) ou
Parallel (Parallèle) dans la section Bus
Type (Type de bus).

Vous pouvez configurer chaque type de bus.
(Voir page 51, Configuration d'un bus série.)
ou (Voir page 53, Configuration d'un bus
parallèle.)

Astuces
Vous pouvez positionner un bus ou un signal en cliquant sur le positionneur du bus ou du signal, puis en le faisant
glisser vers la position souhaitée.

Configuration d'un bus série
Vous pouvez définir des paramètres de bus série (en option). Vous pouvez utiliser des voies numériques dans les définitions
de bus pour les instruments de la gamme MSO uniquement.
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1. Pour configurer un bus série,
sélectionnez l'option Serial (Série)
de la section Bus Type (Type de bus) et
sélectionnez le type de bus série dans
la liste déroulante.
Chaque type de bus comporte son propre
ensemble de paramètres configurables.
Configurez d'autres types de bus en
fonction du bus sélectionné.

Consultez l'aide en ligne pour en savoir plus
sur la configuration d'un bus.

2. Pour sélectionner l'entrée des
composants affichés du bus, cliquez
sur le paramètre Input (Entrée) du
composant et faites votre choix dans la
liste qui s'affiche.

3. Pour définir un seuil d'entrée,
double-cliquez sur Threshold (Seuil)
et saisissez la valeur à l'aide du pavé
numérique.

REMARQUE. Pour définir des seuils
indépendamment lorsqu'ils sont partagés,
allez à Trig > A Event (Main) Trigger
Setup (Déclencher > Configuration
du déclenchement sur événement A
(principal) et mettez Settings (Réglages)
sur Independent (Indépendant).

4. Pour sélectionner la polarité des
composants affichés du bus, cliquez
sur le paramètre Polarity (Polarité) du
composant et faites votre choix dans la
liste qui s'affiche.
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Configuration d'un bus parallèle
Vous pouvez définir des paramètres de bus parallèles. Vous pouvez utiliser des voies numériques dans les définitions de
bus pour les instruments de la gamme MSO uniquement.

1. Pour configurer un bus parallèle,
sélectionnez l'option Parallel (Parallèle)
de la section Bus Type (Type de bus).
Consultez l'aide en ligne pour en savoir
plus sur la configuration d'un bus.

2. Pour ajouter des sources au bus, cliquez
sur le bouton Select (Sélectionner) de
la section Add Sources (Ajouter des
sources).

3. Cliquez sur le bouton de chaque voie
souhaitée dans le bus. L'ordre du bus
parallèle est déterminé par l'ordre dans
lequel vous sélectionnez les voies.
Les voies numériques sont disponibles
comme sources sur les instruments de la
gamme MSO uniquement.

4. Cliquez sur le bouton OK.
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5. Pour déplacer une voie dans le bus,
accédez à la voie que vous souhaitez
déplacer, sélectionnez-la, puis cliquez
sur les boutons fléchés vers le haut ou
le bas.

6. Pour supprimer une voie dans le bus,
accédez à la voie que vous souhaitez
supprimer, sélectionnez-la, puis cliquez
sur le bouton Remove (Supprimer).

7. Pour définir des seuils de voie, cliquez
sur le bouton Setup (Réglage) de la
section Thresholds (Seuils).

8. Pour chaque seuil que vous souhaitez
définir, double-cliquez sur le seuil de la
voie et saisissez la valeur à l'aide du
pavé numérique ou des boutons d'usage
général.

9. Après avoir défini les seuils souhaités,
cliquez sur le bouton OK.

10. Pour définir un même seuil pour toutes
les voies, double-cliquez sur Digital
Threshold (Seuil global) et utilisez le
pavé numérique pour saisir une valeur.
Cliquez ensuite sur Apply (Appliquer).

11. Pour définir la source d'horloge
et la polarité pour les instruments
MSO7000/C, double-cliquez sur l'option
et faites votre choix dans la liste qui
s'affiche. Pour définir le niveau d'horloge,
double-cliquez sur Clock Level (Niveau
d'horloge) et saisissez le niveau à l'aide
du pavé numérique ou des boutons
d'usage général.

Configuration Affichage bus
Vous pouvez configurer le style et le décodage du bus. Vous pouvez utiliser des voies numériques dans les définitions de
bus pour les instruments de la gamme MSO uniquement.
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1. Sélectionnez Digital > Bus Setup
(Numérique > Configuration de bus).

2. Sélectionnez l'onglet Display
(Affichage).

3. Pour sélectionner le bus, faites défiler
pour afficher le bus, puis sélectionnez-le.

4. Pour sélectionner le style et le décodage
du bus, cliquez sur les boutons du style
et du décodage souhaités pour le bus.

5. Si vous utilisez un tableau de symboles,
cochez la case Use Symbol (Utiliser
symbole). Cliquez sur Browse
(Parcourir) pour accéder au fichier du
tableau de symboles.
D'autres réglages sont disponibles pour
certains bus. Configurez les autres
paramètres appropriés à votre bus.
Consultez l'aide en ligne pour en savoir
plus sur la configuration d'un bus.
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Dans quelles circonstances activer MagniVu
Pour les oscilloscopes de la gamme MSO5000, MagniVu vous offre une résolution plus élevée afin de déterminer d'une
façon précise la position des fronts. Vous pouvez ainsi effectuer plus facilement des mesures de temporisation précises sur
les fronts numériques. Il est possible d'obtenir 32 fois plus de détails que sur un échantillonnage de voie numérique normal.

L'enregistrement MagniVu est acquis parallèlement à l'acquisition numérique principale et il est disponible à tout instant en
cours d'acquisition ou à l'arrêt. MagniVu propose une vue à ultra-haute résolution de vos données échantillonnées, à une
résolution maximale de 60,6 ps pour 10 000 points, centrée sur le déclenchement.

REMARQUE. MagniVu se centre automatiquement sur le point de déclenchement. Si vous activez MagniVu tout en
utilisant une grande longueur d'enregistrement et si le signal numérique que vous recherchez est éloigné du point de
déclenchement, il risque de se trouver en dehors de l'écran et donc de ne pas être affiché. En général, dans ce cas, vous
pouvez trouver l'enregistrement numérique en recherchant le signal numérique dans l'aperçu supérieur, puis en utilisant
l'affichage panoramique comme approprié.

Utilisation de MagniVu
1. Appuyez sur D15–D0.

2. Sélectionnez Digital (Numérique) >
MagniVu pour Activer MagniVu.

Astuces
Si vous pensez avoir besoin d'une résolution de temporisation plus élevée, activez MagniVu pour augmenter la résolution.

MagniVu est toujours acquis. Si l'oscilloscope est arrêté, vous pouvez activer MagniVu et obtenir la meilleure résolution
sans qu'il ne soit nécessaire d'effectuer une nouvelle acquisition.
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Affichage des caractéristiques analogiques des signaux numériques
iCapture vous permet d'afficher les caractéristiques analogiques de signaux de voies numériques. Vous disposez de
fonctionnalités de mesure supplémentaires grâce à l'affichage des caractéristiques analogiques d'un signal. iCapture est
disponible sur les instruments de la gamme MSO70000C.

1. Sélectionnez Vertical > Vertical Setup
(Configuration verticale).

2. Appuyez sur le bouton iCapture de la
section Digital input (Entrée numérique).

3. Cliquez sur Digital Source (Source
numérique) et sélectionnez une voie
numérique à transmettre via l'entrée
analogique.
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4. Pour définir les seuils de voie utilisés lors
de la conversion d'un signal analogique
au format numérique afin de l'inclure
dans un bus, cliquez sur le bouton Digital
Properties (Propriétés numériques).

5. Pour choisir de partager les réglages
de seuil ou de disposer de réglages
indépendants, cliquez sur Channel
Settings (Réglages des voies) et
sélectionnez Shared (Partagé) ou
Independent (Indépendant) dans la
liste.

6. Pour chaque seuil à définir, cliquez sur
le seuil de la voie. Définissez le seuil à
l'aide du pavé numérique ou des boutons
d'usage général.

7. Après avoir défini les seuils requis,
cliquez sur le bouton OK.

Utilisation du mode FastFrame
Le mode FastFrame vous permet de capturer de nombreux événements de déclenchement sous forme d'enregistrements
uniques, dans un enregistrement plus important, puis d'afficher et de mesurer chaque enregistrement individuellement.
L'horodatage indique le temps de déclenchement absolu pour chaque trame et le temps relatif entre les déclenchements de
deux trames spécifiques.
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1. Appuyez sur AUTOSET pour définir
les commandes de déclenchement,
verticales et horizontales ou définir les
commandes manuellement.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

2. Sélectionnez Horiz/Acq > FastFrame
Setup...
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3. Appuyez sur FastFrame pour l'activer.

4. Sélectionnez Frame Size et # of Events
Frames. Utilisez ensuite des boutons
d'usage général pour définir chaque
paramètre. Le nombre de trames
correspond au nombre d'événements
de déclenchement capturés. La taille
de la trame correspond au nombre
d'échantillons qui sont stockés pour
chaque événement de déclenchement
(ou trame). Le nombre de trames
est réduit si la mémoire disponible
est insuffisante pour stocker tous les
enregistrements. Plus la frame est
courte, plus vous pouvez acquérir de
trames.

5. Utilisez les commandes d'affichage des
trames pour sélectionner la trame que
vous souhaitez afficher.

6. Pour afficher plusieurs trames
superposées, sélectionnez Overlay.

7. Servez-vous des commandes
d'horodatage pour sélectionner la
source de la trame de référence, ainsi
que son numéro de trame. La trame
de référence est le point de départ de
la mesure du temps relatif entre deux
trames.

Astuces
Les voies numériques et les bus ne sont pas disponibles en mode FastFrame.

Utilisez la fonction FastFrame lorsque vous souhaitez préserver les données associées à chaque événement de
déclenchement, à des fins d'analyse ou de contrôle visuel futur(e).

60 Manuel de l'utilisateur des gammes MSO70000C, DPO/DSA70000C, DPO7000C et MSO/DPO5000



Acquisition

Utilisez la fonction FastFrame lorsque vous souhaitez capturer plusieurs événements séparés par de longs temps
morts, qui ne vous intéressent pas.

Il est préférable d'afficher les trames multiples avec les palettes de couleur Normal, Vert ou Gris, car la couleur bleu
foncé de la trame sélectionnée risque d'être difficile à distinguer sur les palettes Temp et Spectral.

Utilisation de FastFrame Frame Finder
Frame Finder vous permet de rechercher une trame FastFrame différente des autres trames.

1. Sélectionnez la source des trames
FastFrame.

2. Réglez Search Range en entrant les
informations From Frame # et To
Frame #.

3. Appuyez sur Run/Stop pour arrêter les
acquisitions.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000
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4. Appuyez sur Start pour lancer la
recherche.

Frame Finder recherche et affiche une
trame différente.

5. Si l'anomalie que vous recherchez n'est
pas dans la trame affichée, appuyez sur
No. Frame Finder recherche une autre
trame différente.

6. Si l'anomalie que vous recherchez se
trouve dans la trame affichée, appuyez
sur Yes.

7. Si la recherche est terminée, appuyez
sur Stop.

8. Appuyez sur Run/Stop pour relancer les
acquisitions.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000
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Utilisation de TekLink et de MultiScope Trigger
Utilisez TekLink pour obtenir plus de 4 voies associées à un seul événement de déclenchement, pour obtenir plus de 4 voies
cherchant un problème sur une voie ou pour créer une grande porte AND avec plus de 4 entrées.

REMARQUE. En cas d'utilisation de MultiScope Trigger, les déclenchements B ne sont pas disponibles. TekLink et
MultiScope Trigger ne sont pas disponibles pour les instruments de la gamme DPO7000, MSO5000, et DPO5000.

Lier 2 instruments

1. Connectez deux instruments à l'aide d'un
câble TekLink.

2. L'état de la connexion TekLink est
indiqué dans l'affichage horizontal.

3. Sélectionnez Trig > A Event (Main)
Trigger Setup...
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4. Sélectionnez l'onglet MultiScope Trigger.

5. Activez le déclenchement de plusieurs
oscilloscopes en cochant la case Enable
MultiScope Triggering (with TekLink).

6. Cochez la case Sends Trigger
pour permettre à l'instrument de
déclencher les deux instruments en
configuration instrument-instrument.
L'autre instrument est automatiquement
réglé pour recevoir le déclenchement.
En l'absence de concentrateur, tous
les types de déclenchement sont
disponibles sur l'instrument fournissant
le déclenchement.

7. Pour calibrer MultiScope Trigger
(Déclenchement sur plusieurs
oscilloscopes), cliquez sur le bouton
Align (Aligner).
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Lier plusieurs instruments
Vous pouvez connecter deux instruments ou plus à l'aide d'un concentrateur TekLink.

1. Connectez deux instruments ou plus à
l'aide d'un concentrateur et de câbles
TekLink.

2. L'état de la connexion TekLink est
indiqué dans l'affichage horizontal.

3. Sélectionnez Trig > A Event (Main)
Trigger Setup...
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4. Sélectionnez l'onglet MultiScope Trigger.

5. Activez le déclenchement de plusieurs
oscilloscopes en cochant la case Enable
MultiScope Triggering (with TekLink).

6. Cochez la case Contribute pour
permettre à l'instrument de fournir
un déclenchement en configuration
TekLink. Les autres instruments sont
automatiquement réglés pour recevoir
le déclenchement.

7. Sélectionnez AND ou OR pour associer
tous les déclenchements de contribution
avant de déclencher tous les instruments
de la configuration TekLink.
Le déclenchement AND avec un
concentrateur fonctionne avec les types
de déclenchement sur front et sur mot.
Le déclenchement OR avec un
concentrateur fonctionne avec tous les
types de déclenchement.

8. Pour aligner MultiScope Trigger, cliquez
sur le bouton Align.

9. Si vous souhaitez que l'instrument balaie
le réseau TekLink pour déterminer les
instruments connectés à ce réseau,
appuyez sur le bouton Refresh.

10. Lorsque le déclenchement de plusieurs
oscilloscopes est activé, il est indiqué
dans l'affichage de déclenchement.
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Déclenchements Pinpoint
Le système de déclenchement Pinpoint est doté de types de déclenchement avancés utilisables à la fois sur les
déclencheurs A et B. Il permet de réinitialiser la séquence de déclenchement si l'événement B n'a pas lieu après un
certain nombre d'événements ou après un laps de temps spécifique. Les déclenchements Pinpoint prennent en charge la
capture des événements sur la base de l'événement de déclenchement le plus complexe ou d'une séquence d'événements
de déclenchement.
La fonctionnalité de déclenchement Pinpoint n'est disponible qu'en partie sur les instruments MSO5000 et DPO5000.

Cette section présente les concepts et les procédures d'utilisation du système de déclenchement.

Concepts de déclenchement
Evénement de déclenchement
L'événement de déclenchement établit le point de référence temporelle zéro dans l'enregistrement de signal. Toutes les
données de l'enregistrement de signal sont situées dans le temps par rapport à ce point. L'instrument effectue l'acquisition
en continu et conserve suffisamment de points d'échantillonnage pour compléter la portion de pré-déclenchement de
l'enregistrement de signal. Lorsqu'un événement de déclenchement se produit, l'instrument commence l'acquisition des
échantillons pour créer la portion de post-déclenchement de l'enregistrement de signal (c'est-à-dire la portion affichée après,
ou à droite, de l'événement de déclenchement). Une fois le déclenchement reconnu, l'instrument n'accepte plus d'autre
déclenchement jusqu'à ce que l'acquisition soit terminée et le temps d'inhibition écoulé.

Modes de déclenchement
Le mode de déclenchement détermine le comportement de l'instrument en l'absence d'un événement de déclenchement :

Le mode de déclenchement Normal permet à l'instrument d'effectuer l'acquisition d'un signal uniquement s'il y a
déclenchement. Si aucun déclenchement n'a lieu, le dernier enregistrement de signal acquis reste affiché. S'il n'existe
aucun dernier signal, rien ne s'affiche.

Le mode de déclenchement Auto permet à l'instrument d'effectuer l'acquisition d'un signal même sans présence de
déclenchement. Le mode Auto utilise un minuteur qui démarre une fois que l'événement de déclenchement s'est produit.
Si aucun autre événement de déclenchement n'est détecté avant l'arrêt du minuteur, l'instrument force le déclenchement.
Le temps d'attente d'un événement de déclenchement varie suivant le paramètre temporel initialement défini.

Lorsque le mode Auto force le déclenchement, en l'absence d'un événement de déclenchement valide, il ne synchronise
pas le signal à l'écran. Le signal traverse alors l’écran. Si un événement de déclenchement valide se produit, l'affichage
devient stable.

En mode déclenchement sur front, vous pouvez également forcer l'instrument au déclenchement en cliquant sur le bouton
Force Trigger dans la fenêtre de commande Trigger Setup.

Sélectionnez le mode de déclenchement souhaité dans le menu Trig > Mode. Pour plus d'informations, consultez l'aide en
ligne de l'instrument.
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Inhibition du déclenchement
L'inhibition du déclenchement peut permettre de stabiliser le déclenchement en étendant la période au cours de laquelle une
autre reconnaissance de déclenchement est supprimée après avoir initié une acquisition. Une telle extension peut permettre
au système d'ignorer les événements restants d'une salve récurrente d'événements et, par conséquent, de toujours se
déclencher sur le premier événement de chaque salve. Réglez le facteur d'inhibition pour obtenir un déclenchement stable
lorsque l'instrument se déclenche sur la base d'événements non valides.

Configurez l'inhibition de déclenchement souhaitée dans le menu Trig > Holdoff. Pour plus d'informations, consultez
l'aide en ligne de l'instrument.

Couplage de déclenchement
Le couplage de déclenchement détermine quelle partie du signal est transmise au circuit de déclenchement. Le
déclenchement sur front peut utiliser tous les types de couplage disponibles : CA, CC, Rejet basse fréquence, Rejet haute
fréquence et Rejet du bruit. Tous les autres types de déclenchement utilisent un couplage CC uniquement. Il se peut que
votre instrument ne prenne pas en charge tous les types de couplage.

Sélectionnez le couplage de déclenchement souhaité dans le menu de configuration Trig > A Event (Main) Trigger Setup.
Pour plus d'informations, consultez l'aide en ligne de l'instrument.

Position horizontale
La position horizontale détermine où a lieu le déclenchement dans l'enregistrement de signal. Elle vous permet de
choisir la quantité de données capturées avant et après l'événement de déclenchement. La portion de l'enregistrement
située avant le déclenchement est appelée portion de pré-déclenchement. La portion située après le déclenchement
est appelée portion de post-déclenchement.

Les données de pré-déclenchement sont très utiles lors du dépannage. Par exemple, si vous recherchez la cause d'un
parasite indésirable dans votre circuit de test, vous pouvez effectuer un déclenchement sur le parasite et allonger la
période de pré-déclenchement de façon à capturer les données avant le parasite. En analysant ce qui s'est passé avant le
parasite, il est possible que vous découvriez des informations qui vous aideront à trouver l'origine du parasite. Vous pouvez
également découvrir ce qui s'est passé suite à un événement de déclenchement, en allongeant suffisamment la période
post-déclenchement pour capturer les données après le déclenchement.

Pente et Niveau
La commande Pente détermine si l'instrument détecte le point de déclenchement sur le front montant ou descendant d'un
signal. La commande Niveau détermine où se situe le point de déclenchement sur le front.

Système de déclenchement retardé
Vous pouvez effectuer le déclenchement sur le système de déclenchement A uniquement (Principal) ou bien combiner le
déclenchement A (Principal) et le déclenchement B (Retardé), pour un déclenchement sur des événements séquentiels.
Lorsque vous utilisez un déclenchement séquentiel, l'événement A active le système de déclenchement et l'événement B
active l'instrument lorsque les conditions de déclenchement B sont satisfaites. Les déclenchements A et B peuvent avoir des
sources séparées ; c'est d'ailleurs souvent le cas. La condition de déclenchement B est basée sur un temps de retard ou sur
un nombre spécifique d'événements. (Voir page 74, Utilisation des déclenchements A (Principal) et B (Retardé).)
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Choix d'un type de déclenchement
Votre instrument vous permet de modifier les paramètres de déclenchement de base, à partir du panneau avant, ou de
configurer les paramètres de déclenchement avancés depuis la fenêtre de commande Trigger Setup.

REMARQUE. Certaines sélections du type de déclenchement ne sont pas disponibles sur certains instruments.

1. Sélectionnez Trig > Vertical Setup
(Déclenchement > Configuration
verticale).

2. Définissez la source, la pente, le
couplage et le mode à l'aide du menu de
configuration.
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3. Pour sélectionner l'un des autres types
de déclenchement, sélectionnez un type
de déclenchement directement dans le
menu Trig.

4. Terminez la configuration du
déclenchement en vous servant
des commandes relatives au type de
déclenchement. Les commandes de
configuration du déclenchement varient
en fonction du type de déclenchement,
du modèle de l'instrument et des options.
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Choix de déclenchement
Type de déclenchement Conditions de déclenchement
Front Déclenchement effectué sur le front montant ou descendant, tel que défini par la

commande Pente. Les options de couplage sont CC, CA, Rejet BF CA, Rejet HF
CA et Rejet bruit.

Parasite Déclenchement effectué sur une impulsion plus étroite (ou plus large) que la largeur
spécifiée ou bien ces mêmes parasites sont ignorés.

Largeur Déclenchement effectué sur des impulsions situées à l'intérieur ou à l'extérieur de
la plage temporelle spécifiée. Vous pouvez effectuer le déclenchement sur des
impulsions positives ou négatives.

Petite
impulsion

Déclenchement effectué sur une amplitude d'impulsion qui dépasse un seuil, mais
ne dépasse pas le seuil suivant avant de recroiser le premier seuil. Vous pouvez
détecter des petites impulsions positives ou négatives ou uniquement les petites
impulsions plus larges que la largeur spécifiée. Ces impulsions peuvent également
être qualifiées par l'état logique d'autres voies.

Fenêtre Déclenchement effectué lorsque le signal d'entrée dépasse le seuil supérieur défini
ou descend en dessous du seuil inférieur défini. Le déclenchement de l'instrument a
lieu lorsque le signal entre dans la fenêtre définie par les seuils, ou en sort. Qualifiez
l'événement de déclenchement en termes de temps en utilisant l'option Trigger When
Wider (déclenchement sur largeur supérieure) ou suivant l'état logique des autres
voies, en utilisant l'option Trigger When Logic (déclenchement sur état logique).

Délai Déclenchement effectué lorsque aucune impulsion n'est détectée dans le laps de
temps spécifié.

Transition Déclenchement effectué sur les fronts d'impulsion traversant deux seuils plus vite ou
plus lentement que le temps spécifié. Les fronts d'impulsion peuvent être positifs ou
négatifs.

Série Déclenchement sur séquence série 64 bits à des débits de données jusqu'à
1,25 Gb/s (modèles < 4 GHz) et un à quatre symboles 8b10b jusqu'à 3,125 Gb/s
(modèles ≥ 4 GHz uniquement) ou 6,25 Gb/s (modèles B ≥ 4 GHz). Verrou sur une
séquence de bits pseudo-aléatoire. Option ST1G ou ST6G requise. Ce mode inclut
une récupération d'horloge. Appuyez sur le bouton Set 50% (Définir 50 %) pour
réinitialiser la récupération d'horloge.
Position Lock (Verrouillage de position) trouve automatiquement une longue
séquence de bits pseudo-aléatoire (PRBS) répétitive et la verrouille. Ce verrou
signifie que l'instrument connaît la longueur de bits de la séquence de bits
pseudo-aléatoire et qu'il peut ainsi prédire la répétition du cycle. Position Lock
(Verrouillage de position) permet à l'instrument de prélever des échantillons à
des emplacements spécifiques d'une séquence de données, avec une précision
exceptionnelle de la base de temps. Option ST1G ou ST6G requise.

Séquence Déclenchement effectué sur des entrées logiques, qui entraîne un résultat Vrai ou
Faux pour la fonction. Vous pouvez également spécifier que les conditions logiques
doivent être satisfaites pendant un certain temps avant le déclenchement.

Etat Déclenchement effectué lorsque toutes les entrées logiques de la fonction logique
sélectionnée entraînent un résultat Vrai ou Faux pour la fonction, lorsque l'entrée
d'horloge change d'état.

Etablisse-
ment/Maintien

Déclenchement effectué lorsqu'une entrée logique change d'état en termes de temps
d'établissement et de maintien, par rapport à l'horloge. Le mode déclenche sur une
violation d'établissement et de maintien.
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Type de déclenchement Conditions de déclenchement
Comm Déclenchement effectué avec les tests de masque sur les normes et les codes de

communication (voies analogiques uniquement). Les commandes fonctionnent
ensemble pour définir les paramètres de l'événement de déclenchement (disponibles
avec l'Option MTM ou MTH sur certains instruments). Ce mode inclut une
récupération d'horloge. Appuyez sur le bouton Set 50% (Définir 50 %) pour
réinitialiser la récupération d'horloge.

Bus Déclenchement effectué sur les composants (comme une adresse spécifiée)
d'un bus défini par vos soins. Pour certains instruments et options, les types de
déclenchement incluent des déclenchements parallèles, SPI, RS-232, USB et I2C.

Vidéo Déclenchement effectué sur la base de champs ou de lignes spécifiques d'un signal
vidéo composite (gammes DPO7000C, MSO5000 et DPO5000 uniquement). Seuls
les formats de signal composite sont pris en charge.

CAN Déclenchement effectué sur les signaux de bus CAN.
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Vérification de l'état du déclenchement
Vous pouvez vérifier l'état du déclenchement à l'aide des voyants lumineux situés sur le panneau avant de l'instrument ou
depuis l'écran d'affichage.

Vérifiez les voyants du panneau avant ARM,
READY et TRIG'D afin de déterminer l'état
du déclenchement.

Si le voyant TRIG'D est allumé, cela
signifie que l'instrument a reconnu un
déclenchement valide et qu'il complète
la portion post-déclenchement du signal.

Si le voyant READY est allumé, cela
signifie que l'instrument peut accepter,
et attend, qu'un déclenchement
valide se produise. Les données
de pré-déclenchement ont déjà été
capturées.

Si le voyant ARM est allumé, cela
signifie que le circuit de déclenchement
est en train de compléter la portion de
pré-déclenchement de l'enregistrement
de signal.

Si les voyants TRIG'D et READY
sont tous deux allumés, cela signifie
qu'un déclenchement sur événement A
valide a été détecté et que l'instrument
est en attente d'un déclenchement
retardé. Lorsqu'un déclenchement
retardé est détecté, la portion de
post-déclenchement du signal retardé
est complétée à son tour.

Si les voyants ARM, TRIG'D et READY
sont éteints, cela signifie que toutes les
acquisitions sont arrêtées.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C
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Pour déterminer rapidement la configuration
de certains paramètres de déclenchement
clés, consultez l'affichage Déclenchement
situé en bas de l'écran. Les affichages
varient pour les déclenchements sur front et
avancés :

1. Source de déclenchement A = Voie 1

2. Pente de déclenchement = front montant

3. Niveau de déclenchement

4. Base de temps

5. Vérifiez les valeurs ARM, READY et
TRIG'D afin de déterminer l'état du
déclenchement.

6. Vérifiez la valeur Auto/Normal afin de
déterminer le mode de déclenchement.

Utilisation des déclenchements A (Principal) et B (Retardé)
Vous pouvez utiliser le déclenchement sur événement A (Principal) pour les signaux simples ou le combiner avec le
déclenchement sur événement B (Retardé) pour capter des signaux plus complexes. Une fois que l'événement A se produit,
le système de déclenchement recherche l'événement B avant de lancer le déclenchement et d'afficher le signal.

Déclenchement A

1. Sélectionnez Trig > A Event
(Main)Trigger Setup...
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2. Définissez le type et la source du type de
déclenchement A, dans l'onglet A Event.

Déclenchement B (Retardé)

REMARQUE. Les déclenchements B ne
sont pas disponibles si MultiScope Trigger
est activé.

3. Choisissez une fonction dans l'onglet
A →B Seq.

4. Définissez le retard de déclenchement
ou le nombre d'événements B.
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5. Définissez les caractéristiques du
déclenchement B dans l'onglet B Event
(Delayed).

6. Sélectionnez Normal et Auto, dans les
sections Trigger Mode et Holdoff de
l'onglet Mode.

Déclenchement sur événement B

Le déclenchement A arme l'instrument.
L'acquisition post-déclenchement commence
sur le nième événement B.

Déclenchement B après retard

Le déclenchement A arme l'instrument.
L'acquisition post-déclenchement démarre
sur le premier front B après le retard de
déclenchement.
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Déclenchement avec réinitialisation

Vous pouvez spécifier une condition afin de
réinitialiser le système de déclenchement
si ce dernier se produit avant l'événement
de déclenchement B. Lorsque l'événement
de réinitialisation se produit, le système
de déclenchement arrête d'attendre un
événement B et revient au statut d'attente
de l'événement A.
La fonction Déclenchement avec
réinitialisation n'est pas disponible sur les
instruments MSO5000 et DPO5000.

Astuces
Le retard de déclenchement B et le retard horizontal sont des fonctions indépendantes. Lorsque vous établissez une
condition de déclenchement en utilisant soit le déclenchement A seul, soit les déclenchements A et B ensemble, vous
pouvez également utiliser le retard horizontal pour retarder l'acquisition d'un laps de temps supplémentaire.

Correction de la position de déclenchement
La correction de la position de déclenchement rectifie les différences dans le chemin de données et le chemin de
déclenchement, afin de positionner plus précisément le déclenchement sur le signal affiché. La correction de la position de
déclenchement peut également utiliser un moyennage pour placer le déclenchement avec plus de précision sur des signaux
bruyants. Pour un positionnement plus précis sur l’écran des déclenchements sur front, observez la procédure suivante.

1. Pour un positionnement plus précis à
l’écran des déclenchements sur front,
sélectionnez Enhanced Triggering.
Pour un positionnement plus précis
des déclenchements sur des signaux
bruyants, sélectionnez également
Optimized for Noisy Signals.
La sélection Optimized for Noisy
Signals est uniquement disponible si
Enhanced Triggering est sélectionné.
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Déclenchement avec balayage d'événement B
Utilisez A->B Sequence (Séquence A->B) B-Event Scan (Balayage d'événement B) pour créer des diagrammes de l'œil
imbriqués, synchronisés ou initiés par un événement de déclenchement A.

B-Scan de l'événement n'est pas disponible sur les instruments MSO5000 et DPO5000.

Trig on nth Event (Déclenchement au nième événement) capture le nième événement B qui survient après l'événement A
pour toutes les acquisitions. B-Event Scan (Balayage d'événement B) avance automatiquement la valeur de l'événement B
pour capturer différentes portions du signal.

1. Définissez le type et la source du type de
déclenchement A, dans l'onglet A Event
(Evénement A).

2. Définissez le type et la source du type de
déclenchement B, dans l'onglet B Event
(Evénement B).

3. Pour un positionnement plus précis à
l'écran des déclenchements sur front,
sélectionnez Enhanced Triggering
(Déclenchement amélioré). Pour
un positionnement plus précis des
déclenchements sur des signaux
bruyants, sélectionnez également
Optimized for Noisy Signals (Optimisé
pour les signaux bruyants).
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4. Sélectionnez Trig on nth Event
(Déclenchement au nième événement)
et B Event Scan (Balayage d'événement
B) dans l'onglet A>B Seq (Séquence
A->B).

5. Pour afficher la fenêtre de configuration
du balayage d'événement B, appuyez sur
B Event Scan (Balayage d'événement B)
> Setup (Configuration).

6. Définissez la valeur de départ de
l'événement B.

7. Définissez la valeur de fin de l'événement
B.

8. Définissez le nombre d'acquisitions
avant incrémentation de la valeur de
l'événement B.
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9. Sélectionnez la méthode
d'incrémentation de l'événement B après
réalisation du nombre d'acquisitions
sélectionné :

Sequential Scan (Balayage
séquentiel) incrémente de 1 jusqu'à
atteindre la fin de l'événement.
Lorsque la fin de l'événement est
atteinte, la valeur de l'événement B
est réinitialisée à la valeur de départ
de l'événement et le processus
redémarre.
Random Scan (Balayage aléatoire)
définit la valeur de l'événement B sur
une valeur aléatoire entre le début de
l'événement et sa fin, pour chaque
ensemble d'acquisitions Advance
After (Avancer après).
Toggle Between Events (Basculer
entre les événements) fait basculer
la valeur de l'événement B
entre l'événement de départ et
l'événement de fin pour chaque
ensemble d'acquisitions Advance
After (Avancer après).
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10. Dans cet exemple, un signal DDR3 DQS
est sur Ch 1 et le signal DQ sur Ch 2.
L'instrument est en Run Mode (Mode
d'exécution) avec le Display Mode (Mode
d'affichage) réglé sur Infinite Persistence
(Persistance infinie). La configuration
de déclenchement de l'instrument est la
suivante :

Déclenchement sur fenêtre
d'événement A sur Ch 1 pour
détecter la condition d'écriture DDR3
DQS.
Déclenchement sur front
d'événement B sur pente nulle
sur Ch 1 pour activer les fronts DQS
(horloge).
A->B Sequence (Séquence
A->B) réglée sur Trig on the nth
Event (Déclenchement au nième
événement).
B Scan Enabled (Balayage B
activé) avec Start Event (Début
d'événement) = 1, End Event
(Fin d'événement) = 8 et Mode =
Sequential (Séquentiel).
Les yeux sont formés par le signal
DQ sur Ch 2.

Manuel de l'utilisateur des gammes MSO70000C, DPO/DSA70000C, DPO7000C et MSO/DPO5000 81



Déclenchements Pinpoint

Déclenchement sur un bus parallèle
Déterminez les problèmes grâce au déclenchement sur un bus parallèle. Les instruments peuvent utiliser des voies
numériques comme composants d'un bus parallèle.

1. Sélectionnez Trig > A Event (Main)
Trigger Setup... (Déclencher >
Configuration du déclenchement sur
événement A (principal)...).

2. Sélectionnez l'onglet A Event
(Evénement A).
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3. Dans la section Trigger Type (Type de
déclenchement), sélectionnez Bus.

4. Sélectionnez le bus sur lequel
déclencher.

REMARQUE. Les bus synchronisés
n'apparaissent dans la liste déroulante que
si la source d'horloge est réglée sur Ch4.
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5. Cliquez sur le bouton Edit (Modifier)
pour définir la séquence et le format sur
lesquels déclencher.

6. Définissez la séquence sur laquelle
déclencher à l'aide du pavé numérique.

7. Analysez vos signaux.
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Déclenchement sur un bus série
Déterminez les problèmes grâce au déclenchement sur un bus série. Des bus série sont disponibles sur les instruments des
gammes MSO70000, MSO5000 et DPO5000. Des voies numériques peuvent être utilisées dans les définitions de bus pour
les instruments MSO.

1. Configurez un bus série (Voir page 50,
Configuration d'un bus.).

2. Sélectionnez Trig > A Event (Main)
Trigger Setup... (Déclencher >
Configuration du déclenchement sur
événement A (principal)...).

3. Sélectionnez l'onglet A Event
(Evénement A).
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4. Dans la section Trigger Type (Type de
déclenchement), sélectionnez Bus.

5. Sélectionnez le bus.

6. Sélectionnez le signal de bus sur lequel
déclencher.

7. En fonction de votre choix dans la liste
Trigger On (Déclencher sur) et du type
de bus, effectuez les sélections requises
pour le bus.
Consultez l'aide en ligne pour en savoir
plus sur la configuration d'un bus.
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Envoi d'un e-mail lors du déclenchement
Vous devez configurer la fonction E-mail sur événement avant d'effectuer la procédure suivante. (Voir page 88, Configuration
de l'envoi d'un e-mail pour un événement.)

1. Sélectionnez Trig > A Event (Main)
Trigger Setup...

2. Sélectionnez l'onglet Mode.

3. Dans la section E-mail on Trigger, cliquez
sur On, puis cliquez sur Setup. (Voir
page 88, Configuration de l'envoi d'un
e-mail pour un événement.)
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Configuration de l'envoi d'un e-mail pour un événement
1. Sélectionnez Utilities > E-mail on

Event > Setup... (Utilitaires > E-mail sur
événement > Configuration...).

2. Entrez l'adresse e-mail des destinataires.
Séparez les entrées multiples par des
virgules. La zone d'adresse ne peut
contenir plus de 252 caractères.

3. Cliquez sur Config, puis entrez l'adresse
du serveur SMTP. Contactez votre
administrateur réseau pour savoir quelle
adresse utiliser.
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4. Sélectionnez le ou les événements pour
lesquels vous souhaitez envoyer un
e-mail.

5. Pour inclure des pièces jointes,
sélectionnez le type de pièce jointe
souhaité, puis cliquez sur Settings pour
en spécifier le format.

6. Définissez la limite de message et la
taille d'e-mail maximum Lorsque la
limite de message est atteinte, vous
devez cliquer sur Reset pour pouvoir
envoyer davantage d'e-mails pour cet
événement.

7. Pour vérifier que les adresses
électroniques définies sont correctes,
envoyez un message test en cliquant sur
Send (Envoyer).

8. Si nécessaire, cliquez sur Config pour
accéder à la boîte de dialogue de
configuration de l'e-mail et réglez les
paramètres à votre convenance.

Astuces
Pour enregistrer des pièces jointes sur le disque dur de l'instrument, configurez Max E-mail Size (taille maximum du
message) sur zéro. Les pièces jointes sont enregistrées à l'emplacement par défaut C:\TekScope\Screen Captures,
Waveforms ou Data, suivant le type de pièce jointe choisi.

Des messages d'erreur s'affichent si vous n'entrez pas une adresse e-mail valide ou une adresse de serveur SMTP.

Manuel de l'utilisateur des gammes MSO70000C, DPO/DSA70000C, DPO7000C et MSO/DPO5000 89



Déclenchements Pinpoint

Utilisation du retard horizontal
Utilisez la fonction de retard horizontal pour
faire l'acquisition du détail du signal, dans
une région qui est séparée du point de
déclenchement par un intervalle de temps
important.

1. Sélectionnez Horiz/Acq >
Horizontal/Acquisition Setup
(Configuration de l'acquisition
horizontale).

2. Appuyez sur la touche Delay Mode pour
activer le mode retard.

3. Ajustez le temps de retard à l'aide de la
commande POSITION horizontale ou
saisissez directement le temps de retard
dans la fenêtre de commande.

4. Ajustez l'échelle horizontale (SCALE)
pour capturer les détails dont vous avez
besoin.

Astuces
Vous pouvez utiliser conjointement les fonctions Zoom MultiView et Retard horizontal pour agrandir une acquisition
retardée.

Activez et désactivez rapidement le retard horizontal pour comparer les détails du signal sur deux zones d'intérêt
différentes, l'une près du point de déclenchement et l'autre centrée sur le retard.
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Affichage d'un signal
Cette section présente les concepts et les procédures d'affichage d'un signal. Des informations plus détaillées sont
disponibles dans l'aide en ligne.

Configuration du style d'affichage
Pour définir le style d'affichage, sélectionnez
Display > Display Style, puis choisissez l'un
des styles suivants :

Affiche les signaux
sous forme de lignes
tracées entre les points
d'enregistrement.

Affiche les points
d'enregistrement du
signal sous forme de
points, à l'écran.

Affiche les échantillons
réels. Les points
interpolés ne sont pas
affichés.
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Configuration de la persistance d'affichage
Sélectionnez Display > Display
Persistence, puis choisissez le type
de persistance souhaité.

L'option Pas de persistance (No
persistence) affiche les points
d'enregistrement pour l'acquisition en
cours uniquement. Chaque nouvel
enregistrement de signal remplace le
précédent, pour une voie.

L'option Persistance infinie (Infinite
persistence) cumule en permanence
les points d'enregistrement, jusqu'à ce
que vous modifiiez l'un des paramètres
d'affichage de l'acquisition. Utilisez cette
option pour afficher les points capturés
en-dehors de l'enveloppe d'acquisition
normale.

L'option Persistance variable (Variable
persistence) cumule les points
d'enregistrement pendant un laps
de temps spécifique. Chaque
point d'enregistrement se dégrade
indépendamment, suivant le laps de
temps choisi.

La réinitialisation de la persistance
annule la persistance.

1. Pour définir le temps de persistance
variable, sélectionnez Display > Display
Persistence > Persistence Controls....

2. Cliquez sur Variable, Persist Time,
puis servez-vous des boutons d'usage
général pour choisir le temps de
persistance souhaité.
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Configuration du format d'affichage
L'instrument peut afficher les signaux dans trois formats différents. Choisissez le format qui correspond le mieux à vos
besoins.

Sélectionnez Display > Display Format.

Sélectionnez le format YT pour afficher
l'amplitude d'un signal à mesure qu'elle
évolue dans le temps.

Sélectionnez le format XY pour
comparer point par point l'amplitude des
enregistrements de signal :
Les voies suivantes sont comparées :
Ch 1 (X) et Ch 2 (Y),
Ch 3 (X) et Ch 4 (Y),
Réf 1 (X) et Réf 2 (Y),
Réf 3 (X) et Réf 4 (Y),

Sélectionnez le format XYZ pour
comparer les niveaux de tension des
enregistrements du signal Ch 1 (X) et
Ch 2 (Y) point par point comme dans
le format d’affichage XY. L'intensité
du signal affiché est modulée par
l'enregistrement du signal Ch 3 (Z). Le
format XYZ est déclenché. Un signal
de -5 divisions (position et décalage
compris) sur Ch 3 génère un écran vide ;
un signal de +5 divisions génère une
intensité maximale.

Astuces
Le format XY est particulièrement utile lors de l'étude des relations de phase, telles que les figures de Lissajous.

Le format XY est un affichage des points seuls, bien qu'il puisse avoir une persistance. Le style Vecteur n'a aucun
effet lorsque vous sélectionnez le format XY.

Pour les instruments des gammes MSO5000 et DPO5000, le mode Fast Acq (Acq. rapide) n'est pas disponible en
mode Affichage XY ou XYZ.
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Sélection de l'interpolation du signal
Sélectionnez Display > Waveform
Interpolation, puis choisissez l'une des
options suivantes :

L'interpolation Sin(X)/X calcule les points
d'enregistrement à l'aide d'une courbe
entre les échantillons réels capturés.

L'interpolation linéaire calcule les points
d'enregistrement entre les échantillons
réels capturés, à l'aide d'un ajustement
linéaire.
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Astuces
L'interpolation Sin(X)/X est le mode d'interpolation par défaut. Il exige moins de points d'échantillonnage réels que
l'interpolation linéaire pour représenter un signal de manière précise.

Ajout de texte à l'écran
1. Sélectionnez Display > Screen Text.

2. Entrez jusqu'à huit lignes de texte
indépendantes.

3. Cliquez sur Off ou On sous Text pour
activer ou désactiver l'affichage du texte.

4. Cliquez sur Font ou Color pour
sélectionner la police et la couleur du
texte à l’écran.

5. Cliquez sur Controls pour ouvrir la
fenêtre de commande Text Properties
(Propriétés du texte), afin de positionner
le texte à l'écran.

6. Cliquez sur Clear pour effacer la totalité
du texte dans la ligne sélectionnée.

Astuces
Vous pouvez cliquer sur le texte et le faire glisser pour le repositionner à l'écran.

Vous pouvez également donner des libellés aux signaux et aux bus (Voir page 49, Configuration des voies numériques.)
(Voir page 50, Configuration d'un bus.).
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Configuration du style du réticule
Pour définir le style du réticule, sélectionnez
Display > Graticule Style, puis choisissez
l'un des styles suivants :

Utilisez ce style pour
avoir un aperçu rapide
des paramètres du
signal.

Utilisez ce style pour
afficher les mesures
en plein écran, avec
des curseurs et des
affichages automatiques,
lorsqu'il n'est pas
nécessaire d'utiliser
un affichage en Croix.
Utilisez ce style pour
avoir un rapide aperçu
des signaux, tout en
laissant de l'espace
pour les affichages
automatiques et d'autres
données.
Utilisez ce style avec des
affichages automatiques
et d'autres écrans de
texte, lorsque vous
n'avez pas besoin des
fonctions d'affichage.
Utilisez ce style pour les
signaux vidéo NTSC.

Utilisez ce style pour les
signaux vidéo autres que
NTSC.
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Configuration du marqueur de niveau de déclenchement
1. Sélectionnez Display > Objects....

2. Sélectionnez l'une des options
suivantes :

L'option Short affiche une courte
flèche sur le côté du réticule.

L'option Long affiche une ligne
horizontale sur toute la longueur du
réticule.

L'option Off désactive le marqueur
du niveau de déclenchement.

Affichage de la date et de l’heure
1. Sélectionnez Display > Objects....

2. Basculez entre l'affichage de la date
et de l'heure, sur le réticule. Utilisez
le menu Utilities pour régler la date et
l'heure.
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Utilisation des palettes de couleurs
Sélectionnez Display > Record View
Palette ou FastAcq/WfmDB Palette, puis
sélectionnez l'un des modèles de couleurs
suivants pour le signal et le réticule :

La palette Normal affiche les niveaux
de teinte et de clarté pour un affichage
global de meilleure qualité. La couleur
de chaque signal de voie correspond à
la couleur du bouton correspondant sur
le panneau avant.

La palette Temperature Grading affiche
dans des tons rouges les zones du
signal dotées de la plus forte densité
d'échantillonnage. Les zones dont la
densité est moindre apparaissent dans
des tons bleus.

La palette Monochrome Green affiche
dans des tons vert clair les zones du
signal dotées de la plus forte densité
d'échantillonnage. Les zones dont la
densité est moindre apparaissent dans
des tons vert foncé. Cet affichage
s'approche davantage des écrans
d'oscilloscope analogique classique.

La palette Spectral grading affiche
dans des tons bleus les zones du
signal dotées de la plus forte densité
d'échantillonnage. Les zones dont la
densité est moindre apparaissent dans
des tons rouges.

La palette Monochrome gray affiche
dans des tons gris clair les zones du
signal dotées de la plus forte densité
d'échantillonnage. Les zones dont la
densité est moindre apparaissent dans
des tons gris foncé.

Le signal s'affiche dans les couleurs
définies par l'utilisateur.
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Astuces
Sélectionnez l'une des palettes de couleurs dans la fenêtre de commande Display > Colors, pour afficher les différentes
densités d'échantillonnage dans des couleurs différentes.

Il existe deux palettes de couleurs, une pour la vue d'enregistrement et une pour les fonctions FastAcq/WfmDB.

Configuration des couleurs de signal de référence
Sélectionnez Display > Colors..., puis
choisissez l'une des options suivantes :

L'option Default utilise la couleur système
par défaut pour les signaux de référence.

L'option Inherit utilise la même couleur
pour le signal de référence et le signal
original.
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Configuration des couleurs de signal calculées
Sélectionnez Display > Colors..., puis
choisissez l'une des options suivantes :

L'option Default utilise la couleur système
par défaut pour les signaux calculés.

L'option Inherit utilise la même couleur
pour le signal calculé que pour le signal
de la voie la plus basse sur laquelle la
fonction mathématique est basée.

Astuces
La couleur par défaut pour les signaux calculés et de référence varie à chaque signal.

Utilisation du zoom MultiView
Utilisez la fonction Zoom MultiView pour agrandir un signal verticalement, horizontalement ou dans les deux sens. Les
signaux agrandis peuvent également être alignés ou verrouillés, et vous pouvez les faire défiler automatiquement. Les
paramètres d'échelle et de position affectent uniquement l'affichage, et non les données du signal elles-mêmes.

1. Appuyez sur MultiView Zoom pour
diviser l'écran en deux et ajouter un
réticule de zoom.
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2. Appuyez sur HORIZ ou sur VERT pour
sélectionnez suivant quel axe le zoom
est appliqué dans le réticule. Utilisez
les boutons d'usage général pour régler
l'échelle et la position du signal agrandi.
Dans cet exemple, le réticule principal
est la moitié supérieure du réticule et
le réticule faisant l’objet de zoom est la
moitié inférieure du réticule.

REMARQUE. Vous pouvez masquer ou
afficher les signaux agrandis en appuyant sur
Show/Hide Waveforms (Afficher/masquer
les signaux) et en sélectionnant les signaux
que vous souhaitez afficher.

3. Pour régler la taille du réticule de zoom,
sélectionnez Zoom Graticule Size dans
le menu Vertical ou Horiz/Acq.

4. Pour désactiver le zoom, appuyez sur le
bouton correspondant dans le panneau
avant.

Astuces
Vous pouvez également utiliser le menu Zoom Setup pour modifier la taille du réticule du signal agrandi.

Wave Inspector vous permet de traiter les signaux à longueur d'enregistrement élevée. (Voir page 106, Utilisation de
Wave Inspector pour traiter les signaux à longueur d'enregistrement élevée.)
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Zoom sur plusieurs zones
Lorsque vous souhaitez afficher et comparer simultanément plusieurs zones d'un enregistrement, observez la procédure
suivante.

1. Définissez la zone de signal souhaitée
en cliquant dessus et en faisant glisser
le curseur pour la délimiter.

2. Sélectionnez Zoom 1 On.

3. En cliquant et en faisant glisser le
curseur, délimitez la zone du signal
que vous souhaitez agrandir, puis
sélectionnez Zoom 2 On.

4. Pour ajuster la zone de zoom
horizontalement, cliquez sur le marqueur
horizontal situé en dessous de la
case Zoom pour sélectionner la zone
agrandie.

5. Utilisez les boutons d'usage général
pour ajuster la position horizontale et le
facteur de zoom de la zone de signal
agrandie.
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6. Pour ajuster la zone de zoom
verticalement, sélectionnez Vertical >
Zoom Setup..., cliquez sur un champ
vertical, puis utilisez les boutons d'usage
général pour ajuster la position verticale
et le facteur de zoom.

Astuces
Pour faire disparaître la zone de zoom, cliquez sur Position Factor Reset dans la fenêtre de commande Zoom Setup.

Vous pouvez activer ou désactiver chaque fenêtre de zoom depuis la fenêtre de commande Zoom Setup.

Appuyez sur le bouton MultiView Zoom pour activer ou désactiver tous les zooms.

Pour repositionner horizontalement la zone de zoom, cliquez sur le marqueur horizontal et faites-le glisser jusqu'en
bas de la zone de zoom.

Wave Inspector vous permet de traiter les signaux à longueur d'enregistrement élevée. (Voir page 106, Utilisation de
Wave Inspector pour traiter les signaux à longueur d'enregistrement élevée.)

Verrouillage et défilement des signaux agrandis
1. Pour utiliser la fonction de verrouillage

et de défilement, sélectionnez Zoom
Setup... dans le menu Vertical ou
Horiz/Acq, puis sélectionnez l'onglet
Lock and Scroll.
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2. Pour faire défiler une zone de zoom
unique, cochez la case d'option
Zoom 1-4, puis cliquez sur le bouton
Auto Scroll.

3. Pour faire défiler plusieurs zones de
zoom simultanément, cliquez sur Lock,
puis cochez la case d'option Zoom 1-4
souhaitée pour le défilement.
La fonction Lock permet de verrouiller
les zones de zoom dans leur position
horizontale respective. Ensuite, si vous
modifiez la position horizontale de l'une
des zones verrouillées, toutes les autres
zones sont également modifiées.
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Astuces
Lorsque plusieurs zones de zoom sont sélectionnées mais non verrouillées, la zone dont le numéro est le plus élevé
défile automatiquement, tandis que les autres restent stationnaires.

Masquage des signaux dans la fenêtre agrandie
1. Pour masquer ou afficher les

signaux, sélectionnez Zoom Setup...
(Configuration du zoom…) à partir
du menu Vertical ou Horiz/Acq
(Horizontal/Acquisition).

2. Sélectionnez un onglet Zoom et
appuyez sur Show/Hide Waveforms
(Afficher/masquer les signaux).

3. Sélectionnez la zone agrandie qui
contient le signal à afficher ou à
masquer.

4. Décochez le signal de voie, calculé,
de référence ou numérique que vous
souhaitez masquer.

Les voies numériques sont disponibles
uniquement sur les instruments de la
gamme MSO.
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Utilisation de Wave Inspector pour traiter les signaux à longueur
d'enregistrement élevée

Les commandes Wave Inspector (panoramique/zoom, lecture/pause, marquage, recherche) vous permettent de traiter de
manière efficace les signaux à longueur d'enregistrement élevée. Pour agrandir un signal horizontalement, tournez le bouton
Zoom. Pour faire défiler un signal zoomé, tournez le bouton Pan.

Wave inspector est disponible sur les instruments des gammes MSO5000 et DPO5000.

La commande Pan-Zoom se compose
des éléments suivants :

1. Un bouton extérieur (Pan)

2. Un bouton intérieur (Zoom)

Zoom sur un signal

Pour utiliser la fonction zoom :

1. Tournez le bouton intérieur de la
commande Pan-Zoom, dans le sens
horaire, pour effectuer un zoom avant
sur une partie sélectionnée du signal.
Tournez le bouton dans le sens
antihoraire pour effectuer un zoom
arrière.

2. Vous pouvez également activer ou
désactiver le zoom en appuyant sur le
bouton zoom.

(Voir page 100, Utilisation du zoom
MultiView.)
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3. Examinez la vue zoomée du signal,
qui s'affiche dans la partie inférieure
agrandie de l'écran. La partie supérieure
de l'écran affiche la position et la taille
de la partie zoomée sur l'ensemble de
l'enregistrement de signal.

Panoramique sur un signal

Lorsque la fonction zoom est activée, utilisez la fonction panoramique pour faire défiler rapidement le signal. Pour utiliser
la fonction panoramique :

1. Tournez le bouton panoramique
(extérieur) des commandes Pan-Zoom
pour effectuer un panoramique du
signal.
Tournez le bouton dans le sens horaire
pour effectuer un panoramique avant.
Tournez-le dans le sens antihoraire
pour effectuer un panoramique arrière.
Plus vous tournez le bouton, plus
la fenêtre de panoramique avance
rapidement.

Lecture et pause d'un signal

Utilisez la fonction Lecture/Pause pour faire défiler automatiquement un enregistrement de signal. Observez la procédure
suivante :

1. Pour activer le mode Lecture/Pause,
appuyez sur le bouton correspondant.

2. Ajustez la vitesse de lecture en
tournant le bouton panoramique
(extérieur). Plus vous tournez le
bouton, plus la vitesse est rapide.
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3. Vous pouvez également changer le
sens de lecture en inversant le sens de
rotation du bouton panoramique.

4. En cours de lecture, jusqu'à un certain
point, plus vous tournez le bouton
extérieur, plus le signal accélère.
Si vous tournez le bouton extérieur
au maximum, la vitesse de lecture
ne change plus, mais la zone de
zoom se déplace rapidement dans
cette direction. Servez-vous de cette
fonction de rotation maximum pour
répéter la lecture d'une partie du signal
que vous venez de visionner et que
vous souhaitez revoir.

5. Pour interrompre le mode
Lecture/Pause, appuyez de nouveau
sur ce bouton.

Recherche et marquage des signaux
Vous pouvez marquer des points intéressants dans le signal acquis. Ces marqueurs vous aident à limiter votre analyse
à des portions spécifiques du signal. Vous pouvez marquer des portions du signal automatiquement, si elles répondent
à certains critères, ou les marquer manuellement et individuellement. Vous pouvez passer d'un marqueur à un autre
(d’une zone intéressante à une autre zone intéressante). Vous pouvez automatiquement rechercher et marquer différents
paramètres servant de déclencheur. Un grand nombre de paramètres de recherche n’ont pas les limites de temps des
déclencheurs. Vous pouvez effectuer une recherche sur des signaux calculés ou des signaux de référence. Vous pouvez
trouver tous les événements acquis d’un certain type.

Les marqueurs de recherche servent ainsi à signaler des portions du signal, pour référence. Vous pouvez définir d'effectuer
un marquage automatique à l'aide de critères de recherche. Vous pouvez effectuer votre recherche sur la base de critères
tels que des fronts, des largeurs d'impulsion, des petites impulsions, des états logiques, des temps de montée/descente, des
violations des temps d’établissement et de maintien et des types de bus spécifiques.

Les options Search (Rechercher) et Mark (Marquer) ne prennent pas en charge les signaux numériques.
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Pour définir et supprimer manuellement des marqueurs :

1. Appuyez sur Multiview Zoom. Le zoom
1 est utilisé avec des marqueurs.

2. Sélectionnez Analyze > Search.

3. Déplacez (la fenêtre de zoom) jusqu'à
la zone du signal où vous souhaitez
créer (ou supprimer) un marqueur de
recherche en tournant le bouton d’usage
général.
Appuyez sur le bouton Next (Suivant)
( →) ou Prev (Précédent) (←) pour
passer à un marqueur existant.

4. Appuyez sur Set Clr ou sur le bouton
Set/Clear (Définir/Supprimer) sur le
panneau avant.
Si aucun marqueur de recherche ne se
trouve au centre de l'écran, l'instrument
en ajoute un.
Lorsqu’un marqueur est créé, le facteur
de zoom horizontal est enregistré. Si
vous utilisez Next ou Prev pour passer
d’un marqueur à un autre, le facteur de
zoom est rétabli.
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5. Analysez votre signal en passant d'un
marqueur de recherche à un autre.
Utilisez le bouton Next ( →) ou Prev (←)
pour passer d'un point marqué à un autre
sans régler aucune autre commande.

6. Supprimez un marqueur. Appuyez
sur le bouton Next (Suivant) ( →) ou
Prev (Précédent) (←) pour passer au
marqueur que vous souhaitez supprimer.
Pour supprimer le marqueur placé au
centre, appuyez sur le bouton Set Clr
ou sur le bouton Set/Clear du panneau
avant. Cette commande fonctionne sur
les marqueurs créés automatiquement
et manuellement.

Pour définir et supprimer automatiquement des marqueurs de recherche :

1. Appuyez sur Search (Rechercher)
ou sélectionnez Analyze > Search
(Analyser > Rechercher).

2. Sélectionnez le type de recherche
souhaitée à partir du menu.
Le menu de recherche est similaire au
menu de déclenchement.
Les recherches de bus série sont en
option.
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3. Configurez votre recherche dans l’onglet
Configure. Pour copier la configuration
du déclenchement ou une configuration
de recherche, appuyez sur Settings
Copy.

4. Dans la fenêtre de copie des réglages,
sélectionnez l’emplacement d’origine et
l’emplacement de destination. Appuyez
sur Copy puis sur Close.

5. Pour modifier la configuration de
recherche actuelle, réglez les
commandes affichées. Les commandes
affichées varient en fonction de la
recherche sélectionnée.

6. Si ce n’est pas encore fait, appuyez sur
Search pour activer la recherche.
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7. Sur l'écran, des triangles indiquent
l'emplacement des marqueurs
automatiques ; les triangles à contour
blanc indiquent les marqueurs
personnalisés (définis par l'utilisateur).
Ils apparaissent à la fois sur les vues
normales et agrandies.

8. Vous pouvez rechercher rapidement
votre signal en passant d’un marqueur
à un autre à l’aide des boutons fléchés
Next (Suivant) ( →) et Prev (Suivant)
(←). Aucun autre réglage n'est
nécessaire.

9. Pour basculer entre l’affichage du
comptage d’événements de recherche
et l’heure des marqueurs, sélectionnez
l’onglet Results puis appuyez sur View
Count.

10. Pour supprimer tous les marqueurs du
tableau, appuyez sur All Marks Clear.

11. Pour exporter le tableau des marqueurs
dans un fichier, appuyez sur All Marks
Export.
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12. Pour convertir un marqueur ou tous les
marqueurs en marqueurs utilisateur,
appuyez sur Search Marks Save or Save
All.

13. Pour supprimer la rangée en surbrillance
du tableau de marqueurs, appuyez sur
Search Marks Clear.

14. Pour basculer entre l’affichage des
emplacements des marqueurs au format
technique et au format haute précision,
appuyez sur Digits.

15. Pour activer et désactiver l’affichage des
triangles de marquage, sélectionnez
l’onglet View puis appuyez sur Show
Marks.

16. Pour interrompre les acquisitions
lorsqu’une correspondance est
trouvée, sélectionnez l’onglet Mode et
sélectionnez Stop Acquisition if event
found.

Astuces
La recherche s’effectue uniquement sur les données acquises. Configurez l’instrument afin d’acquérir les données
que vous recherchez.

Définissez la fréquence d’échantillonnage afin que l’événement objet de la recherche soit décelable. Vous pouvez
rechercher un parasite plus large qu’une paire d’intervalles d’échantillonnage.

Vous pouvez copier des paramètres de déclenchement afin de rechercher dans le signal capturé des emplacements
répondant aux conditions de déclenchement. Vous pouvez copier des paramètres de recherche dans vos paramètres
de déclenchement.

Les marqueurs de recherche de fronts sont créés sans facteurs de zoom. D’autres types de recherche créent des
marqueurs avec un facteur de zoom approprié.

En appuyant sur Bring Zoom to Mark (Zoomer sur le marqueur) Zoom 2 ou Zoom 3, le zoom ayant les mêmes
paramètres que le Zoom 1 s’affiche.
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Les marqueurs personnalisés sont enregistrés avec le signal lors de sa sauvegarde et lors de la sauvegarde de la
configuration.

Les marqueurs de recherche automatiques ne sont pas enregistrés en même temps que le signal. Les critères de
recherche sont, toutefois, enregistrés dans la configuration. Vous pouvez donc facilement les recréer en utilisant de
nouveau la fonction de recherche.

La recherche comprend les fonctions de recherche suivantes :

Recherche Description
Front Recherche les fronts (montants ou descendants) avec un niveau de seuil défini par

l'utilisateur.
Parasite Recherche les impulsions plus étroites (ou plus larges) que la largeur spécifiée ou ignore

les parasites plus étroits (ou plus larges) que la largeur spécifiée.
Larg.impuls Recherche les largeurs d'impulsion positives ou négatives qui sont >, <, = à ou ≠ d'une

largeur d'impulsion définie par l'utilisateur.
Etablissement & Maintien Recherche les violations du temps d'établissement et de maintien défini par l'utilisateur.
Petite impulsion Recherche les impulsions positives ou négatives qui dépassent un seuil d'amplitude mais

ne dépassent pas le seuil suivant avant de recroiser le premier seuil. Recherche toutes les
petites impulsions ou seulement celles d'une durée >, <, = à ou ≠ d'une période définie
par l'utilisateur.

Fenêtre Recherche un signal entrant dans la fenêtre définie par les seuils ou en sortant. Qualifiez
l'événement de recherche en termes de temps en utilisant l'option When Wider (Si largeur
supérieure) ou suivant l'état logique des autres voies, en utilisant l'option When Logic (Si
état logique).

Séquence Recherche un motif logique (AND, OR, NAND, or NOR) sur plusieurs signaux avec
chaque entrée définie comme Haute, Basse ou Peu importe. Recherche des moments où
l'événement devient vrai, faux ou reste valide pour un laps de temps >, <, = à ou ≠ d'une
période définie par l'utilisateur. En outre, vous devez définir l'une des entrées comme
horloge pour les recherches (d'état) synchrones.

Transition Recherche les fronts montants et/ou descendants qui sont gt;, <, = à ou ≠ d'une période
définie par l'utilisateur.

Délai d'attente Recherche l’absence d’impulsion dans un laps de temps spécifié.
Etat Recherche le moment où toutes les entrées logiques de la fonction logique sélectionnée

entraînent un résultat True ou False pour la fonction, lorsque l'entrée d'horloge change
d'état.

Lecture DDR Recherche les impulsions de lecture DDR. Nécessite l'option DDRA.
Ecriture DDR Recherche les impulsions d'écriture DDR. Nécessite l'option DDRA.
Lecture et écriture DDR Recherche les impulsions de lecture et d'écriture DDR. Nécessite l'option DDRA.
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Analyse des signaux
Votre instrument est doté de différents outils destinés à vous aider dans l'analyse des signaux : curseurs, mesures
automatiques, statistiques, histogrammes, fonctions mathématiques, analyse spectrale et tests avancés. Cette section
présente les concepts et les procédures d'analyse des signaux. Des informations plus détaillées sont disponibles dans
l'aide en ligne.

Mesures automatiques
1. Sélectionnez Measure > Measurement

Setup....

2. Sélectionnez la voie, puis le signal
calculé ou de référence que vous
souhaitez mesurer.

3. A l'aide des onglets, sélectionnez
les mesures dans cinq catégories
différentes.
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4. Pour supprimer toutes les mesures,
cliquez sur Clear All.

5. Pour supprimer plusieurs mesures,
sélectionnez-les avec la fonction
cliquer-glisser, puis cliquez sur Clear
Selected.

Vous pouvez également choisir une
mesure pour le signal sélectionné
directement dans le menu Measure.
(Voir page 117, Choix de mesures
automatiques.)

Astuces
Les mesures automatiques ne sont pas disponibles pour les signaux de voies numériques. Pour les instruments
MSO7000/C, vous pouvez mesurer un signal de voie numérique en transmettant au préalable la voie numérique vers une
voie analogique à l'aide d'iCapture. (Voir page 57, Affichage des caractéristiques analogiques des signaux numériques.)

En mode Défilement, les mesures ne sont pas disponibles tant que l'acquisition n'est pas terminée.

AVERTISSEMENT. En cas d'écrêtage vertical, la tension à l'extrémité de la sonde peut être dangereuse, même si l'affichage
indique une tension basse. Un symbole apparaît dans l'affichage de mesure si une condition d'écrêtage vertical existe.
Les mesures automatiques relatives à l'amplitude peuvent générer des résultats inexacts lorsque le signal est écrêté
verticalement. L'écrêtage entraîne également des valeurs d'amplitude inexactes sur les signaux stockés ou exportés vers
d'autres programmes. Si un signal calculé est écrêté, cela n'affecte pas les mesures d'amplitude de ce signal.
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Choix de mesures automatiques
Les tableaux suivants répertorient toutes les mesures automatiques disponibles, par catégorie : amplitude, temps,
histogramme, communication ou d'autres. (Voir page 115, Mesures automatiques.)

Mesures d'amplitude
Mesure Description
Amplitude Valeur haute moins valeur basse, mesurée sur l'ensemble du signal ou du fenêtrage.
Valeur haute Cette valeur est utilisée comme 100 % lorsque des valeurs de référence basse, moyenne et élevée

sont nécessaires, notamment dans les mesures de temps de montée ou de descente. Elle est
calculée par la méthode min/max ou par histogramme. La méthode min/max utilise la valeur
maximum trouvée. La méthode par histogramme utilise la valeur la plus couramment trouvée
au-dessus du point médian. Cette valeur est mesurée sur l'ensemble du signal ou du fenêtrage.

Valeur basse Cette valeur est utilisée comme 0 % lorsque des valeurs de référence basse, moyenne et élevée
sont nécessaires, notamment dans les mesures de temps de montée ou de descente. Elle est
calculée par la méthode min/max ou par histogramme. La méthode min/max utilise la valeur
minimum trouvée. La méthode par histogramme utilise la valeur la plus couramment trouvée en
dessous du point médian. Cette valeur est mesurée sur l'ensemble du signal ou du fenêtrage.

Efficace Tension efficace réelle sur l'ensemble du signal ou du fenêtrage.
Valeur efficace CA Tension efficace vraie sur la zone de mesure.
Max Tension de crête la plus positive. Cette valeur est mesurée sur l'ensemble du signal ou du fenêtrage.
Min Tension de crête la plus négative. Cette valeur est mesurée sur l'ensemble du signal ou du

fenêtrage.
Crête-crête Différence absolue entre l'amplitude maximum et l'amplitude minimum sur l'ensemble du signal

ou du fenêtrage.
Valeur efficace du
cycle

Tension efficace réelle sur le premier cycle du signal ou du fenêtrage.

Suroscillation + Cette valeur est mesurée sur l'ensemble du signal ou du fenêtrage et est exprimée comme suit :
Suroscillation positive = ((Maximum – Valeur haute) / Amplitude) x 100 %.

Suroscillation - Cette valeur est mesurée sur l'ensemble du signal ou du fenêtrage et est exprimée comme suit :
Suroscillation négative = ((Valeur basse - Minimum) / Amplitude) x 100 %.

Moyenne Cette valeur est mesurée sur l'ensemble du signal ou du fenêtrage.
Moyenne sur un
cycle

Moyenne arithmétique sur le premier cycle du signal ou du fenêtrage.

Mesures de temps
Mesure Description
Temps de montée Temps nécessaire au front montant de la première impulsion du signal ou du fenêtrage pour

passer de la valeur de référence basse (par défaut = 10 %) à la valeur de référence haute (par
défaut = 90 %) de la valeur finale.

Temps de descente Temps nécessaire au front descendant de la première impulsion du signal ou du fenêtrage pour
passer de la valeur de référence haute (par défaut = 90 %) à la valeur de référence basse (par
défaut = 10 %) de la valeur finale.

Largeur pos. Distance (temps) entre les points d'amplitude de la référence moyenne (par défaut 50 %) d'une
impulsion positive. La mesure se fait sur la première impulsion du signal ou du fenêtrage.

Manuel de l'utilisateur des gammes MSO70000C, DPO/DSA70000C, DPO7000C et MSO/DPO5000 117



Analyse des signaux

Mesures de temps (suite)

Mesure Description
Largeur nég. Distance (temps) entre les points d'amplitude de la référence moyenne (par défaut 50 %) d'une

impulsion négative. La mesure se fait sur la première impulsion du signal ou du fenêtrage.
Rapport cyclique + Rapport entre la largeur d'impulsion positive et la durée du signal, exprimé en pourcentage. Le

rapport cyclique est mesuré sur le premier cycle du signal ou du fenêtrage.
Rapport cyclique - Rapport entre la largeur d'impulsion négative et la durée du signal, exprimé en pourcentage. Le

rapport cyclique est mesuré sur le premier cycle du signal ou du fenêtrage.
Durée Temps requis pour compléter le premier cycle d'un signal ou d'un fenêtrage. La durée est l'inverse

de la fréquence ; elle est mesurée en secondes.
Fréq Fréquence du premier cycle d'un signal ou d'un fenêtrage. La fréquence est l'inverse de la durée ;

elle est mesurée en hertz (Hz) et un hertz représente un cycle par seconde.
Retard Temps entre le point d'amplitude de la référence moyenne (par défaut 50 %) de deux signaux

différents.

Autres mesures
Mesure Description
Surface Mesure de surface sur l'ensemble du signal ou du fenêtrage, exprimée en volts-seconde. La

surface mesurée au-dessus de la terre est positive ; la surface mesurée en dessous est négative.
Surface sur cycle Mesure de surface du premier cycle du signal ou du fenêtrage, exprimée en volts-seconde. La

surface au-dessus du point de référence commun est positive, tandis que la surface en dessous est
négative.

Phase Laps de temps d'avance ou de retard d'un signal par rapport à un autre ; il est exprimé en degrés,
où 360° représente un cycle de signal complet.

Largeur salve Durée d'une salve (série d'événements transitoires) ; elle est mesurée sur l'ensemble du signal
ou du fenêtrage.

Mesures d'histogramme
Mesure Description
Nb signaux Affiche le nombre de signaux ayant contribué à créer l'histogramme.
Impacts dans le bloc Affiche le nombre de points situés dans ou sur la barre de l'histogramme.
Impacts de crête Affiche le nombre de points situés dans le secteur le plus grand de l'histogramme.
Médian Affiche le point médian de la barre de l'histogramme. La moitié de tous les points capturés dans ou

sur la barre de l'histogramme est inférieure à cette valeur et l'autre moitié est supérieure.
Max Affiche la tension du plus haut secteur non égal à zéro dans les histogrammes verticaux ou le

temps du secteur non égal à zéro le plus à droite dans les histogrammes horizontaux.
Min Affiche la tension du plus bas secteur non égal à zéro dans les histogrammes verticaux ou le temps

du secteur non égal à zéro le plus à gauche dans les histogrammes horizontaux.
Crête-crête Affiche la valeur crête à crête de l'histogramme. Les histogrammes verticaux affichent la tension

du plus haut secteur non égal à zéro moins la tension du plus bas secteur non égal à zéro. Les
histogrammes horizontaux affichent le temps du secteur non égal à zéro le plus à droite moins le
temps du secteur non égal à zéro le plus à gauche.

Moyenne Mesure la moyenne de tous les points capturés dans ou sur la barre de l'histogramme.
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Mesures d'histogramme (suite)

Mesure Description
Ecart type Mesure l'écart type (valeur efficace d'écart) de tous les points capturés dans ou sur la barre de

l'histogramme.
Ecart type
moyen ±1

Affiche le pourcentage des points de l'histogramme situés dans un écart type de la moyenne de
l'histogramme.

Ecart type
moyen ±2

Affiche le pourcentage des points de l'histogramme situés dans deux écarts types de la moyenne
de l'histogramme.

Ecart type
moyen ±3

Affiche le pourcentage des points de l'histogramme situés dans trois écarts types de la moyenne de
l'histogramme.

Mesures de communication
Mesure Description
Rapport ext Rapport entre le haut et la base de l'œil. Cette mesure est disponible uniquement pour la base de

données de signal ou un signal de référence enregistré dans le mode base de données de signal.
% Rapport ext Rapport entre le haut et la base de l'œil, exprimé en pourcentage. Cette mesure est disponible

uniquement pour la base de données de signal ou un signal de référence enregistré dans le mode
base de données de signal.

Rapport ext (dB) Rapport entre le haut et la base de l'œil, exprimé en décibels. Cette mesure est disponible
uniquement pour la base de données de signal ou un signal de référence enregistré dans le mode
base de données de signal.

Hauteur de l'œil Mesure de la hauteur de l'œil, en volts.
Largeur de l'œil Mesure de la largeur de l'œil, en secondes.
Haut de l'œil Valeur supérieure utilisée dans les mesures de rapport d'extinction.
Base de l'œil Valeur de base utilisée dans les mesures de rapport d'extinction.
% Croisement Point de croisement de l'œil, exprimé sous forme de pourcentage de la hauteur de l'œil.
Gigue c-c Valeur crête à crête de la gigue de front, en unités horizontales courantes.
Gigue efficace Valeur efficace de la gigue de front, en unités horizontales courantes.
Gigue 6 Sigma Six fois la valeur efficace de la gigue de front, en unités horizontales courantes.
Bruit c-c Valeur crête à crête du bruit en haut ou à la base du signal que vous avez spécifié.
Bruit efficace Valeur efficace du bruit en haut ou à la base du signal que vous avez spécifié.
Rapport S/B Rapport entre l'amplitude du signal et le bruit en haut ou à la base du signal que vous avez spécifié.
Distorsion sur cycle Variation temporelle crête à crête du premier croisement de l'œil mesuré au point de référence

moyen, sous forme de pourcentage de la durée de l'œil.
Facteur Q Rapport entre la taille de l'œil et le bruit.
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Personnalisation des mesures automatiques
Vous pouvez personnaliser une mesure automatique à l'aide des fonctions de fenêtrage, de modification des statistiques de
mesure ou d'ajustement des niveaux de référence des mesures.

Fenêtrage

Utilisez la fonction Fenêtrage (Gating) pour
limiter la mesure à une certaine portion du
signal.

1. Sélectionnez Measure > Gating >
Gating ....

2. Positionnez la fenêtre en observant l'une
des méthodes suivantes :

Cliquez sur Cursor pour définir
comme zone de fenêtrage la zone
située entre les curseurs.

Cliquez sur Zoom (1-4) pour définir
comme zone de fenêtrage le réticule
du zoom (1-4).
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Statistiques

La fonction Statistiques s'active
automatiquement avec les mesures.
Les statistiques caractérisent la stabilité des
mesures.

1. Pour modifier les statistiques affichées,
sélectionnez Measure > Statistics, puis
Mean ou All (toutes ces options incluent
les statistiques min, max, moyenne,
écart type et population).

2. Pour supprimer des statistiques,
sélectionnez Off.

REMARQUE. Le fait de placer le curseur
sur une mesure permet d'en afficher une
version à plus haute résolution.

Capture instantanée

Pour afficher une vue simultanée de toutes
les mesures valides, sélectionnez Measure
> Snapshot.
REMARQUE. Si la configuration d’une
mesure est incorrecte, trois points
d’interrogation s’affichent à la place des
résultats.

Pour la capture instantanée de mesures
générales, sélectionnez General; pour
la capture instantanée de mesures de
communication, sélectionnez Comm.
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Annoter des mesures

1. Pour annoter des mesures, sélectionnez
Annotation dans la fenêtre de
commande Measurement Setup.
Sélectionnez la mesure à annoter dans
la liste déroulante.

2. Pour définir le niveau de détails
concernant l'annotation de mesure,
sélectionnez Measure > Annotation >
Standard ou Detailed.
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Niveaux de référence

Les niveaux de référence déterminent la
manière dont sont effectuées les mesures
temporelles.

1. Sélectionnez Measure > Reference
Levels....

2. Ajustez les niveaux de référence de
mesure sur différentes valeurs relatives
ou absolues.

Les valeurs de référence haute et
basse sont utilisées pour calculer les
temps de montée et de descente.
La référence haute par défaut est
90 % ; la référence basse par défaut
est 10 %.

La référence moyenne est
principalement utilisée entre les
fronts, notamment les largeurs
d'impulsion. Le niveau par défaut est
50 %.

La référence Mid2 est utilisée sur
le second signal spécifié, dans les
mesures de retard ou de phase. Le
niveau par défaut est 50 %.
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Astuces
Pour garantir la précision des valeurs de bruit, assurez-vous d'ouvrir le menu Reference Levels Setup (Configuration des
niveaux de référence) et que le type de signal est défini sur Eye, lorsque que vous mesurez un signal d'œil.

Mesures par curseur
Servez-vous des curseurs pour effectuer des mesures manuelles sur les données capturées.

1. Appuyez sur Cursors.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

2. Sélectionnez la source du curseur.

3. Sélectionnez un type de curseur parmi
les options suivantes :

Les barres H mesurent l'amplitude
(généralement en volts ou en
ampères)

Les barres V mesurent les
paramètres horizontaux
(généralement le temps)

Les curseurs de signal et d'écran
mesurent simultanément les
paramètres verticaux et horizontaux.
Les curseurs de signal sont associés
au signal, par opposition aux
curseurs d'écran, qui sont flottants.
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4. Pour effectuer des mesures entre deux
signaux, sélectionnez Waveform, puis
choisissez la source de signal pour
chaque curseur.

5. Sélectionnez Cursors > Cursor
Position..., puis utilisez les boutons
d'usage général pour ajuster la position
du curseur.

6. Lisez les résultats de mesure des
curseurs à l'écran.

Astuces
Servez-vous du mode Curseur double pour que les curseurs se déplacent en tandem. Servez-vous du mode Curseur
indépendant pour déplacer les curseurs séparément.

Si vous utilisez le réticule de zoom, vous pouvez placer un curseur directement sur un point donné du signal pour
effectuer des mesures de précision.

Vous pouvez également déplacer les curseurs en cliquant dessus et en les faisant glisser vers leur nouvel emplacement.

Vous pouvez également déplacer les curseurs au centre de l’écran en appuyant sur Move Cursors to Center.

Vous avez le choix entre des curseurs uniformes ou discontinus.

Les curseurs verticaux mesurent le temps entre le point de déclenchement et le curseur vertical.
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Configuration d'un histogramme
Vous pouvez afficher un histogramme vertical (tension) ou horizontal (temps). Utilisez des mesures d'histogramme pour
obtenir des données de mesure statistiques pour la section d'un signal le long d'un axe.

1. Cliquez sur la souris et faites glisser le
pointeur sur le segment du signal que
l'histogramme doit couvrir. Par exemple,
pour un histogramme horizontal, tracez
une barre plus large que haute.

2. Sélectionnez Histogram Vertical ou
Histogram Horizontal dans le menu de
raccourci.

3. Affichez l'histogramme en haut (pour les
histogrammes horizontaux) ou à gauche
(pour les histogrammes verticaux) du
réticule.
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4. Pour ajuster l'histogramme ou la
taille et l'emplacement de la barre
d'histogramme, sélectionnez Measure
> Waveform Histograms, puis
servez-vous de la fenêtre de commande
Histogram Setup.

5. Vous pouvez également effectuer des
mesures automatiques sur les données
d'histogramme. (Voir page 115, Mesures
automatiques.)

Astuces
Utilisez des histogrammes verticaux pour mesurer le bruit de signal et des histogrammes horizontaux pour mesurer
la gigue de signal.

Utilisez la méthode cliquer-glisser pour activer le menu de raccourci afin de désactiver l'affichage histogramme.
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Utilisation de signaux calculés
Vous pouvez créer des signaux calculés pour prendre en charge l'analyse de vos signaux de référence et de voie. En
combinant et en transformant les signaux sources et d'autres données en signaux calculés, vous pouvez dériver les
affichages de données requises par votre application.

Observez la procédure suivante pour créer des équations mathématiques prédéfinies.

1. Sélectionnez Math > Math Setup....

2. Choisissez l'une des équations
mathématiques prédéfinies.

Observez la procédure suivante pour créer une expression de signal calculé avancée.

1. Sélectionnez Math > Math Setup....
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2. Cliquez sur Editor.

3. Créez ensuite votre expression de signal
calculé avancée en utilisant les sources,
les opérateurs, les constantes, les
mesures et les fonctions.

4. Lorsque vous avez défini l'expression de
votre choix, cliquez sur Apply.

5. Pour ajouter votre propre filtre, cliquez
sur l'onglet Filter. Cliquez sur Load.
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6. Double-cliquez sur le dossier contenant
les filtres que vous souhaitez utiliser.
Double-cliquez sur le filtre que vous
souhaitez utiliser.
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7. Créez votre expression mathématique à
l'aide du filtre sélectionné.

8. Lorsque vous avez défini l'expression de
votre choix, cliquez sur Apply.

Astuces
Un double-clic sur une expression mathématique ouvre le Math Equation Editor (Editeur d'équations mathématiques).

Les définitions mathématiques ne sont pas implémentées si les sources ne sont pas valides.

Les signaux calculés sont créés à partir de signaux de voies analogiques, de signaux de référence et de signaux
source calculés, ainsi qu'à partir de mesures.

Les voies numériques ne sont pas valables dans les signaux calculés. Toutefois, les signaux iCapture sont valables
dans les signaux calculés.

Utilisez les propriétés numériques pour définir le seuil numérique des voies analogiques.

Les mesures sont effectuées sur des signaux calculés, de la même manière que pour les signaux de voie.

L'échelle et la position horizontales des signaux calculés proviennent de la source des expressions mathématiques
associées. Vous pouvez ajuster ces paramètres pour les signaux sources, ce qui les modifiera pour les signaux calculés.

Vous pouvez agrandir les signaux calculés à l'aide du zoom MultiView ; servez-vous de la souris pour positionner
la zone de zoom.

Consultez l'aide en ligne pour plus d'informations sur les filtres mathématiques arbitraires.
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Utilisation de l'analyse spectrale
Observez la procédure suivante pour créer des expressions mathématiques spectrales prédéfinies. Consultez l'aide
en ligne pour plus d'informations.

1. Sélectionnez Math > Math Setup....

2. Choisissez l'une des expressions
mathématiques spectrales prédéfinies.

3. Cliquez sur Basic.

4. Cliquez sur Resolution BW ou Frequency
Span et utilisez le clavier ou les boutons
d'usage général pour ajuster l'affichage
spectral.

REMARQUE. Resolution BW (Bande
passante de résolution) et Frequency
Span sont uniquement réglables en mode
horizontal manuel.
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Observez la procédure suivante pour créer une expression mathématique spectrale avancée.

1. Sélectionnez Math > Advanced
Spectral....

2. Sélectionnez le signal calculé que vous
souhaitez définir.

3. Cliquez sur le type de signal spectral que
vous souhaitez créer. Pour redéfinir un
signal, cliquez sur Clear.

4. Sélectionnez le signal source.

5. Ajustez le signal spectral, à l'aide des
commandes de la fenêtre Spectral Setup
et des boutons d'usage général.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C
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Gammes MSO5000 et DPO5000

6. Vous pouvez visualiser simultanément
les signaux temporels et les signaux de
fréquence.
Utilisez le fenêtrage pour sélectionner
une section délimitée du signal temporel
en vue d'une analyse spectrale. (Voir
page 120, Fenêtrage.)

Astuces
La source des signaux calculés spectraux doit être une voie ou un autre signal calculé.

Utilisez des longueurs d'enregistrement faibles pour obtenir une réponse plus rapide.

Utilisez des longueurs d'enregistrement élevées pour diminuer le bruit associé au signal et augmenter la résolution de
la fréquence.

Les différentes fonctions de fenêtre produisent des formes de réponse de filtre différentes dans le spectre et des bandes
passantes de résolution différente. Consultez l'aide en ligne pour plus d'informations.

La bande passante de résolution (RBW, resolution bandwidth) influe directement sur la largeur de fenêtre. Par
conséquent, les marqueurs de la fenêtre de domaine temporel se déplacent à mesure que vous ajustez la commande.

Vous pouvez ajuster l'amplitude linéaire des données réelles ou imaginaires dans le spectre. Cela peut être utile si vous
traitez le spectre hors ligne et le transformez de nouveau en trace de domaine temporel.
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Tests de masque
La fonction de test des masques de communication série (option MTM ou MTH) vous permet de comparer votre signal à un
modèle ou à un masque prédéfini. Pour que le signal réussisse le test, il doit se situer en-dehors des segments définis par le
masque. En général, les comités de normalisation tels que l'ANSI sont responsables de la définition des masques. Pour
effectuer un test de masque, observez la procédure suivante :

1. Sélectionnez Mask (Masque) >
Source....

2. Choisissez la source du signal.

3. Cliquez sur l'onglet Masks.

4. Sélectionnez le type et la norme.
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5. Cliquez sur un bouton Config pour
accéder à une fenêtre de commande
Mask Configuration, dans laquelle
vous pouvez configurer l'affichage des
masques et des violations, ainsi que les
fonctions Mask Autoset et Autofit.

6. Cliquez sur Masks pour revenir à la
fenêtre de commande Mask Setup.

7. Définissez Lock Mask to Wfm sur On
pour effectuer un suivi des changements
de masque dans les paramètres
horizontaux et verticaux.

8. Définissez Hit Count sur On pour mettre
en relief les violations durant un test de
masque.

9. Cliquez sur Autoset pour aligner
automatiquement le signal avec le
masque, sur la base des caractéristiques
du signal d'entrée.

10. Définissez Autofit sur On pour
repositionner automatiquement le signal
après chaque acquisition, afin de réduire
le nombre d'impacts.

11. Cliquez sur l'onglet Tolerance, puis
définissez la valeur de tolérance.
Les valeurs de tolérance supérieures à
0 % augmentent la difficulté des tests de
masque et les valeurs inférieures à 0 %
les rendent plus faciles.
Utilisez 0 % si vous souhaitez que le
masque soit standard, tel que défini
dans la norme. Vous pouvez modifier
ce pourcentage pour effectuer des test
avec marge.
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12. Sélectionnez l'onglet Pass/Fail Setup,
puis configurez les paramètres de
réussite/d'échec (lorsque le mode
d'acquisition est défini sur Waveform
Database, l'intitulé # of Wfms devient
Samples).

13. Sélectionnez les notifications de
réussite/d'échec du test.

14. Sélectionnez la polarité du signal à
tester.

15. Définissez Repeat sur On pour exécuter
le test de masque en continu.

16. Sélectionnez l'avis souhaité une fois le
test terminé.

17. Cliquez sur l'onglet Pass/Fail Results
pour afficher les résultats du test.

18. Définissez Pass/Fail Test sur On pour
lancer le test de masque.

19. Cliquez sur Reset pour réinitialiser les
totaux et effacer les violations.

Astuces
Les tests de masques ne sont pas disponibles pour les signaux de voies numériques.

Si le signal se situe en-dehors du masque, activez la fonction Autoset pour centrer le signal dans le masque.
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Utilisation du test des valeurs limites
Le test optionnel des valeurs limites vous permet de comparer un signal actif avec un signal de gabarit. Créez votre signal de
gabarit à partir d’un bon signal connu et utilisez-le pour le comparer à un signal actif et procéder au test de réussite/échec.

1. Sélectionnez Mask > Limit Test
Setup... (Masque > Config. test des
val. lim.).

2. Créez le gabarit en sélectionnant la
source, la destination et les limites
de tolérance. Utilisez le bouton
multifonctionnel pour régler les limites
de tolérance. Les limites de tolérance
indiquent la marge autorisée pour le
signal avant d’échouer au test des
valeurs limites.

3. Cliquez sur Save. Vous pouvez créer
plusieurs gabarits et les sauvegarder
pour une utilisation ultérieure.

4. Sélectionnez le signal source à
comparer au gabarit.

5. Sélectionnez le gabarit à comparer au
signal source. (Il s’agit généralement du
gabarit que vous avez créé à l’étape 3.)
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6. Cliquez sur Failure Notification pour
configurer la notification d’échec.

7. Sélectionnez la ou les notifications
d’échec, puis cliquez sur Setup pour
revenir à la fenêtre de commande de
configuration.

8. Cliquez sur Lock Template to Waveform
On afin de verrouiller l’échelle ou la
position verticale du gabarit sur celle du
signal source.

9. Cliquez sur Highlight Hits On pour
afficher les points situés à l’extérieur du
gabarit dans une couleur différente.

10. Définissez Limit Test sur On pour lancer
le test.

11. Cliquez sur Reset pour effacer toutes
les violations et réinitialiser le test.

Astuces
Vous pouvez utiliser des signaux actifs ou sauvegardés pour créer un gabarit de test des valeurs limites.

Le mode d’acquisition Moyenne vous permet de créer un signal de gabarit plus uniforme.

Le mode d’acquisition Enveloppe vous permet de créer un gabarit autorisant les suroscillations occasionnelles.
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MyScope
MyScope vous permet de créer des fenêtres de commande personnalisées contenant uniquement les commandes que vous
utilisez régulièrement. Au lieu de passer d'une fenêtre de commande à une autre, placez toutes les commandes que vous
utilisez le plus dans une seule fenêtre de commande personnalisée.

Cette section présente les procédures de création et d'utilisation des fenêtres de commande MyScope. Des informations
plus détaillées sont disponibles dans l'aide en ligne.

Création d'une nouvelle fenêtre de commande MyScope
1. Sélectionnez MyScope > New Control

Window....

2. Cliquez sur + pour développer une
catégorie. Les commandes que vous
pouvez ajouter à votre fenêtre de
commande MyScope figurent dans
chaque catégorie. Les catégories
correspondent à la barre de menus, afin
de vous permettre de trouver facilement
vos commandes favorites.
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3. Cliquez sur une commande pour en
afficher l'aperçu.

4. Double-cliquez sur le commande ou
cliquez sur + pour développer la liste
de commandes (si aucun signe +
n'est disponible, cela signifie que la
commande ne peut être davantage
personnalisée).
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5. Désélectionnez les cases d'option
appropriées pour supprimer les
composants que vous ne souhaitez pas
inclure dans votre fenêtre de commande.

6. Cliquez sur la commande souhaitée et
faites-la glisser jusqu'à votre fenêtre de
commande MyScope. La commande
se place dans l'emplacement de grille
le plus proche lorsque vous relâchez
le bouton de la souris. Vous pouvez
modifier la position de la commande dans
votre fenêtre de commande MyScope en
cliquant dessus et en la faisant glisser.
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7. Cliquez sur New Tab pour ajouter un
onglet à votre fenêtre de commande
MyScope. Vous pouvez créer jusqu'à
six onglets.

8. Pour renommer un onglet, observez la
procédure suivante :

Cliquez sur Rename Tab

Double-cliquez sur l'onglet, puis
saisissez le nouveau nom.

9. Cliquez sur User Pref... pour spécifier
les préférences utilisateur chargées avec
votre fenêtre de commande MyScope.

10. Pour supprimer des commandes,
observez l'une des procédures
suivantes :

Sélectionnez un onglet, puis cliquez
sur Delete. L'onglet et toutes les
commandes qu'il contient sont
supprimés.

Sélectionnez une commande,
puis cliquez sur Delete. Seule
la commande sélectionnée est
supprimée.

11. Cliquez sur Save, puis saisissez un
nom pour votre fenêtre de commande
MyScope ou bien utilisez le nom par
défaut.
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Astuces
Pour reconfigurer une commande, cliquez dessus et faites-la glisser jusqu'à la fenêtre d'aperçu précédente. Ensuite,
sélectionnez ou désélectionnez les cases d'option appropriées pour ajouter ou supprimer des composants de la
commande.

Pour modifier l'ordre des onglets, cliquez sur l'onglet souhaité et faites-le glisser jusqu'à son nouvel emplacement.

Pour supprimer une commande, cliquez dessus et faites-la glisser vers la partie supérieure de l'écran (hors de votre
fenêtre de commande MyScope).

Utilisation de fenêtres de commande MyScope
Pour ouvrir une fenêtre de commande MyScope préalablement définie, observez la procédure suivante :

1. Sélectionnez MyScope > Open Control
Window... ou l'une des cinq fenêtres
MyScope les plus récemment utilisées.

2. Sélectionnez la fenêtre de commande
MyScope que vous souhaitez utiliser,
puis cliquez sur Open.

Pour afficher la fenêtre de commande MyScope active, observez la procédure suivante :
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1. Sélectionnez MyScope > Current... ou
cliquez sur MyScope en mode Barre
d'outils (votre fenêtre de commande
MyScope reste active même lorsqu'elle
n'est pas affichée).

Pour modifier une fenêtre de commande MyScope, observez la procédure suivante :

1. Sélectionnez MyScope > Edit Control
Window....

2. Sélectionnez la fenêtre de commande
que vous souhaitez modifier, puis cliquez
sur Open.
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Astuces
Certaines commandes fonctionnent différemment dans une fenêtre de commande MyScope que dans une fenêtre de
commande classique. Pour plus de détails, consultez l'aide en ligne.

Vous pouvez copier des fenêtres de commande MyScope (fichiers .tcw) vers d'autres instruments des gammes
DPO7000C, DPO/DSA70000C, MSO70000C, MSO5000 et DPO5000.
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Informations sur les fonctions d'enregistrement et de rappel
Cette section présente les procédures d'enregistrement et de rappel des captures d'écran et des paramètres de
configuration, d'enregistrement des mesures, d'utilisation du Presse-papiers et d'impression, sur votre instrument. Des
informations plus détaillées sont disponibles dans l'aide en ligne.

Enregistrement de captures d’écran
1. Sélectionnez File > Save ou Save As >

Screen Capture....

2. Cliquez sur Options... pour configurer
les options Palette, View (Vue), Image
ou Screen Capture Format (Format
de capture d'écran) ; sinon, passez à
l'étape 3.
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3. Sélectionnez l'emplacement de
sauvegarde de la capture d'écran.

4. Saisissez un nom pour la capture
d'écran, ou bien utilisez le nom par
défaut, puis sélectionnez un type de
fichier.

5. Cliquez sur Save.

Astuce
Pour enregistrer rapidement plusieurs captures d'écran, sélectionnez Set Front Panel Print Button to Save, puis
cliquez sur Save. Vous pouvez à présent enregistrer une capture d'écran en appuyant simplement sur le bouton
Print du panneau avant.

Enregistrement de signaux
1. Pour enregistrer des signaux,

sélectionnez File > Save ou Save
As > Waveform....
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2. Cliquez sur Waveform (Signal).

3. Cliquez sur Options... pour spécifier les
options Waveform Data Range (Plage
de données du signal), FastFrame Data
Range (Plage de données FastFrame),
Waveform Detail (Détail du signal), Data
Destination (Destination des données),
Source et Data Ordering (Ordre des
données) ; sinon, passez à l'étape 4.

4. Sélectionnez la source.

5. Vous pouvez enregistrer un signal soit
sous forme de signal de référence dans
la mémoire de l'instrument, soit sous
forme de fichier .wfm dans un répertoire
Windows. Pour enregistrer le signal
comme référence, sélectionnez Ref 1–4.
Pour enregistrer le signal comme fichier
.wfm, sélectionnez l'emplacement de
sauvegarde souhaité.

6. Si vous choisissez d'enregistrer un fichier
.wfm, saisissez un nom pour le fichier ou
utilisez le nom par défaut.

7. Cliquez sur Save.

Astuces
Sélectionnez Auto-increment file name (Incrémentation automatique du nom de fichier) pour enregistrer les signaux
similaires sans avoir à saisir de nouveau le nom complet.

Pour enregistrer rapidement plusieurs signaux, sélectionnez Set Front Panel Print Button to Save, puis cliquez sur
Save. Vous pouvez à présent enregistrer un signal en appuyant simplement sur le bouton Print du panneau avant.
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Rappel de signaux
1. Sélectionnez File > Recall....

2. Cliquez sur Waveform.

3. Sélectionnez la destination du signal
rappelé.

4. Sélectionnez le signal à rappeler.

5. Cliquez sur Recall. Lorsque vous
cliquez sur Recall, le signal de référence
s'active, de même que la fenêtre de
commande Reference Waveform.

6. Servez-vous des commandes
disponibles pour configurer le signal
de référence. Vous pouvez également
accéder à la fenêtre de commande
Reference Waveform en sélectionnant
File > Reference Waveform Controls....
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Astuce
Vous pouvez enregistrer plusieurs types de fichier différents mais vous ne pouvez rappeler que des fichiers de
configuration (*.set) et de signal (*.wfm).

Enregistrement de signaux numériques
Sur les instruments de la gamme MSO, vous pouvez enregistrer des signaux numériques dans un fichier au format .csv.

1. Pour enregistrer des signaux
numériques, sélectionnez File >
Save (Fichier > Enregistrer) ou Save
As > Digitals (Enregistrer sous >
Numériques).

2. Cliquez sur Digitals (Numériques).

3. Vous ne pouvez enregistrer des signaux
numériques sous forme de fichier
.csv que dans un répertoire Windows.
Pour enregistrer sous forme de fichier
.csv, sélectionnez l'emplacement
d'enregistrement souhaité.

4. Saisissez un nom de fichier ou utilisez
le nom par défaut.

5. Cliquez sur Save (Enregistrer).
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Enregistrement de configurations de l'instrument
1. Sélectionnez File > Save ou Save As

> Setup....

2. Cliquez sur Setup (Configuration).

3. Sélectionnez l'emplacement
d'enregistrement de la configuration.
Vous pouvez soit enregistrer la
configuration dans la mémoire
de l'instrument, dans l'un des dix
emplacements de stockage disponibles,
soit l'enregistrer sous forme de fichier
.set dans un répertoire Windows.

4. Saisissez un nom de fichier ou utilisez
le nom par défaut. Utilisez le clavier qui
apparaît pour entrer le nom de fichier
de la configuration enregistrée dans la
mémoire de l'instrument.

5. Cliquez sur Save.

Astuces
Si l'écran tactile est activé, servez-vous du clavier qui apparaît à l'écran pour nommer les différentes configurations,
à des fins d'identification.

Sélectionnez l'option Auto-increment file name (Incrémentation automatique du nom de fichier) pour enregistrer les
fichiers similaires sans avoir à saisir de nouveau le nom complet.

Pour enregistrer rapidement plusieurs configurations, sélectionnez Set Front Panel Print Button to Save, puis
cliquez sur Save. Vous pouvez à présent enregistrer une configuration en appuyant simplement sur le bouton Print
du panneau avant.
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Rappel de configurations de l'instrument
1. Sélectionnez File > Recall....

2. Cliquez sur Setup.

3. Sélectionnez la configuration que
vous souhaitez rappeler. Vous pouvez
rappeler un fichier de configuration à
partir de l'un des dix emplacements de la
mémoire de l'instrument ou à partir d'un
répertoire Windows.
Pour conserver vos réglages actuels de
compensation, sélectionnez Don't recall
deskew values (Ne pas rappeler les
valeurs de compensation).

4. Cliquez sur Recall.

Astuce
Vous pouvez rappeler n'importe quelle configuration sauvegardée sur le disque, puis la sauvegarder dans un
emplacement de stockage de configuration interne afin d'y accéder plus rapidement.
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Enregistrement de mesures
1. Sélectionnez File > Save (Fichier

> Enregistrer) ou Save As >
Measurement... (Enregistrer sous
> Mesure...).

2. Cliquez sur Options... pour spécifier
les options Displayed Measurements
(Mesures affichées), Measurement
Snapshot (Instantané de mesure)
et Measurement Format (Format de
mesure) ; sinon, passez à l'étape 3.

3. Sélectionnez l'emplacement de
sauvegarde de la mesure.

4. Saisissez un nom pour la mesure, puis
sélectionnez un type de fichier.

5. Cliquez sur Save.
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Enregistrement de masques utilisateur
1. Sélectionnez File > Save (Fichier >

Enregistrer) ou Save As > User Mask
(Enregistrer sous > Masque utilisateur).

2. Cliquez sur User Mask (Masque
utilisateur).

3. Sélectionnez l'emplacement
d'enregistrement du masque.

4. Saisissez un nom pour le masque, puis
sélectionnez un type de fichier.

5. Cliquez sur Save (Enregistrer).
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Enregistrement de données d'histogramme
1. Sélectionnez File > Save (Fichier >

Enregistrer) ou Save As > Histogram
Data (Enregistrer sous > Données
d'histogramme).

2. Sélectionnez Histogram (Histogramme).
En fonction des sélections antérieures,
il se peut que vous deviez sélectionner
More > Histogram Data (Suite >
Données d'histogramme) pour afficher la
sélection de l'histogramme.

3. Sélectionnez l'emplacement
d'enregistrement de l'histogramme.

4. Saisissez un nom pour l'histogramme,
puis sélectionnez un type de fichier.

5. Cliquez sur Save (Enregistrer).
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Enregistrement d'horodatages
1. Sélectionnez File > Save (Fichier >

Enregistrer) ou Save As > Timestamp
Table (Enregistrer sous > Tableau
d'horodatage).

2. Cliquez sur Timestamp (Horodatage).
En fonction des sélections antérieures,
il se peut que vous deviez sélectionner
More > Timestamp Table (Suite >
Tableau d'horodatage) pour afficher la
sélection de l'horodatage.

3. Cliquez sur Options... pour spécifier
les options Source ou FastFrame Data
Range (Plage de données FastFrame) ;
sinon, passez à l'étape 4.

4. Sélectionnez l'emplacement
d'enregistrement de l'horodatage.

5. Saisissez un nom pour l'horodatage,
puis sélectionnez un type de fichier.

6. Cliquez sur Save (Enregistrer).
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Copie des résultats dans le Presse-papiers
Observez la procédure suivante pour définir le contenu de sortie et le format des images, des signaux ou des mesures
à copier dans le Presse-papiers Microsoft.

1. Sélectionnez Edit > Copy Setup....

2. Cliquez sur l'onglet Images, Waveforms
ou Measurements, puis sélectionnez
les options souhaitées.
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Pour copier des images, des signaux ou des mesures, observez la procédure suivante :

1. Sélectionnez l'élément que vous
souhaitez copier.

2. Sélectionnez Edit > Copy ou appuyez
sur Ctrl + C.

3. Appuyez sur Ctrl + V pour coller
l'élément dans une application Windows.
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Impression d'une copie d'écran
1. Pour imprimer une copie d'écran,

appuyez sur la touche d'impression
ou sélectionnez File > Print (Fichier
> Imprimer). Au besoin, modifiez
l'orientation de la page dans la boîte de
dialogue Page Setup (Configuration de
la page).

Le contenu des boîtes de dialogue Print
et Page Setup qui s'affichent dépend de
l'imprimante que vous utilisez.

2. Cliquez sur Page Setup....

3. Sélectionnez les paramètres
d'impression.
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Utilisation du logiciel d'application
Chaque application est utilisable, gratuitement, dix fois en version d'essai sur votre instrument. Ces applications proposent
des solutions de mesures spécifiques à une application. Vous trouverez ci-dessous quelques exemples. Des packs
supplémentaires peuvent également être disponibles. Certaines applications peuvent ne pas être disponibles sur votre
instrument. Contactez votre représentant Tektronix ou visitez notre site Web à l'adresse www.tektronix.com pour plus
d'informations.

Utilisez l'analyse de bus mémoire DDRA pour identifier automatiquement les lectures et écritures DDR1, LP-DDR1,
LP-DDR2, DDR2, DDR3, GDDR3 et GDDR5.

Utilisez l'outil d'analyse de la gigue et de diagrammes en œil DJA pour mesurer précisément des signaux de données
d'horloge, numériques et série complexes.

Utilisez D-PHY pour Emetteur MIPI D-PHY pour déboguer, caractériser et tester la conformité (option DJA nécessaire).

Utilisez le pack d'analyse de signal numérique DSAH pour les instruments <12 GHz.

Utilisez le pack d'analyse de signal numérique DSAU pour les instruments >12 GHz.

Utilisez le logiciel de conformité de ports d'affichage DSPT pour valider vos conceptions de circuits imprimés, de cartes
mères et de cartes graphiques.

Utilisez le logiciel de test de conformité DVI pour tester la conformité de la couche physique DVI.

Utilisez le détecteur de taux d'erreurs sur les bits et les trames ERRDT pour détecter des erreurs dans les normes série
à grande vitesse (option ST6G nécessaire).

Utilisez ET3 pour tester le conformité Ethernet Base-T 10/100/1000.

Utilisez le logiciel de test de conformité HDMI HT3 pour tester la conformité HDMI des modèles ≥ 4 GHz.

Utilisez le logiciel de synthèse directe HDMI HT3DS pour HDMI 1.4 (option HT3 nécessaire) pour effectuer une analyse
HDMI.

Utilisez le logiciel d'analyse de gigue JA3 Advanced pour analyser les performances de temporisation. Analysez la
gigue sur les cycles d'horloge contigus en procédant à des acquisitions monocoup.

Utilisez le logiciel d'analyse série LSA pour l'analyse et le déclenchement des protocoles CAN/LIN.

Utilisez les tests des valeurs limites des signaux LT pour comparer un signal acquis avec les limites de tolérance
définies par vos soins.

Utilisez le logiciel de test du masque de communication MTH pour vérifier la conformité du masque sur les modèles
≥4 GHz.

Utilisez le logiciel de test du masque de communication MTM pour vérifier la conformité du masque sur les modèles <
4 GHz.

Utilisez le module RTE PCE pour la conformité PCI-Express des modèles ≥4 GHz.

Utilisez le pack de solutions d'alimentation PS1 pour mesurer et analyser les alimentations.

Utilisez le logiciel de déclenchement de protocole série ST1G ou ST6G pour déclencher et décoder les données 8 B/10 B
avec les protocoles de données ou série haute vitesse. Déclenchement de protocole jusqu'à 6,25 G éch./s.

Utilisez le logiciel de mesure de puissance PWR pour mesurer et analyser rapidement la dissipation d'énergie des
composants magnétiques et des systèmes de commutation de l'alimentation.
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Utilisez l'analyse de liaison de données série SLA et SLE pour émuler la voie de données série, compenser un
accessoire et ajouter ou enlever l'égalisation de l'émetteur. SLA ajoute le traitement des signaux avec égalisations.

Utilisez SR-COMP pour permettre le déclenchement et l'analyse série de signaux RS-232/422/485/UART.

Utilisez SR-DSI1 pour une analyse série MIPI-DSI1.

Utilisez SR-CSI2 pour une analyse série MIPI-DSI2.

Utilisez SR-EMBD pour permettre un déclenchement et une analyse série de signaux I2C et SPI.

Utilisez SR-USB pour permettre un déclenchement et une analyse série de signaux USB LS, FS et HS.

Utilisez SST Serial ATA et le module de conformité Serial Attached SCSI avec l'option RTE.

Utilisez SVP, SVM et SVE pour valider les conceptions à large bande et caractériser les événements spectraux à
large bande.

Utilisez SVO pour une analyse OFDM flexible, SVE nécessaire.

Utilisez SVT pour les mesures du temps d'établissement (fréquence et phase), SVE nécessaire.

Utilisez USB2.0 pour caractériser les signaux USB 2.0, notamment pour tester le masque et les paramètres.

Utilisez USB3 pour vérifier, caractériser, déboguer et tester la conformité des systèmes USB 3.0 (option DJA nécessaire).

Utilisez le logiciel d'analyse de protocole CAN/LIN VNM pour les tests CAN et LIN (déclenchement CAN non inclus).

Pour installer un logiciel d'application,
observez les instructions qui l'accompagnent.
Pour exécuter le logiciel, sélectionnez
Analyze, puis sélectionnez l'application.
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Exemples d'application
Cette section contient des exemples d'utilisation de votre instrument dans les tâches de dépannage courantes et dans
des applications plus avancées.

Capture d'anomalies intermittentes
L'une des tâches les plus difficiles auxquelles doivent faire face les concepteurs est la détermination de la cause des pannes
intermittentes. Si vous savez exactement quel type d'anomalie vous recherchez, il est facile de configurer la fonction de
déclenchement avancée de l'oscilloscope pour isoler cette anomalie. Cependant, lorsque vous ne savez pas quoi chercher
exactement, cette tâche peut être extrêmement longue et fastidieuse pour trouver des anomalies peu fréquentes, tout
particulièrement au vu de la faiblesse du taux de capture de signal des oscilloscopes à mémoire numérique traditionnels.

Les oscilloscopes à phosphore numérique dotés de la technologie DPX possèdent une fonction d'acquisition
exceptionnellement rapide, appelée FastAcq, qui vous permet de rechercher les anomalies de ce type en quelques secondes
ou minutes. Cette tâche prendrait plusieurs heures, voire plusieurs jours, sur un oscilloscope traditionnel.

Observez la procédure suivante pour capturer les anomalies intermittentes.

1. Branchez la sonde à la source du signal
d'entrée.

2. Appuyez sur Autoset.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000
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3. Sélectionnez Display > Display
Persistence > Infinite Persistence.
Dans cet exemple, vous recherchez un
signal d'horloge. Après avoir observé
le signal pendant 1 à 2 minutes, mais
avant de rechercher le problème ailleurs,
passez à l'étape 4.

4. Appuyez sur FastAcq.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000

5. Rechercher les parasites, transitoires ou
autres anomalies aléatoires présentes
au sein du signal. Dans cet exemple,
la fonction FastAcq a révélé un parasite
positif de ≈300 ns, au bout de quelques
secondes seulement.
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6. Pour effectuer le déclenchement sur
le parasite identifié lors de l'étape 5,
sélectionnez Glitch Setup....

7. Sélectionnez la polarité appropriée.

8. Cliquez sur Level, puis définissez le
niveau en fonction des résultats obtenus
lors de l'étape 5.

9. Cliquez sur Width, puis définissez la
largeur en fonction des résultats obtenus
lors de l'étape 5.
Cochez HF Filtering (Filtrage HF) si
vous souhaitez que le système de
déclenchement traite une salve haute
fréquence comme une impulsion unique.

10. Définissez l'option E-mail on Trigger sur
On. (Voir page 88, Configuration de
l'envoi d'un e-mail pour un événement.)

11. Appuyez sur Single pour effectuer le
déclenchement sur un parasite unique.

Gammes MSO70000C, DSA70000C, DPO70000C et DPO7000C

Gammes MSO5000 et DPO5000
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Utilisation du Bureau étendu et de l'architecture OpenChoice pour une
documentation plus efficace

Les ingénieurs ont souvent besoin de documenter leur travail en laboratoire, à des fins de référence future. Au lieu
d'enregistrer les captures d'écran et les données de signal sur un CD ou un périphérique de stockage USB, puis de générer
ultérieurement un rapport, servez-vous de l'architecture OpenChoice pour documenter en temps réel votre travail.

Pour que votre instrument se situe au centre du processus de conception et de documentation, observez la procédure
suivante.

REMARQUE. Pour les systèmes à 64 bits, vous avez besoin d'applications et de pilotes compatibles 64 bits.

1. Chargez Microsoft Word ou Excel sur
votre instrument.

2. Branchez un second moniteur. (Voir
page 10, Ajout d'un second moniteur.)

3. Ouvrez Microsoft Word, puis faites
glisser la fenêtre Word dans le bureau
étendu.

4. Cliquez sur TekScope pour restaurer
l'application de l'instrument.
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5. Sélectionnez Edit > Select for Copy >
Full Screen (bitmap).

6. Appuyez sur Ctrl+C.

7. Dans le document Word, cliquez à l'endroit où vous souhaitez placer la capture d'écran, puis appuyez sur Ctrl+V.

Astuces
L'instrument est fourni avec divers outils logiciels OpenChoice, conçus pour une efficacité et une connectivité optimales
avec le reste de votre environnement de conception.

Déclenchement sur un signal vidéo
L'instrument prend en charge le déclenchement sur des signaux haute définition, NTSC, SECAM et PAL.

Pour effectuer le déclenchement sur des trames vidéo :

REMARQUE. Le type de déclenchement vidéo est disponible uniquement sur les instruments de la gamme DPO7000C,
MSO5000 et DPO5000.
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1. Sélectionnez Trig > A Event (Main)
Trigger Setup....

2. Définissez le type et la source du type de
déclenchement A, dans l'onglet A Event.
Sélectionnez Format > 525/NTSC.

3. Sélectionnez Trigger On > Field.
Sélectionnez Odd, Even ou All, pour les
trames.

Déclenchement sur lignes
Pour examiner les lignes vidéo de la trame :
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1. Sélectionnez Trig > A Event (Main)
Trigger Setup....

2. Définissez le type et la source du type de
déclenchement A, dans l'onglet A Event.
Sélectionnez Format > 525/NTSC.

3. Sélectionnez Trigger On > All Lines.
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Mise en corrélation des données entre l'oscilloscope Tektronix et l'analyseur
logique

La majorité des systèmes haute vitesse possèdent des front d'horloge rapides et des débits de données élevés. Pour ces
systèmes, vous devez consulter les caractéristiques analogiques des signaux numériques haute vitesse en relation avec les
événements numériques complexes du circuit. iView est votre fenêtre sur le monde analogique et numérique. La fonction
iView intègre en continu les données et établit automatiquement une corrélation temporelle, depuis les analyseurs logiques
et les oscilloscopes Tektronix, afin que vous puissiez transférer des signaux analogiques de l'écran de l'oscilloscope à celui
de l'analyseur logique d'un simple clic de souris. Vous pouvez ainsi afficher les signaux analogiques et numériques en
corrélation temporelle et mettre en relief la source des parasites insaisissables et d'autres problèmes.

Le câble d'oscilloscope externe iView vous permet de connecter un analyseur logique à un oscilloscope Tektronix,
permettant une communication entre les deux instruments. L'assistant Ajout d'un oscilloscope externe, disponible dans le
menu System de l'application TLA, vous guide tout au long de la procédure de connexion du câble iView entre l'analyseur
logique et l'oscilloscope.

Une fenêtre de configuration est également disponible ; elle vous aide à vérifier, modifier et tester les paramètres de
l'oscilloscope. Avant de faire l'acquisition d'un signal et de l'afficher, vous devez établir une connexion entre votre analyseur
logique Tektronix et l'oscilloscope, à l'aide de l'assistant Ajout oscilloscope externe.

1. Sélectionnez Add iView External
Oscilloscope... dans le menu System
de l'analyseur logique.

2. Sélectionnez votre modèle
d'oscilloscope.

3. Observez les instructions qui s'affichent
à l'écran, puis cliquez sur Next.

4. Consultez la documentation de votre
analyseur logique Tektronix pour plus
d'informations sur la mise en corrélation
des données entre l'analyseur logique
et l'oscilloscope.
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Nettoyage
Observez ces procédures pour nettoyer votre l’instrument. Si un nettoyage supplémentaire est nécessaire, confiez
l’instrument à un technicien qualifié.

Nettoyage extérieur
Nettoyez les surfaces extérieures du châssis à l’aide d’un chiffon sec non pelucheux ou d’une brosse douce en soies de
porc. S’il reste des impuretés, utilisez un chiffon ou un tampon imbibé d'une solution d’alcool isopropylique à 75 %. Utilisez
un tampon pour nettoyer les espaces étroits autour des commandes et des connecteurs. N’utilisez jamais de produit
abrasif sur le châssis.

Nettoyez le bouton de mise en marche/veille à l’aide d’une lingette nettoyante humide. Ne vaporisez rien sur le bouton
et ne le mouillez pas directement.

ATTENTION. L’utilisation d’agents nettoyants ou de méthodes de nettoyage inappropriés et les gestes brutaux peuvent
endommager l’instrument. N’utilisez pas de produits de nettoyage chimiques susceptibles d’endommager les éléments en
plastique de l’oscilloscope. Utilisez de l’eau déminéralisée pour le nettoyage des boutons du panneau avant. Utilisez une
solution d’alcool isopropylique à 75 % comme produit de nettoyage et de l’eau déminéralisée pour le rinçage. Avant d’utiliser
tout autre type de produit, consultez votre centre de service ou votre représentant Tektronix.

Afin d’éviter toute humidité dans l’instrument lors du nettoyage externe, utilisez uniquement le liquide nécessaire pour
humidifier le chiffon ou l’applicateur.
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Se procurer les dernières versions et applications des oscilloscopes
Il se peut que la dernière version d'une application en option que vous avez commandée avec votre instrument ne soit pas
installée sur celui-ci. L'adresse de téléchargement suivante est un moyen rapide et facile d'obtenir la dernière version
d'un logiciel.

Pour télécharger la dernière version d'un logiciel, allez à la page d'accueil du site Web de Tektronix (www.tektronix.com),
et trouvez la section Téléchargements y figurant. Entrez le nom de l'application dans la zone de texte ENTER MODEL
NUMBER (Entrez numéro de modèle), et sélectionnez Software (Logiciels) dans le menu déroulant Select Download
Type (Sélectionner type de téléchargement).

REMARQUE. Le fichier Release Notes (Notes de mise à jour) disponible sur la page Web peut contenir davantage
d'informations récentes que le fichier readme.txt contenu dans le fichier exécutable à télécharger.

Pour définir les critères de recherche, utilisez le titre de l'application dans la zone de texte ENTER MODEL NUMBER.
Utilisez, par exemple, le mot-clé DPOJET pour chercher et télécharger la dernière version de DPOJET.

Si vous avez acheté l'application en même temps que votre instrument, votre clé de licence Tektronix vous permettra
d'utiliser l'application.

Si vous mettez votre solution à niveau, suivez les instructions concernant l'Installation de votre nouvelle clé de licence
Tektronix dans le fichier Readme.txt pour activer l'application.
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Instructions relatives aux sondes passives de 500 MHz et 1 GHz TPP0500
et TPP1000

071-2809-xx

Copyright© Tektronix, Inc. Tous droits réservés.

Informations relatives au fonctionnement
Les sondes passives 10 X TPP0500 & TPP1000 sont des sondes compactes avec une atténuation 10X, conçues pour être
utilisées avec les oscilloscopes Tektronix des gammes MSO/DPO4000B & 5000.

Les sondes ne comportent pas de pièces remplaçables par l'utilisateur ou Tektronix.

Connexion de la sonde à l'oscilloscope
Connectez la sonde en vous basant sur les illustrations ci-dessous.

Manuel de l'utilisateur des gammes MSO70000C, DPO/DSA70000C, DPO7000C et MSO/DPO5000 173



Annexe

Compensation de la sonde
MSO/DPO5000. Procédez comme suit pour compenser la sonde :

1. Connectez la sonde à une voie de l'oscilloscope.

2. Connectez la sonde aux bornes de sortie de compensation de la sonde sur le panneau avant de l'oscilloscope.

3. Sélectionnez Vertical > Probe Cal (Vertical > Etal. de la sonde).

4. Sélectionnez l'onglet correspondant à la voie à laquelle est attachée la sonde.

5. Dans la section Calibration (Etalonnage) du menu, cliquez sur la touche Calibrate Probe (Etalonner la sonde).

AVERTISSEMENT. Afin d'éviter les chocs électriques, ne vous connectez au signal Probe Comp (Comp. sonde) sur
l'oscilloscope qu'au moment de ce réglage.

En cas d'échec de la compensation de la sonde, vérifiez que les connexions signal et masse sont solidement branchées au
niveau des connexions Comp. sonde sur l'oscilloscope. Vérifiez également que le connecteur de masse est solidement
branché sur la tête de sonde, que l'extrémité rigide ou pogo est solidement raccordée à la tête de sonde et que l'embout en
forme de crochet est solidement branché sur l'extrémité.

Accessoires standard
Les accessoires standard fournis avec la sonde sont illustrés ci-dessous.

AVERTISSEMENT. Pour éviter tout choc électrique lors de l’utilisation de la sonde ou des accessoires, gardez vos doigts
derrière le protège-doigts du corps de la sonde et des accessoires.

Option Description
Embout en forme de crochet
Enfoncez l'embout en forme de crochet sur
l'extrémité de la sonde, puis accrochez-le sur le
circuit.

Nouvelle commande référence Tektronix
013-0362-XX
Mini-embout en forme de crochet
Cette extrémité vous permet d'accéder à des points
de test dans des endroits confinés. Enfoncez
l'embout en forme de crochet sur l'extrémité de la
sonde, puis accrochez-le sur le circuit.

Nouvelle commande référence Tektronix
013-0363-XX
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Option Description
Extrémité rigide
Cette extrémité est pré-installée sur la sonde.

Nouvelle commande référence Tektronix
206-0610-XX

Extrémité Pogo
Cette extrémité à ressort permet de tester la
compatibilité des cartes de circuit imprimé.

Nouvelle commande référence Tektronix
206-0611-XX
Conducteur de masse, avec pince crocodile
Fixez le connecteur à la masse de la tête de sonde,
puis à la masse de votre circuit.

Nouvelle commande référence Tektronix
196-3521-XX

Ressorts de masse
Attachez le ressort à la bande de masse sur
l'extrémité de la sonde pour prendre des mesures
sur des points de test dont les connecteurs de
masse sont proches (<0,75 pouce, typ. ; XX pouce,
court).
Nouvelle commande références Tektronix :
016-2028-XX (long, 2 ea.)
016-2034-XX (court, 2 ea.)

Accessoires en option
Vous pouvez commander les accessoires suivants pour votre sonde.

Accessoire Référence Tektronix
Conducteur de masse à pince, 15,25 cm 196-3198-xx
Conducteur de masse, crocodile, 30,50 cm 196-3512-xx
Embout de test MicroCKT 206-0569-xx
Point de test carte de circuit imprimé/adaptateur PCB 016-2016-xx
Point de test Carte Ckt Extrémité de la sonde compacte 131-4210-xx
Fil, bobine, 32 AWG 020-3045-xx
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Remplacement de l'extrémité de la sonde
Commander référence Tektronix 206-0610-xx pour remplacer l'extrémité rigide, ou commander référence 206-0611–xx pour
remplacer la broche pogo.

Spécifications

Tableau 1 : Spécifications électriques et mécaniques
Caractéristique TPP0500 TPP1000
Bande passante (-3 dB) 500 MHz 1 GHz
Temps de montée système (typique) <350 ps <700 ps
Capacité d'entrée système Extrémité rigide : 3,9 pF ± 0,3 pf

Extrémité broche pogo : 5,1 pf ± 0,5 pf
Précision de l'atténuation système 10:1 ±2.2%
Résistance série de la sonde @CC 9,75 MΩ ± 0,5 %
Résistance d'entrée système @CC 10 MΩ ± 2 %
Retard de propagation ~5,67 ns
Tension d'entrée maximale 300 Veff CAT II
Longueur de câble 1,3 m ± 3 cm

Graphiques de performances
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Référez-vous à la courbe de réduction du câble de référence ci-dessus lors de mesures flottantes.

Tableau 2 : Spécifications environnementales
Caractéristiques Description
Température

En fonctionnement
A l'arrêt

-15 °C à +65 °C (+5 °F à +149 °F)
-62 °C à +85 °C (–80 °F à +185 °F)

Humidité
En fonctionnement
A l'arrêt

5 à 95 % d'humidité relative jusqu'à +30 °C
5 à 45 % d'humidité relative à 30 °C jusqu'à 50 °C

Altitude
En fonctionnement
A l'arrêt

4600 m maximum
12200 m maximum

Tableau 3 : Homologations
Caractéristiques Description
Déclaration de conformité
CE

La conformité à la spécification suivante, telle qu'énoncée au Journal officiel des
Communautés européennes, a été démontrée :
Directive Basse tension 2006/95/CE :
EN61010-031 : 2002
Catégorie Exemples de produits appartenant à cette catégorie
CAT III Réseaux de distribution, installations fixes
CAT II Réseaux d'alimentation terminale, appareils, équipements portatifs

Descriptions des catégories
de mesures

CAT I Circuits non connectés directement au secteur.
Niveau de pollution 2 N'utilisez pas cet appareil dans un environnement susceptible

d'abriter des polluants conducteurs (selon la définition de la norme CEI 61010-1). Conçu
pour une utilisation en intérieur uniquement.

Autres normes de sécurité UL61010B-1, Première édition & UL61010B-2-031, Première édition.
CAN/CSA-C22.2 N° 1010.1-92, & CAN/CSA-C22.2 N° 1010.2.031-94
CEI 61010-031:2002
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Recyclage de l'appareil. Ce produit respecte les exigences de l'Union européenne, conformément à la
directive 2002/96/CE relative aux déchets d'équipements électriques et électroniques (DEEE). Pour plus
d'informations sur les solutions de recyclage, reportez-vous à la section Assistance/Maintenance du site
Web de Tektronix (www.tektronix.com).

Consignes de sécurité
Veuillez lire avec attention les précautions et consignes de sécurité suivantes, afin d'éviter toute blessure et
l'endommagement éventuel de cet appareil et des produits qui lui sont associés. Pour écarter tout danger, utilisez
uniquement cet appareil dans les conditions spécifiées. Une utilisation non conforme aux spécifications de la sonde ou des
accessoires pourrait provoquer un choc électrique ou un incendie.

Pour éviter les incendies et les dommages corporels
Utilisation d'un oscilloscope référencé à la masse. Ne prenez pas de mesures flottantes sur le câble de référence
de cette sonde lorsque vous l'utilisez avec des oscilloscopes référencés à la masse (par exemple, des oscilloscopes des
gammes DPO, MSO et TDS). Ce câble de référence doit être relié à une prise de terre (0 V).

Branchements et débranchements appropriés. Branchez la sortie de sonde sur l’instrument de mesure avant de
brancher la sonde sur le circuit à tester. Débranchez l'entrée et le fil de référence de la sonde du circuit testé avant de
débrancher la sonde de l'instrument de mesure.

Eviter les chocs électriques. Pour éviter des blessures graves ou mortelles, ne connectez ou ne déconnectez pas les
sondes ou les conducteurs de test lorsqu'ils sont connectés à une source de tension.

Respectez toutes les valeurs nominales des bornes. Pour éviter tout risque d'incendie ou de choc électrique,
respectez les valeurs nominales et les indications figurant sur le produit. Consultez le manuel livré avec le produit où figurent
toutes les informations complémentaires avant de procéder au branchement du produit.

Eviter les chocs électriques. Lorsque vous utilisez des accessoires de sonde, n'allez jamais au-delà de la valeur
nominale la plus basse de la sonde ou de son accessoire, la valeur la plus basse étant celle de référence, y compris la
catégorie de mesure et la tension nominale.

Eviter les surcharges électriques. Pour éviter les risques de blessures ou d'incendie, n'appliquez pas de potentiel
sur une entrée, entrées de référence comprises, qui varie par rapport à la masse de plus de la valeur nominale maximale
pour cette entrée.

Eviter les circuits exposés et ne pas mettre en service sans capots de protection. Ne touchez à aucun
branchement ou composant exposé lorsque l’appareil est sous tension.

Inspecter la sonde et les accessoires. Avant chaque utilisation, vérifiez si la sonde et les accessoires ne sont
pas endommagés (coupures, déchirures, défauts dans le corps de la sonde, accessoires, gaine de câble, etc.). Ne les
utilisez pas s'ils sont endommagés.
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Ne pas utiliser l'appareil dans un environnement humide.

Ne pas utiliser l'appareil dans un environnement explosif.

Conserver les surfaces du produit propres et sèches.

Termes et symboles relatifs à la sécurité apparaissant dans ce manuel.
Les mentions suivantes peuvent figurer dans ce manuel :

AVERTISSEMENT. Les avertissements identifient des situations ou des opérations pouvant entraîner des blessures
graves ou mortelles.

ATTENTION. Les mises en garde identifient des situations ou des opérations susceptibles d'endommager le matériel
ou d'autres équipements.

Symboles figurant sur le produit. Les symboles suivants peuvent figurer sur le produit :

Coordonnées de Tektronix

Site Web : www.tektronix.com
Téléphone : 1-800-833-9200
Adresse : Tektronix, Inc.

Service ou nom (si vous le connaissez)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
Etats-Unis

Adresse électronique : techsupport@tektronix.com

Informations sur la garantie
Pour connaître les informations sur la garantie, allez à www.tektronix.com/warranty
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Instructions de la sonde logique générale P6616
071-2831-00

Copyright© Tektronix, Inc. Tous droits réservés.

Description du produit
La sonde logique générale P6616 permet de connecter des oscilloscopes à signaux mixtes des gammes Tektronix MSO5000
et MSO4000B à des signaux et des bus numériques sur votre système cible. La sonde contient 16 voies de données
réparties entre deux ensembles de câbles (GROUPE 1 et GROUPE 2).

Le premier câble de chaque ensemble est identifié par un isolant bleu, tandis que les sept autres câbles sont gris. L'extrémité
de tous les câbles comporte un connecteur de masse. Vous pouvez connecter les câbles de sonde séparément au système
cible, ou les regrouper au moyen des supports d'extrémité de câble.
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Connexion de la sonde à l'oscilloscope
Connectez la sonde en vous basant sur l'illustration ci-dessous.

1. Insérez la sonde, libellé vers le haut, dans le connecteur sur l'oscilloscope.

2. Pour retirer la sonde, pressez les boutons sur le côté et tirez sur la sonde.
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Connexion de la sonde à votre circuit
Attachez la sonde au circuit au moyen des connecteurs et des adaptateurs illustrés au verso de ces instructions. Choisissez
la méthode la mieux adaptée à vos besoins, puis passez à l'étape de configuration de la sonde.

Configuration de la sonde
Pour définir et voir les paramètres des voies numériques, procédez comme suit :

Pour les instruments de la gamme MSO5000, sélectionnez>Digital Setup (Vertical > Configuration numérique) ou
appuyez sur la touche D15-D0.

Pour les instruments de la gamme MSO4000B, appuyez sur la touche D15–D0.

Les paramètres repris ci-dessous peuvent être définis sur chaque voie numérique :

Tension de seuil et position verticale (la valeur de seuil par défaut est 1,4 V)

Position et hauteur de signal (définies une fois pour les 16 voies)

Libellé des voies

Pour définir et voir les caractéristiques de bus, procédez comme suit :

Pour les instruments de la gamme MSO5000, utilisez les commandes dans le menu Bus Setup (Configuration de bus).

Pour les instruments de la gamme MSO4000B, appuyez sur les touches B1 à B4.

Les écrans de configuration vous permettent de définir et de voir des caractéristiques de bus telles que :

Type d'horloge

Type de bus (série ou parallèle)

Largeur de bus

Format d'affichage (hexadécimal, binaire ou symboles ASCII)

Les informations relatives à la configuration de bus parallèle se trouvent sur certains modèles d'oscilloscope. Cependant,
pour d'autres bus tels que SPI et I2C, vous devez disposer de l'option appropriée. Reportez-vous à la fiche technique du
produit ou au manuel de l'oscilloscope pour connaître la nomenclature précise et les détails de commande.

Vérification de fonctionnement
L'activité logique s'affiche immédiatement sur toutes les voies actives connectées. Si aucun signal actif n'apparaît :

1. Appuyez sur le bouton Trigger (Déclenchement).

2. Sélectionnez Edge (Front) comme type de déclenchement.

3. Sélectionnez la voie que vous souhaitez configurer comme source.

4. Pour les instruments de la gamme MSO4000B, appuyez sur la touche Autoset.

Si aucun signal actif ne s'affiche, essayez une autre voie de sonde (ou sonde analogique) pour vérifier l'activité sur
le circuit au point de test.
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Application type
1. Utilisez la sonde P6616 pour voir les signaux numériques sur un bus système.

2. Utilisez une sonde analogique, comme la sonde passive TPP0500 ou TPP1000, pour voir les informations relatives au
signal analogique.

Accessoires
Les accessoires standard suivants sont fournis avec la sonde et sont illustrés à la page suivante.

Op-
tion Description Quantité Référence
— Kit d'accessoires pour sonde logique Option 1 à 6 020-2662-XX
1 Extrémité de masse (extension) 1 jeu de 20 020-2711-XX
2 Extrémité de sonde 1 jeu de 10 131-5638-11
3 Griffe CI 1 jeu de 20 020-2733-XX
4 Support d'extrémité de sonde 2 ea 352-1115-XX
5 Conducteur de masse de 8" 1 jeu de 2 020-2713-XX
6 Conducteur de masse de 3" 1 jeu de 8 020-2712-XX

Instructions 1 1 ea 071-2831-XX
1 Les instructions sont jointes à la sonde, mais pas au kit d'accessoires.

Les instructions peuvent être téléchargées depuis l'adresse www.tektronix.com/manuals.

Vous pouvez commander les accessoires suivants pour votre sonde :

Description Référence
Adaptateur d'embase mâle Footprint to Square D-MAX pour sonde P6960 NEX-P6960PIN
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Spécifications
Tableau 4 : Spécifications électriques et mécaniques
Caractéristique Description
Voies d'entrée 16 numériques
Résistance d'entrée 100 kΩ ± 1 %
Capacité d'entrée 3 pF
Basculement du signal d'entrée

Minimum 400 mVcrête-crête
Maximum 30 V crête-crête, ≤ 200 MHz (centrée sur la tension de seuil CC) à l'extrémité

de la sonde
10 V crête-crête, ≥ 200 MHz (centrée sur la tension de seuil CC) à l'extrémité
de la sonde

Signal d'entrée non
destructif maximal

± 42 V

Plage du seuil définie par l'utilisateur ± 40 V
Largeur d'impulsion détectable minimale 1 ns
Distorsion voie numérique à
voie numérique

200 ps

Longueur de sonde 1,3 m (4,27 pieds)

Tableau 5 : Spécifications environnementales
Caractéristique Description
Température

En fonctionnement 0 °C à + 50 °C
A l'arrêt -55 °C à +75 °C (-67 °F à +167 °F)

Humidité
En fonctionnement 5 à 95 % d'humidité relative
A l'arrêt 10 % à 95 % d'humidité relative

Altitude
En fonctionnement 4600 m maximum
A l'arrêt 15 500 m maximum

Recyclage de l'appareil. Ce produit respecte les exigences de l'Union européenne, conformément à la
directive 2002/96/CE relative aux déchets d'équipements électriques et électroniques (DEEE). Pour plus
d'informations sur les solutions de recyclage, reportez-vous à la section Assistance/Maintenance du site
Web de Tektronix (www.tektronix.com).
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Consignes de sécurité
Pour écarter tout danger, utilisez uniquement cette sonde dans les conditions spécifiées.

Branchements et débranchements appropriés. Branchez la sortie de sonde à l’instrument de mesure avant de
brancher la sonde sur le circuit à tester. Débranchez l’entrée et la mise à la masse de la sonde du circuit testé avant de
débrancher la sonde de l’instrument de mesure.

Respectez toutes les valeurs nominales des bornes. Pour éviter tout risque d'incendie ou de choc électrique,
respectez les valeurs nominales et les indications figurant sur le produit. Consultez le manuel livré avec le produit où figurent
toutes les informations complémentaires avant de procéder au branchement du produit.

Ne mettez pas l'appareil en service sans ses capots. Ne touchez à aucun branchement ou composant exposé
lorsque l’appareil est sous tension.

Evitez tout circuit exposé. Ne touchez à aucun branchement ou composant exposé lorsque l’appareil est sous tension.

N'utilisez pas l'appareil si vous suspectez une panne. En cas de doute sur le bon état de l'appareil, faites-le
inspecter par un technicien qualifié.

Ne pas utiliser l'appareil dans un environnement humide. N'utilisez pas l'appareil dans un environnement explosif.

Conserver les surfaces du produit propres et sèches.

Termes et symboles relatifs à la sécurité apparaissant dans ce manuel.
Les mentions suivantes peuvent figurer dans ce manuel :

AVERTISSEMENT. Les avertissements identifient des situations ou des opérations pouvant entraîner des blessures
graves ou mortelles.

ATTENTION. Les mises en garde identifient des situations ou des opérations susceptibles d'endommager le matériel
ou d'autres équipements.

Symboles figurant sur le produit. Le symbole suivant peut figurer sur le produit :
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Coordonnées de Tektronix
Site Web : www.tektronix.com
Téléphone : 1-800-833-9200
Adresse : Tektronix, Inc.

Service ou nom (si vous le connaissez)
14200 SW Karl Braun
Drive P.O. Box 500
Beaverton, OR 97077
Etats-Unis

Adresse électronique : techsupport@tektronix.com

Informations sur la garantie
Pour connaître les informations sur la garantie, allez à www.tektronix.com/warranty.
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Connexion de la sonde au circuit
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déclenchement, 69
Communication

déclenchement, définition, 72
mesures, 119

Configuration d'un
e-mail sur événement, 88

Configuration d'un
histogramme, 126

Configuration de l'instrument
enregistrement, 152
rappel, 153

Configuration par défaut, 32
Connexion à un réseau, 9
Consignes de sécurité, v
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Copie d'écran, 160
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enregistrement, 147
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déclenchement, 68
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Curseur barres V, 124
Curseur d'écran, 124

D
Date et heure, 97
débranchement de l'alimentation, 8
décharges électrostatiques

prévention, 4

Déclenchement
affichage, 74
Balayage d'événement B, 78
bus parallèle, 82
bus série, 85
concepts, 67
couplage, 68
état, 73
forcé, 67
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modes, 67
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pente, 68
post-déclenchement, 67, 68
pré-déclenchement, 67, 68

Déclenchement CAN
définition, 72

Déclenchement principal, 68, 74
Déclenchement retardé, 68, 74
Déclenchement séquentiel, 74
Déclenchement sur délai

définition, 71
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établissement/maintien
définition, 71

Déclenchement sur état
définition, 71

Déclenchement sur fenêtre
définition, 71

Déclenchement sur front
définition, 71

Déclenchement sur largeur
d'impulsion
définition, 71

Déclenchement sur parasite
définition, 71

Déclenchement sur petite impulsion
définition, 71

Déclenchement sur séquence
définition, 71

Déclenchement sur transition
définition, 71

Déclenchement sur verrouillage de
séquence, 71

Déclenchement vidéo, 167
définition, 71, 72

Déclenchements Pinpoint, 67
Défilement automatique, 103, 105
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E
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temps équivalent, 35
temps réel, 34
temps réel interpolé, 35

Echantillons intensifiés
affichage des signaux sous

forme de, 91
Echelle horizontale

et signaux calculés, 131
enregistrement

données d'histogramme, 156
horodatages, 157
masques, 155
pièces jointes de l'e-mail, 89

Enregistrement
captures d'écran, 147
configuration, 152
mesures, 154
signaux, 148

enregistrement de signaux
numériques, 151

Enregistrement du signal
définition, 36

Etalonnage, 28
Etiquette, 95
Evénement de déclenchement

définition, 67
exemples, 163
Exemples d'application, 163
Exportation Voir Enregistrement
Expression mathématique spectrale

avancé, 133
Expressions mathématiques

prédéfinies, 128
Expressions mathématiques

spectrales prédéfinies, 132

F
Faire défiler les signaux

agrandis, 103, 105
FastFrame, 58

Frame finder, 61
Fenêtrage, 120

Fonction mathématique
couleurs, 100
éditeur, 128
filtres arbitraires, 130
signaux, 128

Forcer déclenchement, 67
Format d'affichage X-Y-Z, 93
Format d'affichage XY, 93
Format d'affichage Y-T, 93

G
Gestion de la

longueur d’enregistrement
élevée, 106

H
histogramme

enregistrement, 156
horodatage

enregistrement, 157
Horodatages, 60

définition, 58

I
Imprimer, 160
installation, 1
Interactions du mode Défilement, 47
Interpolation, 36, 94
Interpolation linéaire, 94
Interpolation sin(x)/x, 94
iView, 170

L
Largeur de fenêtre et bande passante

de résolution, 134
Lecture, 107
Lecture sur

signal, 107
Lecture/Pause, 107
Lecture/Pause sur

signal, 107
Lecture/Pause, bouton, 107
libellé

bus, 50
texte à l'écran, 95
voie numérique, 49

Limite de bande passante, 46

Logiciel
dernière version, 172
en option, 161
Version, 172

Logiciel d'application, 161

M
MagniVu, 56
Marquage, 108, 109, 110
Marqueur horizontal, 102
Marqueurs du niveau de

déclenchement, 97
Marqueurs utilisateur, 108
masque

enregistrement, 155
Masque

Auto-ajustement, 136
marge de tolérance, 136
réglage automatique, 136, 137
test réussi/échoué, 137

Mémoire segmentée, 58
Menu contextuel, 26
Menu de raccourci, 26
Menus, 26
Mesures, 115

annotation, 122
capture instantanée, 121, 122
curseur, 124
définition, 117
enregistrement, 154
niveaux de référence, 123
personnalisation, 120
précision, 34
statistiques, 121

Mesures d'amplitude, 117
Mesures d'histogramme, 118
Mesures de temps, 117
Mesures par curseur, 124
Mise hors tension, 7
Mise sous tension, 5
Mode d'acquisition Base de données

de signal, 37
Mode d'acquisition Détection de

crête, 37
Mode d'acquisition Echantillon, 37
Mode d'acquisition Enveloppe, 37
Mode d'acquisition Haute

résolution, 37
Mode d'acquisition Moyenne, 37
Mode de déclenchement

automatique, 67
Mode Défilement, 47
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mode horizontal
sélection, 39

Modes d'acquisition
définition, 37
modification, 38

MultiScope Trigger, 63
MyScope

modification, 145
nouvelle fenêtre de

commande, 140
utilisation, 144

N
Nettoyage, 171
Nettoyage extérieur, 171
Niveaux de référence, 123
Normal, mode de

déclenchement, 67

O
Objets

affichage, 97
OpenChoice

exemple, 166

P
Palette de couleurs Monochrome

gray, 98
Palette de couleurs Monochrome

green, 98
Palette de couleurs Normal, 98
Palette de couleurs Spectral

grading, 98
Palette de couleurs Temperature

grading, 98
Palette de couleurs User defined, 98
Palette FastAcq/WfmDB, 98
Palette vue d'enregistrement, 98
Palettes de couleurs, 98
Pan, 106, 107
Panneau de contrôle, 14
Panoramique sur

signal, 106, 107
Parasites

capture, 37, 42, 163
Déclenchement sur, 68

Pause, 107
Pause sur

signal, 107
Persistance

affichage, 92

Persistance infinie, 92
Persistance variable, 92
Points

affichage des points
d'enregistrement du signal
sous forme de, 91

Position de déclenchement, 77
Position horizontale

définition, 31
et signaux calculés, 131

Position verticale, 31
Position verticale et réglage

automatique, 33
Post-déclenchement, 67, 68
Pré-déclenchement, 67, 68
Préférences utilisateur, 34
Première inspection, 27
prévention des décharges

électrostatiques, 4
Procédure

d'utilisation de MagniVu, 56
d'utilisation de Wave

Inspector, 106
de gestion de signaux à

longueur d'enregistrement
élevée, 106

de recherche et de marquage
de signaux, 108

Processus d'échantillonnage
définition, 34

R
Rappel

configuration, 153
signaux, 150

Recherche, 108, 109, 110
restauration du système

d'exploitation, 13
Retard horizontal, 90

S
Schéma de l'écran, 19
Schéma de l'interface, 19
Schéma du panneau arrière, 16
Schéma du panneau avant, 14
Schéma du panneau de contrôle, 21
Schéma du panneau latéral, 16
Sélections de

déclenchement, 71
Séquence unique, 39

signal
analyse, 115

Signal
curseurs, 124
enregistrement, 148
marqueurs utilisateur, 108
rappel, 150
recherche et marquage, 108
style d'affichage, 91

Signal d'entrée, 30
signaux numériques

enregistrement, 151
Sonde

compensation, 34
éliminer les distorsions, 34
étalonnage, 34
P6616, 180
TPP0500, 173
TPP1000, 173

Spécifications
Alimentation électrique, 5
Fonctionnement, 2

Statistiques, 121
Style de réticule Complet, 96
Style de réticule Croix, 96
Style de réticule Grille, 96
Style de réticule Trame, 96
Styles de réticule, 96
Superposer les trames, 60

T
Taille du réticule de zoom, 101
TekLink, 63
Test des valeurs limites, 138
Tests de masque, 135
Tests de masque série, 135
Texte à l'écran, 95
Trigger

MultiScope Trigger, 63
Types de

déclenchement, 71

V
Vecteurs

affichage des signaux sous
forme de, 91

Verrou de sécurité, 9
Verrou, ordinateur portable

standard, 9
Verrouiller les signaux

agrandis, 103, 105
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Vidéo
Lignes, 168

voies numériques
caractéristiques

analogiques, 57
configuration, 49
signal d'entrée, 48

Voyant d'état ARM, 73
Voyant d'état READY, 73
Voyant d'état TRIG'D, 73

W
Wave Inspector, 106

Z
Zoom, 100, 106

taille du réticule, 107
Zoom MultiView, 100
Zoom sur

signal, 106
Zoom sur plusieurs zones, 102
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